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SAFETY PRECAUTIONS
(Make sure to read before training)

When designing a system, always read the relevant manuals and give due consideration to safety.
In addition, pay careful attention to the following points for proper handling during training.

[Precautions during training]
Danger

● To prevent electric shock, do not touch the terminal block while the power is supplied.

● Before opening the safety cover, turn off the power or ensure sufficient safety.

Caution
● Follow the instructor's directions during training.

● Do not remove units from the training equipment or change wiring without permission.
Doing so may cause a breakdown, malfunction, injury, or fire.

● Before mounting or removing a unit, turn off the power.
Not doing so may cause a unit failure or electric shock.

● If the training equipment gives out a strange smell or makes an unusual noise, press the "Power
Switch" or the "Emergency Switch" to stop the machine.

● If any trouble occurs, contact the instructor right away.
A - 1



A - 2



REVISIONS

* The textbook number is given on the bottom left of the back cover.
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Introduction

This textbook is designed to help you learn the utilization of the Mitsubishi Electric Graphic Operation Terminal 
(Mitsubishi Electric GOT).
Practice the examples in this textbook to learn how to use the GOT.

[Basic course]
You can learn the basic skills for using the GOT.
Course content:

1. Functions, performance, and system configuration of the GOT2000 series
2. GOT basic operation and setup procedures
3. Figure and basic object functions

(Text, numerical display, numerical input, lamp display, comment display, touch switch, etc.)
4. Sequence program monitor (ladder) and device monitor functions

[Practice course]
You can learn how to create the screens used on the GOT efficiently.
Course content:

1. GOT operation and GT Designer3 basic operation
2. How to use advanced object functions

(Layer, graph, comment display, language switching, library, parts movement, alarm function, etc.)
A - 9



Relevant manuals

The following table lists the relevant manuals for this product.
Refer to the manuals as needed.

* Stored in GT Works3 in PDF Format.

Copyright notice

GOT is the registered trademark of Mitsubishi Electric Corporation.
Other company and product names herein are trademarks or registered trademarks of their respective owners.

Manual name
Manual number

(Model code)

(1) GT Works3 Version1 Installation Procedure Manual Included with the product

(2) GT Designer3 (GOT2000) Help Stored in software

(3)
GT Designer3 (GOT2000) Screen Design Manual

(Sold separately)*
SH-081220ENG

(1D7ML9)

(4)
GOT2000 Series MES Interface Function Manual
For GT Works3 Version1

SH-081228ENG

(5)

GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1
For GT Works3 Version1 (Sold separately)*

SH-081197ENG
(1D7MJ8)

GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1)
For GT Works3 Version1

SH-081198ENG

GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2)
For GT Works3 Version1 SH-081199ENG

GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals)
For GT Works3 Version1

SH-081200ENG

(6)

GOT2000 Series User's Manual (Hardware)
(Sold separately)*

SH-081194ENG
(1D7MJ5)

GOT2000 Series User's Manual (Utility)
(Sold separately)*

SH-081195ENG
(1D7MJ6)

GOT2000 Series User's Manual (Monitor)
(Sold separately)*

SH-081196ENG
(1D7MJ7)

(7)
GT Converter2 Version3 Operating Manual
For GT Works3 Version1

SH-080862ENG

(8) GT SoftGOT2000 Version1 Operating Manual SH-081201ENG
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System configuration used in this textbook
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1. Overview of the GOT

1.1 GOT
The GOT (Graphic Operation Terminal) is an electronic device used as an electronic operation panel to operate/display 
different operations such as switch operation, lamp display, data display and message display, which had been 
conventionally implemented with a control box.

Advantages of using the GOT
(1) Downsizing the operation panel

The GOT replaces physical switches and lamps with graphical ones, saving I/O points on the PLC and reduces 
the size of operation panel. 

(2) Reducing wiring costs
The graphical user interface of the GOT eliminates the time and cost of wiring components inside the operation 
panel.

(3) Standardizing operation panels
GOTs are flexible, allowing you to build or modify projects without changing the PLC program or system wiring, 
which facilitates standardization of operation panels.

(4) Value-added HMI (Human Machine Interface)
GOT can also display graphics, text and alarms in addition to switches and lamps, contributing the value 
addition to entire equipment.

POINTPOINTPOINT

What is the GOT?

"G" …Graphic  "O" …Operation  "T" …Terminal

The GOT (Graphic Operation Terminal) is a programmable display manufactured by Mitsubishi Electric 
Corporation.

GOT

Space saving

Cost savingConventional 
operation panel
1. Overview of the GOT
1.1 GOT
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1.2 Procedure for monitoring the PLC CPU by GOT

Stop

Data

Run

0

Run lamp

Run Run lampStop

Data 600

GOT

Personal computer

Personal computer

USB cable
(Ethernet cable)

Run
Run lamp

Stop

Data 0

GOT

Run Run lampStop

Data 600

PLC CPU

1) Use GT Designer3 (screen 
design software) to create a 
screen to be displayed on the 
GOT. 

2) Transfer the created data to 
the GOT.

3) Connect the GOT to a PLC 
CPU, and start monitoring 
the CPU.

Create the screen by placing 
objects, such as switches, lamps, 
and numerical display.
1 - 2 1. Overview of the GOT
1.2 Procedure for monitoring the PLC CPU by GOT
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1.3 GOT2000 series features
(1) High-speed processing

Easily operate the screens even during high-load processing, such as logging, script, alarm or device data 
transfer. (Monitoring performance is 2-fold or higher than before.*1)

*1 Compared to GOT1000 series GT16 models.

(2) Increased memory capacity

• Design screens without worrying about the data capacity.
• The compression technology allows up to 128 MB of actual space to be used without an SD card.*1

*1 An SD card may be required depending on the project data.

(3) Easy operations with gesture function (GT27 only)

Use intuitive gestures to zoom in/out and to scroll.
• Screen gestures

Zoom in a screen to operate small switches on the screen easily. Scroll to any portion of the screen you 
want to operate.

• Object gestures
Scroll or zoom in and out the displayed contents of the objects gestures such as a flick.
(Applicable objects: Alarm display (user), alarm display (system), simple alarm display, historical trend 
graph, historical data list display, and document display)

(4) Crisp display with outline fonts and PNG images
Customize screen designs using the parts library and fonts that are crisp even when enlarged or reduced.

(5) Enhanced lineup (GT27 and GT25 white models)
• The new white model provides an additional color option.
• The flush frame without the USB port can be cleaned very easily.
• The GOT can be installed vertically when space is limited, offering you greater flexibility in installation.

(6) Two-point press operation to prevent incorrect operations (GT27 only)
Prevent accidental operations by designating two pressing points for critical operations.

For details on the features of the GOT2000 series, refer to the following manuals.

GOT2000 Series User's Manual (Hardware)

GOT2000 Series User's Manual (Utility)

GOT2000 Series User's Manual (Monitor)
1. Overview of the GOT
1.3 GOT2000 series features
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1.4 GOT function list
The following table lists the functions by GOT model.
For the details of functions, supported controllers, and connection types, refer to the GOT2000 series manuals or Help.

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21 GT 
SoftGOT2000

H
ar

dw
ar

e 
sp

ec
ifi

ca
tio

ns

Sc
re

en
 s

iz
e

15" ● — — —

12.1" ● ● — —

10.4" ● ● — —

8.4" ● ● — —

5.7" ● — ● —

4.3" Wide — — ● —

4.5" — — ● —

3.8" — — ● —

R
es

ol
ut

io
n

XGA 1024 × 768 ● — —

Flexible 
resolution

640 to 1920 × 
480 to 1200

SVGA 800 × 600 ● ● —

VGA 640 × 480 ● ● —

QVGA 320 × 240 — — ●

Others — —

GT2104-R: 480 
× 272

GT2104-P: 384 
× 128

GT2103: 320 × 
128

C
ol

or

65536 colors ● ● ● ●

32-shade monochrome 
(black/white) — — ● —

Touch panel simultaneous press (two 
points) ● — — —

Human sensor ●*10 — — —

M
em

or
y

Memory for storage (ROM)
Other than 

below: 57 MB
GT2705: 32 MB

32 MB

GT2105, 
GT2104-R: 9 MB
GT2104-P: 6 MB
GT2103: 3 MB

57 MB

Memory for operation (RAM)
Other than 

below: 128 MB
GT2705: 80 MB

80 MB — —

In
te

rfa
ce

RS-232 ● ● ● ●*12

RS-422/485 ● ● ● ●*12

Ethernet ● ● ● ●*11

USB (Host) ● ● — ●*13

USB (Device) ● ● ● —

SD card slot ● ● ●*14 ●*13

Extension interface, side 
interface

Communication units, 
option units ●*11 ●*11 — ●*11
1 - 4 1. Overview of the GOT
1.4 GOT function list
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Sc
re

en
 d

es
ig

n

Fi
gu

re
/o

bj
ec

t f
un

ct
io

n

Figure ● ● ● ●

Logo text ● ● ● ●

Touch switch ● ● ● ●

Lamp ● ● ● ●

Numerical display, numerical 
input

● ● ● ●

Text display, text input ● ● ● ●

Date display, time display (Battery) ● ● ● ●

Comment display ● ● ● ●

Parts display
(SD card or USB 
memory device)

● ● ●*16 ●

Parts movement
(SD card or USB 
memory device)

● ● ●*16 ●

Historical data list display
(SD card or USB 
memory device)

● ● ●*16 ●

Simple alarm display ● ● ● ●

System alarm display ● ● — ●

Alarm display (user)
(SD card or USB 
memory device, 
battery)

● ● ●*16 ●

Alarm display (system)
(SD card or USB 
memory device, 
battery)

● ● — ●

Recipe display (record list) ● ● — ●

Line graph ● ● ● ●

Trend graph ● ● ● ●

Bar graph ● ● ● ●

Statistic bar graph ● ● ● ●

Statistic pie graph ● ● ● ●

Scatter graph ● ● ● ●

Historical trend graph
(SD card or USB 
memory device) ● ● ●*16 ●

Graphical meter ● ● — ●

Level ● ● ● ●

Panelmeter ● ● ● ●

Slider ● ● ● ●

Document display SD card ● ● — ●

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
1. Overview of the GOT
1.4 GOT function list
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Logging
(SD card or USB 
memory, battery)

● ● ●*6 ●

Recipe
(SD card or USB 
memory device)

● ● ●*16 ●

Device data transfer ● ● ● ●

Trigger action ● ● ● ●

Time action (SD card or USB 
memory device)

● ● ● ●

Hard 
copy

File output SD card or USB 
memory device

● ● ●*6 ●

Serial printer output ● ● ●*6 ●*2

PictBridge printer 
output Printer unit ● ● — ●*2

Project/screen script ● ● ● ●

Object script ● ● — ●

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
1 - 6 1. Overview of the GOT
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Sc
re

en
 d

es
ig

n

Fu
nc

tio
ns

 u
si

ng
 p

er
ip

he
ra

l d
ev

ic
es

Barcode function ● ● ●*6 ●

RFID function ● ● ●*6 ●

GOT Mobile function License, (SD card) ● ● — —

VNC server function License ● ● — —

Remote personal computer 
operation function (Ethernet) License ● ● — —

Remote personal computer 
operation function (Serial)

RGB input unit or 
video/RGB input unit ●*8 — — —

Video display function
Video input or video/
RGB input unit ●*8 — — —

RGB display function
RGB input unit or 
video/RGB input unit ●*8 — — —

Multimedia function
Multimedia unit, CF 
card ●*8 — — —

External I/O function External I/O unit ● ● — —

Operation panel function External I/O unit ● ● — ●

RGB output function RGB output unit ●*8 — — —

Report 
function

Serial printer output (SD card or USB 
memory device)

● ● ●*6 ●*3

PictBridge printer 
output

SD card or USB 
memory device, 
printer unit

● ● — ●*3

Sound output function Sound output unit ● ● — ●

Server function, client function ● ● — —

Mail send function ● ● — ●

FTP server function
(SD card or USB 
memory device)

● ● ●*15 —

File transfer function (FTP 
transfer)

SD card or USB 
memory device

● ● ●*15 —

File transfer function (GOT 
internal transfer)

SD card or USB 
memory device

● ● — —

MES interface function License, (SD card) ● ● — —

Wireless LAN function
(Wireless LAN 
communication unit) ● ● — —

USB mouse, USB keyboard ● ● — ●

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
1. Overview of the GOT
1.4 GOT function list
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Base screen ● ● ● ●

Overlap window ● ● ● ●

Superimpose window ● ● ● ●

Dialog window ● ● ● ●

Mobile screen ● ● — —

Key window ● ● ● ●

Language switching ● ● ● ●

System information ● ● ● ●

Operator authentication 
function

(SD card or USB 
memory device)

● ● ●*16 ●

Operation log SD card or USB 
memory device

● ● — ●

Startup logo ● ● ● ●

KANA KANJI conversion ● ● — ●

FA transparent function ● ● ● —

SoftGOT-GOT link function License key ● ● — ●

Backup/restoration function
SD card or USB 
memory device

● ● ●*6 —

Multi-channel function

●*9

Four channels 
(Up to three 

units)

●
Four 

channels (Up 
to three units)

●*6

Two channels 
(No unit can be 

mounted.)

—

Station No. switching ● ● ● ●

GOT network interaction 
function

● ● — ●

Screen gesture function ● — — —

Object gesture function ● — — —

Security key authentication 
function

● ● — —

IP filter function ● ● — —

File manager
(SD card or USB 
memory device)

● ● — —

Vertical display *5
●

(Rotated 90° to 
left)

●
(Rotated 90° 

to left)

●
(Rotated 90° to 

right)
—

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
1 - 8 1. Overview of the GOT
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*1 Necessary units when using GT27, GT25, GT23, or GT21. Parenthesized devices are required depending on the use conditions.
*2 Data is output to the printer that is recognized by the personal computer.
*3 CSV files are saved in the virtual drive of the personal computer so that it is recommended to output the files to printers.
*4 Only the GOTs with SVGA or higher resolution are supported.
*5 The remote personal computer operation function (Ethernet) cannot be used.

The following screens are displayed horizontally:
Utility screen, monitor and data management screens that are displayed from the utility screen (such as the sequence program 
monitor screen), video camera images displayed with the multimedia and video display functions
For details on the operations of the vertically-installed GOT, refer to the relevant manuals or Help.

*6 Excluding GT2104-PMBLS and GT2103-PMBLS.
*7 GT2105 and GT2104-RTBD only.
*8 Excluding GT2705.
*9 When multiple devices (such as extension units, a barcode reader, and an RFID controller) are used with GT2705, the total 

amount of current must be within the maximum amount of current supplied by GT2705. For details, refer to the GOT2000 series 
manuals.

*10 GT2715 and GT2712 only.
*11 For the applicable communication units and options, refer to the GOT2000 series manuals.
*12 Use the standard interface of the personal computer.
*13 Use the virtual drive of the personal computer for the functions requiring a USB memory or SD card.
*14 GT2103 requires an SD card unit (GT21-03SDCD) sold separately. GT2104-PMBLS and GT2103-PMBLS do not support SD 

cards.
*15 GT2104-R, GT2104-PMBD, and GT2103-PMBD only.
*16 For GT2104-PMBLS and GT2103-PMBLS, only the functions that do not require an SD card can be used.

M
ai

nt
en

an
ce

 fu
nc

tio
ns

Device monitor ● ● ● —

Sequence program monitor
(Ladder)

SD card or USB 
memory device

● ● — —

Sequence program monitor 
(SFC)

SD card or USB 
memory

● ● — —

Network monitor ● ● — —

Intelligent module monitor ● ● — —

Drive recorder
(SD card or USB 
memory device)

● ● — —

Servo amplifier monitor ● ● — —

R motion monitor ● ● — —

Q motion monitor ● ● — —

Motion SFC monitor
SD card or USB 
memory device

● ● — —

CNC monitor ●*4 ●*4 — —

CNC data I/O
SD card or USB 
memory device ●*4 ●*4 — —

CNC machining program edit ●*4 ●*4 — —

Log viewer
(SD card or USB 
memory device)

● ● — —

FX list editor ● ● ●*7 —

FX ladder monitor ● ● — —

iQSS utility SD card or USB 
memory device

● ● — —

System launcher ● ● — —

MELSEC-L troubleshooting ● ● — —

●: Supported —: Not supported

Category Item Necessary devices *1 GT27 GT25 GT21
GT 

SoftGOT2000
1. Overview of the GOT
1.4 GOT function list
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1.5 Equipment required for using GOT
 GOT external appearance and interface

[Front face]

[Rear face]

iF Design 
Award 
2014

* GT27 and GT25 only. The USB (Host) interface 
is at the rear of a white model.

* The USB (Device) interface is at the rear of 
a white model or GT21. 

* GT27 (15" and 12.1" only)

The GOT detects an operator and 
displays its screen automatically.
When no one is around, 
the backlight turns off to 
save energy.

The stylish and simple design with 
a linear motif is sleek and 
complements any machine design.

Data can be transferred without 
opening the cabinet.

The long life cycle minimizes 
maintenance and replacement costs.

Screen data can be transferred and 
data in the GOT can be 
retrieved using a USB memory.
A USB mouse and keyboard 
can be connected.

Communication and optional units 
can be mounted.

Various FA devices, a barcode reader, 
or a serial printer can be connected.

A large amount of data including 
alarms and logging data 
can be saved.

Various FA devices can be 
connected.

Up to four types of controllers from 
different manufacturers* can be 
connected simultaneously 
by Ethernet.

A wireless LAN communication unit 
can be mounted.

A USB memory device can be mounted 
to save alarms and logging data.
A USB mouse and keyboard can 
be connected.

* GT27 and GT25 only

* This image is GT2712.

* Up to two types of controllers for GT21

* GT27 and GT25 only

*GT27 and GT25 only

The GOT can be connected 
to a personal computer 
to transfer data.
* White models only

Human sensor Simple design

LED backlight

USB device

USB host

Extension interface

Ethernet

RS-422/485

SD card slot

Side interface

USB hostRS-232

USB device
1 - 10 1. Overview of the GOT
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 Required equipment
The following shows the equipment required to connect the GOT to the PLC CPU.

*1 The communication unit varies depending on the connection type between the GOT and a PLC.
When the GOT is connected with a PLC by using an interface built in the GOT (Ethernet interface, RS-232 interface, or RS-422/
485 interface), no communication unit is required.

*2 The connection cable varies depending on the connection type.
The connection cables used for each connection type are shown below.

*1 The connection cables are exclusive products. (Only the Ethernet connection cable is commercially available.)

Equipment name Application

[1] Personal computer For writing data to the GOT.

[2] GT Works3 For creating screen data.

[3] USB cable For connecting to a personal computer.

[4] Communication unit For communicating with a PLC CPU.*1

[5] Connection cable For connecting to a PLC CPU.*2

Connection type Connection cable*1

Ethernet connection, CC-Link IE Field Network 
connection

Ethernet cable

Direct CPU connection
RS-232 cable

For RS-232 connection

For RS-422 connection
RS-422 cable
RS-232/422 conversion cable

Computer Link connection
RS-232 cable

For RS-232 connection

For RS-422 connection
RS-422 cable
RS-232/422 conversion Cable

Bus connection Bus connection cable

CC-Link connection CC-Link dedicated cable

MELSECNET/H connection, MELSECNET/10 
connection, CC-Link IE Controller Network connection Optical fiber cable

For optical fiber cable connection

For coaxial cable connection Coaxial cable

Communication unitGT Works3

Personal 

computer

PLC

USB cable Connection cable

[5]

GOT2000
[1]

[2]

[3]

[4]
1. Overview of the GOT
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 GT Designer3
GT Designer3 is the screen design software for GOT2000 series and GOT1000 series.
This software enables you to create projects, perform simulations, and transfer data between the GOT and a 
personal computer.

GT Designer3 has the following drawing modes.
• GT Designer3 (GOT2000): Drawing mode for GOT2000 series
• GT Designer3 (GOT1000): Drawing mode for GOT1000 series

The supported drawing software is started for making project, depending on the selection of GOT type. The title 
bar of GT Designer3 indicates the drawing mode being used.

This textbook uses GT Designer3 (GOT2000) for explanation.

Personal computer (GT Designer3)

Data transfer

GOT

Creating a project 
or performing a 
simulation

Current drawing mode
1 - 12 1. Overview of the GOT
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 Operating environment of GT Designer3

Item Description

Model Personal computer that Windows runs on.

OS (English, Simplified 
Chinese, Traditional Chinese, 
Korean, German, or Italian 
version)

• Microsoft Windows 10 Enterprise (32 bit, 64 bit)*1*2*4*6

• Microsoft Windows 10 Pro (32 bit, 64 bit)*1*2*4*6

• Microsoft Windows 10 Home (32 bit, 64 bit)*1*2*4

• Microsoft Windows 8.1 Enterprise (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8.1 Pro (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8.1 (32 bit, 64 bit)*1*2*4*5

• Microsoft Windows 8 Enterprise (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8 Pro (32 bit, 64 bit)*1*2*4*5*6

• Microsoft Windows 8 (32 bit, 64 bit)*1*2*4*5

• Microsoft Windows 7 Ultimate (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Enterprise (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Professional (32 bit, 64 bit)*1*2*3*4

• Microsoft Windows 7 Home Premium (32 bit, 64 bit)*1*2*4

• Microsoft Windows 7 Starter (32 bit)*1*2

• Microsoft Windows Vista Ultimate (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Enterprise (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Business (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Premium (32 bit) Service Pack1 or later*1*2

• Microsoft Windows Vista Home Basic (32 bit) Service Pack1 or later*1*2

• Microsoft Windows XP Professional (32 bit) Service Pack3*1*2

• Microsoft Windows XP Home Edition (32 bit) Service Pack3*1*2

CPU Intel Core 2 Duo Processor 2.0 GHz or more recommended.

Memory • For a 64-bit OS: 2 GB or more recommended
• For a 32-bit OS: 1 GB or more recommended

Display Resolution XGA (1024 × 768 dots) or higher.

Hard disk space
• For installation: 5 GB or more recommended
• For execution: 512 MB or more recommended

Display color High Color (16 bits) or higher.
1. Overview of the GOT
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*1 For installation, the standard user or administrator account is required.
For installation on Windows XP, the administrator authority is required.
To interact GT Designer3 with other MELSOFT applications which are used under the administrator authority, use GT Designer3 
under the administrator authority.

*2 The following functions are not supported.
• Application start in Windows compatibility mode
• Fast user switching
• Change your desktop themes (fonts)
• Remote desktop
• DPI setting other than the normal size (For Windows XP and Windows Vista)
• Setting the size of text and illustrations on the screen to any size other than [Small-100%] (For Windows 10, Windows 8.1, 

Windows 8, and Windows 7)
*3 Windows XP Mode is not supported.
*4 The touch feature is not supported.
*5 Modern UI Style is not supported.
*6 Hyper-V is not supported.
*7 Versions 8.50, 8.71, and 9.15 of the software are validated by our company.
*8 The following shows the software versions of the controller simulators.

Other software

To use the simulation function on a personal computer, one of the following software applications must be 
installed.
• GX Simulator3 (included in GX Works3 Version1.007H or later)
• GX Simulator2 (included in GX Works2 Version1.12N or later)
• GX Simulator Version 5.00A or later
• MT Simulator2 Version1.70Y or later

The required software version depends on the controller to be simulated.*8

To use the document display function, the following software must be installed.
• Document Converter
• Ghostscript GPL8.50 to 9.15*7 (Free software)

To use the files of Microsoft Word, Microsoft Excel, or Microsoft PowerPoint, the following software also 
must be installed.
• PostScript printer driver supplied with Windows
• Microsoft Office 2003, Microsoft Office XP, Microsoft Office 2000 (Required only when the files of 

Microsoft Word, Microsoft Excel, or Microsoft PowerPoint are used)

To use the remote personal computer operation function (Ethernet), the following software must be 
installed.
• VNC server software (UltraVNC 1.0.5, 1.0.5.6, 1.1.9.6, or 1.2.1.1)
• Windows terminal server function (Windows Server 2003)
• Terminal service function software (RDPGateway(rdp2vnc))

To use the remote personal computer operation function (Serial), one of the following software must be 
installed.
• Remote Personal Computer Operation Driver (MES_2X)
• Remote Personal Computer Operation Driver (TSC-DD)

Use the software compatible with the personal computer OS used for the remote personal computer 
operation function (Serial).

To use the VNC server function, the following software must be installed.
• VNC client software (UltraVNC1.1.9.6, 1.0.9.6.2, or 1.0.8.2)

To use the multimedia function, the following software must be installed.
• Multimedia Interaction Tool
• Multimedia Interaction FTP Service
• Quick Time Player or QuickTime 7 Pro

To display Help, the following software must be installed.
• Internet Explorer7 or later recommended

To display PDF manuals, the following software must be installed.
• Adobe Reader7 or later recommended

Other hardware

Use the hardware compatible with the above OS.
• For installation: mouse, keyboard, DVD-ROM drive
• For execution: mouse, keyboard
• For printing: printer

Use the following hardware when required.
• For simulation (Only when outputting the buzzer sound): Sound card, speaker

Item Description
1 - 14 1. Overview of the GOT
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• Version of GX Simulator

• Version of GX Simulator2

PLC CPU compatible with simulation
Version of 

GX Simulator

QCPU (A mode), ACPU, motion controller CPU (A series) Version5.00A or later

QnACPU Version5.40E or later

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC 
series, FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series

Version5.40E or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version5.40E or later

Q00JCPU, Q00CPU, Q01CPU Version6.00A or later

Q02PHCPU, Q06PHCPU Version7.20W or later

Q12PHCPU, Q25PHCPU Version6.10L or later

Q12PRHCPU, Q25PRHCPU Version6.20W or later

FX3U series, FX3UC series Version7.08J or later

FX3G series Version7.22Y or later

Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 
Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 
Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, Q26UDEHCPU

Version7.23Z or later

PLC CPU compatible with simulation
Version of 

GX Simulator

FX0 series, FX0N series, FX0S series, FX1 series, FX1N series, FX1NC 
series, FX1S series, FX2 series, FX2C series, FX2N series, FX2NC series

Version1.24A or later

QCPU (Q mode) (except for Q00J, Q00, and Q01CPU) Version1.12N or later

Q00JCPU, Q00CPU, Q01CPU Version1.12N or later

QnPHCPU Version1.87R or later

FX3U, FX3UC, FX3G series Version1.24A or later

FX3GC series Version1.77F or later

FX3S series Version1.492N or later

Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, Q04UDHCPU, 
Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, Q20UDHCPU, Q26UDHCPU, 
Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, 
Q13UDEHCPU, Q20UDEHCPU, Q26UDEHCPU

Version1.12N or later

Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU Version1.492N or later

L02CPU, L26CPU-BT Version1.24A or later

L02CPU-P, L26CPU-PBT Version1.62Q or later

L06CPU Version1.98C or later

L02SCPU, L26CPU Version1.98C or later

L02SCPU-P, L06CPU-P, L26CPU-P Version1.492N or later

Q50UDEHCPU, Q100UDEHCPU Version1.31H or later
1. Overview of the GOT
1.5 Equipment required for using GOT

1 - 15



• Version of GX Simulator3

• Version of MT Simulator2

PLC CPU compatible with simulation
Version of 

GX Simulator3

R04CPU, R08CPU, R16CPU, R32CPU, R120CPU Version1.007H or later

R08PCPU, R16PCPU, R32PCPU, R120PCPU Version1.010L or later

R08SFCPU, R16SFCPU, R32SFCPU, R120SFCPU, R04ENCPU, 
R08ENCPU, R16ENCPU, R32ENCPU, R120ENCPU

Version1.020W or later

FX5U series, FX5UC series Version1.025B or later

PLC CPU compatible with simulation
Version of 

MT Simulator2

Q172DSCPU, Q173DSCPU Version1.70Y or later
1 - 16 1. Overview of the GOT
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 List of software applications included in GT Works3
(a) GT Designer3 (GOT2000) Version1

This software is used to create screens for GOT2000 series.
(b) GT Designer3 (GOT1000) Version1

This software is used to create screens for GOT1000 series.
(c) GT Designer2 Classic

This software is used to create screens for GOT900 series.
(d) GT Simulator3 Version1

This software is used to simulate the operation of a GOT2000/GOT1000/GOT900 series GOT on a 
personal computer by connecting with GX Simulator or a PLC CPU.

(e) GT SoftGOT2000 Version1
This software has the functions equivalent to the functions of the GOT2000 series and is used to display 
lamps, data, and messages on a personal computer and panel controllers.

(f) GT SoftGOT1000 Version3
This software has the functions equivalent to the functions of the GOT1000 series and is used to display 
lamps, data, and messages on a personal computer or the like.

(g) GT Converter2 Version3
This software is used to convert the project data created by existing screen editor software into those 
available for use on GT Designer3 or GT Designer2 Classic.

(h) Document Converter
This software is used to convert documents created on a personal computer (such as Microsoft Word and 
Microsoft Excel) to GOT-compatible formats.

(i) Data Transfer Tool, Multimedia Interaction Tool, and other tools
(j) Help and manual list

This list displays the PDF versions of the relevant manuals.
1. Overview of the GOT
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1.6 Applicable connection type between the GOT 
and a PLC CPU

You can use the GOT to monitor PLCs which are connected to the GOT using the following connection types.
The applicable connection type varies depending on your system configuration and purpose.

(1) Ethernet connection
The GOT is connected to a PLC via Ethernet.
The networks can be configured with commercially available products such as hubs and cables.

(2) Direct CPU connection
The GOT is connected to the RS-232 or RS-422 connector of a PLC.
Because no other equipment is required to connect the GOT and the PLC, this is the most economical 
connection type.

(3) Computer link connection
The GOT is connected to the computer link module or serial communication module of a PLC.
Connecting multiple GOTs to a PLC is available depending on the computer link module or serial communication 
module.

Hub

GOT QCPU QCPU QCPU

PLC
GOT

Maximum distance when a RS-232 cable is used: 3 m
Maximum distance when a RS-422 cable is used: 30.5 m*

* Total length of a RS-422 connector conversion cable and a RS-422 cable.

Serial communication unit

GOTGOT GOT

PLC

Maximum distance when a RS-232 cable is used: 15 m
Maximum distance when a RS-422 cable is used: 1200 m
1 - 18 1. Overview of the GOT
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(4) Bus connection
The GOT is connected to an extension connector of a base unit (connection by I/O bus). 
This connection type enables the fastest response to a PLC CPU among all of the connection types.
By occupying one stage of the extension base unit, up to five GOTs can be connected.*1

*1  QCPU (High Performance model or models in higher class)

(5) CC-Link IE Controller Network, MELSECNET/H, or MELSECNET/10 connection
The GOT is connected to a CC-Link IE Controller Network system, MELSECNET/H network system , or 
MELSECNET/10 (PLC to PLC) network system as a normal station.
The cyclic data of the CC-Link IE Controller Network, MELSECNET/H, or MELSECNET/10 (PLC to PLC 
network) and the devices of PLC CPUs in the same network can be monitored.

(6) CC-Link connection
The GOT is connected to a CC-Link system as an intelligent device station.
The cyclic data of the CC-Link system and devices of the PLC CPU (master or local station) can be monitored.

Connecting multiple GOTs is possible.

QCPU
GOT GOTGOT

Maximum distance: 37 m

GOT

GOT GOT

QCPU

Optical loop system

QCPU
GOT GOT

QCPU

Coaxial bus system

QCPU

QCPU GOT
Local station

Partner manufacturer
CC-Link module

Remote I/O station
1. Overview of the GOT
1.6 Applicable connection type between the GOT and a PLC CPU

1 - 19



(7) CC-Link IE Field Network connection
CC-Link IE Field Network is a high-speed and large-capacity Field Network that handles a mix of control data 
and management data of devices. Additionally, distribution of controllers, I/O control, motion control, and safety 
functions can be seamlessly set.

(8) Applicable connections with non-Mitsubishi PLCs
GOT can monitor non-Mitsubishi PLCs.
The system configuration without regard to PLC manufacturers is available.
For the applicable PLCs, refer to product catalogs and manuals.

Partner manufacturer

PLC

Hub

GOT QCPU

PLC
1 - 20 1. Overview of the GOT
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1.7 Connection to equipment other than PLCs
(1) Microcomputer

Data can be read and written from a personal computer, microcomputer board, PLC to GOT virtual devices.

(2) Bar-code reader
The data read with a bar-code reader can be written to a PLC CPU.

(3) Temperature controller, Inverter, Servo amplifier, CNC
The controllers can be monitored and modification in parameters is also possible.
1. Overview of the GOT
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1.8 Multi-channel function
The GOT having multiple communication drivers can monitor up to four controllers (four channels), such as a PLC CPU, 
temperature controller, inverter.

To use the multi-channel function, read the GOT2000 Series Connection Manual (Mitsubishi Electric Products) and 
select systems and the communication units to be mounted on a GOT.

Install multiple 
communication drivers.

Monitor the devices 
of the connected 
controllers.

Channel No. 1

Channel No. 2

Channel No. 3

Channel No. 4

PLC by bus connection

OMRON PLC

Temperature controller

Servo amplifier
1 - 22 1. Overview of the GOT
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2. Batch edit of object settings

GT Designer3 has various functions for increasing the efficiency of screen design.
This chapter explains how to change the object settings of the copied screen efficiently.

2.1 Loading screen data
In this section, the screen data prepared beforehand is used for training.
Load the screen data from the project named "school".

Loading the screen data (project)

1. Select [Project] - [Open] from the menu.

(Next page)

1.
2. Batch edit of object settings
2.1 Loading screen data
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(From previous page)

2. In the [Open Project] dialog, double-click the 
"GOT practice course" folder.

3. Select "school".

4. Click the  button and load the 
screen data.

5. In the dialog asking whether you want to save 
the current project, click the  
button.

(Next page)

2.

3.

4.

5.
2 - 2 2. Batch edit of object settings
2.1 Loading screen data
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(From previous page)

6. The screen data is loaded.
2. Batch edit of object settings
2.1 Loading screen data
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2.2 Copying a screen in the work tree
Create screen No. 2 by copying screen No. 1.

1. Open the loaded data ("school") and right-
click screen No. 1 in the screen tree.

2. Select [Copy], and then select [Paste] from 
the menu.

3. The [Screen Property] dialog appears.

4. Change the [Screen No.] to 2.

5. Click the  button.

6. Screen No. 2 is created.

1.

2.

4.

5.
2 - 4 2. Batch edit of object settings
2.2 Copying a screen in the work tree
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2.3 Selecting objects in a batch on the data view
Select multiple objects on the [Data View] window.

(1) Data view
The [Data View] window lists all figures and objects arranged on the screen.
Double-click the figure or object to be edited directly from the list.

(2) Selecting multiple touch switches
Select the touch switches of screen No. 2.

1. Select [View] - [Docking Window] - [Data 
View].
The [Data View] window appears.

2. Select "Word Switch" on the [Data View] 
window.

3. The word switches on the screen are 
selected.

Select an item (or items) to be displayed.

Figures, object names, positions, layers, 
and object IDs (only for objects) are listed. 

When a figure or object is selected, the 
corresponding figure or object on the 
screen is displayed. 

"G" is added at the beginning of the name 
of grouped objects.

1.

3.

2.
2. Batch edit of object settings
2.3 Selecting objects in a batch on the data view
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2.4 Setting objects in a batch on the property sheet
Change the bit switch settings in a batch on the property sheet.

(1) Property sheet
The property sheet lists all items and settings of the selected objects, figures, and screens.
You can check and change the settings of objects, figures, and screens on the property sheet without opening 
the setting dialog.

Property sheet
2 - 6 2. Batch edit of object settings
2.4 Setting objects in a batch on the property sheet
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(2) Changing touch switch settings
Change the settings of the touch switches selected in section 2.3 (2) in a batch.

(a) Batch edit of the shape

1. Select [Style] → [State OFF] on the property 
sheet while selecting word switches in 
section 2.3 (2).

Click the  button in the [Shape] field to 
display the [Image List] dialog.

2. Select [Library] and [Set OFF and ON at the 
same time],
and select "FA Control Switch Figure B1:
33_ SW_02_0_B".

3. Click the  button.

4. The shape of the selected word switches is 
changed in a batch.

1.

2.

3.

4.
2. Batch edit of object settings
2.4 Setting objects in a batch on the property sheet
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(b) Batch edit of the device setting

1. Select [Device] on the property sheet.

2. Set [Device] to "D110".

3. The device setting of the selected touch 
switches is changed to "D110".

4. Creating screen No. 2 by utilizing screen No. 
1 is complete.

1.

2.

3.
2 - 8 2. Batch edit of object settings
2.4 Setting objects in a batch on the property sheet
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RemarkRemarkRemark

Changing the specific items (device, color, shape, and CH No.) in a batch
In the [Device Batch Edit] dialog, you can edit the specific items (device, network setting, CH No., color, and shape) 
within the specified range.
Display the [Device Batch Edit] dialog by using the following procedure.

• Select [Search/Replace] - [Batch Edit] - [Device]/[Network]/[CH No.]/[Color]/[Shape] menu.

Example) Changing the specific devices in the project in a batch
(D0 → D100, X0010 → M50)
2. Batch edit of object settings
2.4 Setting objects in a batch on the property sheet
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2.5 Searching for and editing a specific setting in 
the data browser

You can view the list of the common settings for objects, figures, and objects set in the project and edit them directly in 
the list or setting dialog.
You can narrow the targets displayed in the list by specifying conditions with keywords. Therefore, you can efficiently 
check and correct data which has many screens or uses existing data.

(1) Displaying the settings in the project
Select [View] → [Docking Window] → [Data Browser] from the menu to display the [Data Browser] window.
The search result list in the [Data Browser] window displays the search results according to the setting of the 
search range.

Example) When [Editing screen] is selected for [Range]
When the [Data Browser] window is displayed, the settings of the screen editor displayed at the topmost position 
are displayed.

Search result list
2 - 10 2. Batch edit of object settings
2.5 Searching for and editing a specific setting in the data browser
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If any setting in the project is changed while the [Data Browser] window is displayed, the search result list is not 
automatically updated.
Click the [Update] button to update the search result list.

To change the targets or items displayed in the [Data Browser] window, refer to the following.

(2) Changing the targets to be displayed in the data browser
(3) Changing the items to be displayed in the data browser

(2) Changing the targets to be displayed in the data browser

1. Select [View] → [Docking Window] → [Data 
Browser] from the menu to display the [Data 
Browser] window.

2. Click the [Option] button and select [Range/
Target Setting] from the pull-down menu.
The [Range/Target Setting] dialog appears.

3. Set [Range] and [Target].

4. Click the  button to reflect the setting 
to the [Data Browser] window.

When the search result list is not in the latest condition When the search result list is in the latest condition

2.
2. Batch edit of object settings
2.5 Searching for and editing a specific setting in the data browser
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(3) Changing the items to be displayed in the data browser

1. Select [View] → [Docking Window] → [Data 
Browser] from the menu to display the [Data 
Browser] window.

2. Click the [Option] button and select [Display 
Item Setting] from the pull-down menu.
The [Display Item Setting] dialog appears.

3. The items in [Display Items] are displayed in 
the [Data Browser] window.
They can be moved between [Display 
Options] and [Display Items] using the 
[Select] button and the [Delete] button.
Move items which you want to display in the 
[Data Browser] window into [Display Items].

(Next page)

2.
2 - 12 2. Batch edit of object settings
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(From previous page)

(The image shown on the left is an example 
for setting [Object ID] as the display target.)

(Next page)

Select an item to move.

Clicking the [Select] button moves the item.

Select the destination to insert the item to be moved from 
[Display Options]. 
(The item is inserted just below the selected item.)
2. Batch edit of object settings
2.5 Searching for and editing a specific setting in the data browser
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(From previous page)

4. The selected items are displayed in the [Data 
Browser] window in the order set for [Display 
Items].
You can change the order of the items in 
[Display Items] by using the [Up] button and 
the [Down] button.
Change the order of the items in [Display 
Items] as desired.

(The image shown on the left is an example 
for moving up [Object ID].)

5. Click the  button to reflect the setting 
to the [Data Browser] window.

Select an item to change the order.

Clicking the [Up] button moves up the item.
2 - 14 2. Batch edit of object settings
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(4) Changing the settings displayed in the data browser separately

(5) Changing the settings displayed in the data browser in a batch

1. Select [View] → [Docking Window] → [Data 
Browser] from the menu to display the [Data 
Browser] window.

2. The text color of each cell in the search result 
list indicates whether you can edit the cell or 
not in the [Data Browser] window.
Double-click a cell whose text color is blue 
and edit the setting.
• When the text color is blue:

The setting can be edited in the [Data 
Browser] window.
Double-click each cell to edit the setting.

• When the text color is black:
The setting cannot be edited in the [Data 
Browser] window.
Double-click each cell to display the setting 
dialog.

The setting method differs depending on the 
setting to be edited. (The image shown on the 
left is an example for changing a font.)

1. Select [View] → [Docking Window] → [Data 
Browser] from the menu to display the [Data 
Browser] window.

2. Select targets (rows) for which the batch edit 
is executed in the search result list.
Multiple rows can be selected by either of the 
following methods.
• [Shift] + click:

Selects the rows from the one where the 
cursor was placed to another row that was 
clicked.

• [Ctrl] + click:
Selects or deselects a row.

• [Shift] + Arrow (Up/Down):
Moves the cursor while selecting the row 
where the cursor was placed.
The row to which the cursor is moved is 
also selected.

The figures and objects corresponding to the 
rows selected in the search result list are 
selected on the screen editor.

(Next page)
2. Batch edit of object settings
2.5 Searching for and editing a specific setting in the data browser
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(From previous page)

3. Click the [Option] button and select [Device 
Batch Edit], [Text Batch Edit], or [Color Batch 
Edit] from the menu.
The batch edit dialog to change each setting 
appears.

(The images shown on the left are an 
example for when [Text Batch Edit] is 
selected from the menu.)

4. Set each item in the displayed dialog and 
click the  button to execute the 
batch edit with the configured settings.

5. Click the  button to close the batch 
edit dialog.

6. Click the  button to update the 
search result list.

4.

5.

6.
2 - 16 2. Batch edit of object settings
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(6) Exporting the data collected in the data browser

1. Select [View] → [Docking Window] → [Data 
Browser] from the menu to display the [Data 
Browser] window.

2. Click the [Option] button and select [Export] 
from the pull-down menu.
The [Save As] dialog appears.

3. Set [File name] and [Save as type], and click 
the  button to export the search 
result list.

4. The search result list is exported in CSV 
format or Unicode text format.
(The image shown on the left is a CSV file.)

2.
2. Batch edit of object settings
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3. Drawing fundamentals

This chapter explains how to create screens for the GOT.
The screen data created in this chapter works with the sequence program described in section 3.31.

[Screens to be created]
The following shows the screens created in this chapter.

Window screen No. 1 Window screen No. 2 to 5

Base screen No. 5 Base screen No. 6 Base screen No. 7

Base screen No. 8 Base screen No. 13Base screen No. 10 Base screen No. 11

Base screen No. 14 Base screen No. 16Base screen No. 15

Base screen No. 19 Base screen No. 24Base screen No. 23

Base screen No. 17

Base screen No. 22

Main menu screen
Base screen No. 1
3. Drawing fundamentals
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3.1 Before creating screens

3.1.1 Operations before creating screens

Configure the project settings as shown below in the [New Project Wizard] window.

(1) System settings for the GOT 

[Series]: "GOT2000"
[GOT Type]: "GT27**-S (800x600)"

(2) Controller setting

[Manufacturer]: "MITSUBISHI ELECTRIC"
[Controller Type]: "MELSEC-Q/QS, Q17nD/M/NC/

DR, CRnD-700"

[I/F]: "Ethernet:Multi"

[Communication Driver]: "Ethernet(MITSUBISHI 
ELECTRIC), Gateway"
3 - 2 3. Drawing fundamentals
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(3) GOT IP address settings

[GOT IP Address]: "192.168.3.18"

(4) Screen switching device settings

[Base Screen]: "D0"
[Overlap Window1]: "D1"

(5) Saving project data
Save the project data.

Select [Project] - [Save As] from the menu, and 
save the current project with the name "JISSEN".
3. Drawing fundamentals
3.1 Before creating screens
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3.1.2 Drawing figures

This section describes how to draw figures and how to edit the figures placed on screens.

(1) Types of figures
The following figures can be drawn with GT Designer3:

Icon Description Shortcut key

Used to draw a line. -

Used to draw a freeform line. -

Used to draw a rectangle. -

Used to draw a polygon. -

Used to draw a circle. -

Used to draw an arc. -

Used to draw a sector. -

Used to draw a scale. -

Used to draw a piping. -

Used to draw a text figure. -

Used to draw a text figure with a style. -

Used to make the paint settings. -

Used to paste bit map data or JPEG data on the current screen. -

Used to paste DXF data on the current screen. -

Used to paste IGES data on the current screen. -

Used to import a screenshot of the selected rectangular area on the display. -

Used to import a screenshot of the selected window on the display. -
3 - 4 3. Drawing fundamentals
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(2) How to draw a figure
The following shows how to draw a polygon as an example.

1. Click  on the figure toolbar.

2. Click the left mouse button at the starting for a 
polygon.

3. Drag the mouse to the second vertex.

4. Release the left mouse button to set the 
second vertex.

(Next page)

1.

Start point

Start point

Second point
3. Drawing fundamentals
3.1 Before creating screens
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(From previous page)

5. Click the left mouse button at the third vertex.

The third vertex is set.

6. Repeat this procedure to increase the number 
of vertexes to draw a polygon.

7. Double-click the left mouse button at the last 
vertex to draw a polygon.
3 - 6 3. Drawing fundamentals
3.1 Before creating screens
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(3) Editing a drawn figure
Use the following edit operations to edit a drawn figure.

Edit Description Operation

Cut Cuts a figure or an object. • Select [Edit] → [Cut] from the menu.

Copy Copies a figure or an object. • Select [Edit] → [Copy] from the menu.

Paste Pastes a cut or copied figure or object. • Select [Edit] → [Paste] from the menu.

Delete Deletes a figure or an object. • Select [Edit] → [Delete] from the menu.

Move to the front 
of the front layer / 
Move to the back 
of the back layer

Changes the display order of objects on the 
screen.

(Example) Change the display order of selected 
objects.

• Select [Edit] → [Stacking Order] → [Move to the Front 
of Front Layer] from the menu.

• Select [Edit] → [Stacking Order] → [Move to the Back 
of Back Layer] from the menu.

Move to the front 
of the layer / 
Move to the back 
of the layer

Changes the display order of figures or objects in 
the same layer.

(Example) Move a selected figure to the front.

• Select [Edit] → [Stacking Order] → [Move to the Front 
of Layer] from the menu.

• Select [Edit] → [Stacking Order] → [Move to the Back 
of Layer] from the menu.

Flip vertically
/ Flip horizontally

Flips a figure. (Any object cannot be flipped.)

(Example) Flip a selected figure vertically. • Select [Edit] → [Rotate/Flip] → [Flip Vertical] from the 
menu.

• Select [Edit] → [Rotate/Flip] → [Flip Horizontal] from 
the menu.

Rotate 90° 
counterclockwise
/ Rotate 90° 
clockwise

Rotates a figure 90° clockwise or 
counterclockwise. (Any object cannot be rotated.)

(Example) Rotate a selected figure 90° 
counterclockwise. • Select [Edit] → [Rotate/Flip] → [Rotate Left] from the 

menu.
• Select [Edit] → [Rotate/Flip] → [Rotate Right] from the 

menu.
3. Drawing fundamentals
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(4) Changing the attribute settings
Change the attributes of the created figure using the property sheet.
To change attributes other than the pattern color, set the following items of the property sheet.

POINTPOINTPOINT

Alternatively, double-click a figure to change the attribute settings in the figure setting dialog.

1) [Line Style]
Select a line style.

2) [Line Width]
Select a line width.

3) [Line Color]
Select a line color.

4) [Pattern]
Select a fill pattern for the figure.

5) [Shape Color]
Select a fill color for the figure.

6) [Background Color]
Select a background color for the figure.

7) [Text Color] (only when a text figure is selected)
Select a text color.

8) [Text Style] (only when a text figure is selected)
Select a text style.

9) [Solid Color] (only when a text figure is selected)
Select a text shadow color.

10) [Use Background Color] (only when a text figure 
is selected)
Select whether to use a background color.

11) [Background Color] (only when a text figure is 
selected)
Select a background color.

4)

2)
3)

5)

1)

6)

9)
8)
7)

10)
11)
3 - 8 3. Drawing fundamentals
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3.2 Setting text figures
In this section and subsequent sections, practice how to create screens.

Create base screen No. 1 as shown below.

3.2.1 Setting a text figure (Outline font and text with a shadow)

(1) Click  on the figure toolbar, and then click any position on the screen editor.

(2) The [Text] dialog appears.
Enter a character string in [Text].

POINTPOINTPOINT

• You can enter a character string containing up to 512 characters.
You can enter a multi-line character string.

• To start a new line, press the  key at the end of the current line.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Set a title by using text figures. 
(Select [Outline Gothic] (32 dots) 
and [Solid] in the text figure 
setting.)

Go To Screen switch 
It switches the screen of each 
base screen. 
Create the switches by following 
the descriptions of the sections 
from 3.3.

(Input example) (Display example)
3. Drawing fundamentals
3.2 Setting text figures
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(3) Set the attributes for the entered character string.

(a) Style
The following text styles are available.

(b) Font

Classification Type Image KANJI region

Standard font

6 × 8 dots Not supported

12-dot Standard Supported

16-dot Standard (Mincho) Supported

16-dot Standard (Gothic) Supported

HQ font

12-dot HQ Mincho Supported

12-dot HQ Gothic Supported

16-dot HQ Mincho Supported

16-dot HQ Gothic Supported

TrueType font

TrueType Mincho Supported

TrueType Gothic Supported

TrueType Numerical 
(Gothic)

Not supported

TrueType Numerical (7-
segment)

Not supported

Outline font
Outline Square style Supported

Outline Gothic Supported

Windows font

TrueType font and 
OpenType font of 
Windows installed in a 
personal computer

Not supported

No character 
effect [Bold]

[Solid]
[Raised]

[Italic]
[Underline]

[Italic] + [Underline]
3 - 10 3. Drawing fundamentals
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(4) Set the items as follows.

Enter "GOT2000 Initial 
screen".

1. Set "Outline Gothic" for [Font].

2. Select "32" for [Size].

3. Select "Solid" for the text style.

(Input example) (Display example)

1.
2.
3.
3. Drawing fundamentals
3.2 Setting text figures
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3.2.2 Setting a Go To Screen switch

Set touch switches that switch a base screen to another one.

(1) Placing a Go To Screen switch

1. Select [Object] - [Switch] - [Go To Screen Switch] 
from the menu.

2. Click the position to place a Go To Screen 
switch.

3. The Go To Screen switch is placed.

4. Select the placed Go To Screen switch (with the 
handle is displayed), and drag the handle to 
resize the Go To Screen switch.

5. Double-click the newly sized Go To Screen 
switch to display the setting dialog.

1.

Drag
3 - 12 3. Drawing fundamentals
3.2 Setting text figures



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS
(2) Setting the switch action for the Go To Screen switch

1. Check that "Base" is selected in [Screen Type].

2. Set [Next Screen]. The specified screen is 
displayed when the Go To Screen switch is 
touched.
[Fixed]: Switches to the base screen or 

window screen with a specified 
screen number.

[Back (Previous/History)]:
Returns to a previous base screen. 
Up to 10 screens can be switched 
according to the history.

[Device]: Switches to the base screen or 
window screen whose screen 
number is specified with the status of 
a device (Value of a bit device or 
word device).

Select [Fixed] and then set 5 for [Screen No.].

3. Click the [Style] tab to set the display style of the 
Go To Screen switch.

3.
1.
2.
3. Drawing fundamentals
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(3) Setting the display style (including shape and color) of the Go To Screen switch

1. In [Shape], select what shape to display when 
the switch is off.

: Displays the currently set shape and 
shapes that have been set in the 
past.

[Shape]: Displays shapes not in the list box 
and shapes from the library.

Select "FA Control Switch Figure A1: 33 
SW_02_0_B" from [Shape].

2. Select [Shape Color] to be used when the switch 
is off.
Configure the setting as shown below.
[Shape Color]: "Blue"
 (Selecting "33 SW_02_0_B" sets [Shape Color] 
to "Blue".)

3. To set the display style of when the switch is on, 
click the ON button.

4. Set the display style to be used when the switch 
is on, as shown below.

[Shape]: "FA Control Switch Figure A1: 36 
SW_02_1_R"

[Shape Color]: "Red"

5. To set the text to be displayed on the switch, 
click the [Text] tab.

3.

2.

1.

4.

5.
3 - 14 3. Drawing fundamentals
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(4) Setting the display style (Text) of the Go To Screen switch

1. Set [Font], [Text Size], [Text Color], and the text 
style to be used when the switch is off.

Configure the settings as shown below.

[Font] : "Outline Gothic"
[Text Size] : "12"
[Text Color] : "White"
Text style : "Regular"

2. Set the text display position.

Select "Center" for [Display Position],
" " for [X], and " " for [Y].

The following positions are selectable for the text 
displayed on a switch or lamp.

3. Enter the following character string in [Text].
"Data
set"

(Next page)

1.

3.

2. Switch figure RightLeft

Up

Down

Center
3. Drawing fundamentals
3.2 Setting text figures

3 - 15



(From previous page)

4. Check that [OFF=ON] is selected.
(If it is selected, the settings to be used when the 
switch is off will be copied.)

5. If it is not selected in step 4, select it now. A 
confirmation message appears. Click the 

 button.

The character string is displayed on the ON 
switch.

6. Click the  button to complete the 
settings.

4.

5.

6.
3 - 16 3. Drawing fundamentals
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(5) Creating the other Go To Screen switches by copying and pasting the Go To Screen switch created 
in (1) to (4)
Configure the settings as shown below.

Switch name
Setting item

Monitor 1 Graph Window check Security 1/2 Security 2/2 State

Basic tab

[Screen Type] [Base] [Base] [Base] [Base] [Base] [Base]

[Fixed] 6 7 8 10 11 13

[Text] tab
Displayed text 
for off and on Monitor 1 Graph Window check Security 1/2 Security 2/2 State

Switch name

Setting item

Display 
condition
Operating 
condition

Offset
Parts 

movement
Recipe Comment User alarm

Basic tab

[Screen Type] [Base] [Base] [Base] [Base] [Base] [Base]

[Fixed] 14 15 16 17 19 22

[Text] tab
Displayed text 
for off and on

Display 
condition
Operating 
condition

Offset
Parts 

movement
Recipe Comment User alarm

Switch name

Setting item

Document 
display 
function

Script Text input
Operating 

time display

Basic tab

[Screen Type] [Base] [Base] [Base] [Base]

[Fixed] 23 24 20 3

[Text] tab Displayed text 
for off and on

Document 
display 
function

Script Text input Operating 
time display
3. Drawing fundamentals
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(6) Clicking the  button to complete the settings

RemarkRemarkRemark

Lamp function
How to switch touch switch images (Shapes of on status and off status) can be selected in "Lamp" in the [Bit 
Switch] dialog.

• Key: The shape of the on status is displayed while you press the touch switch.
The shape of the off status is displayed while you do not press the touch switch.

• Bit: When the bit device set in [Device] turns on, the shape of the off status is switched to the shape of the on 
status.

• Word: When the value of the word device set in [Device] changes to a value within the range specified in 
[Range], the shape of the off status is switched to the shape of the on status.

For the details of the settings described in this section, refer to GT Designer3 (GOT2000) Help or the GT 
Designer3 (GOT2000) Screen Design Manual.
3 - 18 3. Drawing fundamentals
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3.3 Setting numerical inputs and the numeric 
keypad window

(1) Base screen settings
Create base screen No. 5 as shown below.
D10, D12, and D15 are PLC CPU devices.
(Refer to the training device list in section 3.31.)

(2) Sequence program

3.3.1 Setting for numerical inputs

To input numerical values, the following setting is required.

(1) Key window setting
Set the type of key window (Numeric keypad) used to input numerical values.
Even if the type is not set, the system key window can be used for numeric input.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Numerical input, 4-digit decimal number
  Write device: 16 bits (D10)

Key window 
  Use it to input numerical values.

Numerical input, 5-digit decimal number and 1-digit 
decimal point 
  Write device: 16 bits (D15)

Numerical input, 9-digit decimal number and 2-digit 
decimal point 
  Write device: 32 bits (D12)

Go To Screen switch 
  It switches the screen to the base screen No. 1.

Go To Screen switch 
  It switches the screen to the base screen No. 6.

Setting the timer ON/OFF and timer limit D15 with the GOT

 0 
SM401

Always 
OFF

M10

GOT 
timer 1

M11

GOT 
timer 1 OFF

< K0 D15
Timer 1 
limit

D15
T10

Timer 1

M12

Timer 1 
ON

M12
Timer 1 
ON
3. Drawing fundamentals
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3.3.2 Numerical input: Setting a 4-digit number (for surface level setting)

Write device: 16 bits (D10)

(1) Clicking  on the object toolbar, and placing an object on the screen

RemarkRemarkRemark

(1) Resizing the placed shape or object
The following shows how to resize the placed shape or object.
(a) Select a shape or an object to be resized.
(b) Click and drag a sizing handle to resize the shape or object.

(2) Changing the options for placing shapes and objects
To change the options for placing shapes and objects, select [Tools] - [Option] to display the [Operation] tab.
For how to set the options, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen 
Design Manual.

1. Move the cursor to the screen, and click the 
position to place a numerical input.

2. Double-click the object to open the setting dialog.
3 - 20 3. Drawing fundamentals
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(2) Making basic settings

1. Click the  button.

2. Set "D10" for [Device].

3. Click the  button.

1.

2.
3. Drawing fundamentals
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(3) Setting the display format (to handle decimal numbers ranging from 0 to 9999)

(4) Making settings on the screen

1. Set [Format] to "Signed Decimal".

2. Set [Digits (Integral)] to "4".

3. Select the [Fill with 0] checkbox.

4. Select the [Include signs in the integer portion] 
checkbox.

5. Select an icon for [Alignment].
[ ]: Aligns the number to the right within the 
display range.

[ ]: Aligns the number to the left within the 
display range.

[ ]: Aligns the number in the center of the 
display range.

Select the icon of right alignment.

6. Enter "123" in [Sample Value] of [Preview].

7.  Click the  button.

1. Create a display frame for the object by placing a 
figure on the screen.

2. Create a title text by placing a figure on the 
screen.

Note) Create "mm" using a text figure.

The settings of the numerical input are complete.

1.
2.

4.
6.

3.
5.

7.

1.

2.
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3.3.3 Numerical input: Setting a 4-digit number with 1 digit after the decimal 
point (for timer 1 limit setting)

Write device: 16 bits (D15) with a display frame

(1) Clicking  on the object toolbar, and placing an object on the screen

(2) Setting the device

1. Move the cursor to the screen, and click the 
position to place a numerical input.

1. Double-click the object to open the setting 
dialog.

2. Set [Device] to "D15".2.
3. Drawing fundamentals
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(3) Setting the display format (to handle numbers ranging from 0.0 to 999.9)

1. To enter a number with a decimal point, set 
[Format] to "Real".

2. Set [Alignment] to  (Right alignment).

3. Set [Digits (Integral)] to "3".

4. Select the [Fill with 0] checkbox.

5. Select the [Include signs in the integer portion] 
checkbox.

6. Set [Digits (Fractional)] to "1".

7. Select [Adjust Decimal Point Range].

1.
2.

6.

5.
3.
4.

7.
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(4) Reading/writing data with a decimal point
(a) Reading/writing integer data as data with a decimal point

Reading integer data from a PLC CPU as data with a decimal point or writing data with a decimal point to a 
PLC CPU as integer data requires conversion between integer data and data with a decimal point.
If [Adjust Decimal Point Range] under the [Device] tab is selected, the value will be converted between 
integer data and data with a decimal point (Real number) corresponding to the set digit of decimal points.

(b) Reading/writing data with a decimal point
To read/write a real number (Floating point data) from/to the PLC CPU, configure the settings as shown 
below.

([Adjust Decimal Point Range] is grayed out because the decimal point setting is not required.)

GOT

Input 123.9 to the GOT.

123.9

The value read from the PLC CPU, 123.9 is displayed on the GOT.

GOT device
$W: Input value
$$: Monitor value

"$W" = 123.9

"$$" = 123.9

1239D15

Processing at writing
123.9 × 10

(Multiplied by a 
minimum unit)

Processing at reading
1239 ÷ 10

(Divided by a 
minimum unit)

• Number of displayed digits: 5
• Number of decimal places: 1

* When the following numbers are set

PLC CPU
3. Drawing fundamentals
3.3 Setting numerical inputs and the numeric keypad window
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(5) Setting the shape

1. Click the  button on the [Style] tab.

2. The [Image List] dialog appears. Select [61 
Frame] and [1 Frame_1].

3. Click the  button.

4. Set [Frame Color] to "Blue".

5. Set [Shape Color] to "Dark White".

6. Set [Numerical Color] to "Black".

7. Click the  button.

1.

3.

2.

6.

7.

5.

4.
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3.3.4 Numerical input: Setting an 8-digit number with 2 digits after the 
decimal point (for 32-bit data write)

Write device: 32 bits (D12) with a display frame

(1) Clicking  on the object toolbar, and placing an object on the screen
(2) Setting the device as shown below

(Use the same procedure as that described in 3.3.2.)

(3) Setting the display format as shown below
(Use the same procedure as that described in 3.3.2.)

[Device] : "D12"
[Data Type] : "Signed BIN32"

(Set the display format to handle numbers ranging 
from 0.0 to 999999.99.)

[Format] : "Real"
[Digits (Integral)] : "6"
[Fill with 0] : Selected
[Alignment] : 
[Include signs in the integer portion] : Selected
[Digits (Fractional)] : "2"
[Adjust Decimal Point Range] : Selected
3. Drawing fundamentals
3.3 Setting numerical inputs and the numeric keypad window
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(4) Setting the shape as shown below
(Use the same procedure as that described in 3.3.2.)

[Shape] : "1 Frame_1"
[Frame Color] : "Blue"
[Shape Color] : "Dark White"
[Numerical Color] : "Black"

Click the  button.
3 - 28 3. Drawing fundamentals
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3.3.5 Setting the key window display

To use the key window (Numeric keypad) for a numerical input, the action setting for the key window is required.
The following shows the main settings for the key window.

• Key window/cursor display
Set how the cursor and key window are displayed when screens are switched.

• Key window type
(a) [Display value during input] : Displays the value being input in the key window.
(b) [Display input function range] : Displays the input range of data in the key window.

Key window type

 Key window with setting (a)

Key window with settings (a) and (b) (Initial status)

For inputting decimal values

For inputting decimal values

(a)

For inputting decimal values

(a)
(b)
3. Drawing fundamentals
3.3 Setting numerical inputs and the numeric keypad window
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(1) Setting the key window action

RemarkRemarkRemark
A key window can be created by a user by registering a window screen as a key window.
(For the user-created key window, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen 
Design Manual.)

1. Select [Common] - [GOT Environmental 
Setting] - [Key Window] from the menu.

2. The [Environmental Setting] dialog appears. 
Click the [Advanced Setting] tab.

3. Check that the key window and cursor display 
settings are configured as shown on the left.
Click [Setting], and check the detailed display 
settings.

4. Click the [Basic Setting] tab.

5. Set the key window type.
Select the key window type that displays the 
value being input.

Check that "Display value during input" is 
selected.

6. Click the  button.

2.

3.

4.

5.

6.
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(2) Setting the display position of the key window
Specify the position where the key window is displayed.
If the position is not set, the key window is displayed near the object to input.
The display position of the key window can be set for each screen.

RemarkRemarkRemark
If the position is not set, the key window is displayed near the object to input.

1. Select [Object] - [Window Position] - [Key 
Window] from the menu.

2. Click a position, where the top-left corner of the 
key window will be positioned.

3. The key window is displayed at the specified 
position.

2.

3.

<When the position is set> <When the position is not set>
3. Drawing fundamentals
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3.3.6 Setting Go To Screen switches

Set a touch switch that switches a base screen to screen No. 1 and a touch switch that switches a base screen to screen 
No. 6.

(1) Creating new Go To Screen switches by copying and pasting the Go To Screen switch created in 
section 3.2.2
Set the items as shown below.

(2) Clicking the  button to complete the settings

Switch name
Setting item

Back Monitor 1

Basic tab

[Screen Type] [Base] [Base]

[Fixed] 1 6

[Text] tab Text for on and off Back Monitor 1
3 - 32 3. Drawing fundamentals
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3.4 Setting numeric displays and a level display
Create base screen No. 6 as shown below.
M10, M11, D300, D15, and T10 are PLC CPU devices.

3.4.1 Setting Go To Screen switches

Set a touch switch that switches a base screen to screen No. 1 and a touch switch that switches a base screen to screen 
No. 5.

(1) Creating new Go To Screen switches by copying and pasting the Go To Screen switch created in 
section 3.3.2
Check that the items are set as shown below.

(2) Clicking the  button to complete the settings

Switch name
Setting item Back Data set

Basic tab

[Screen Type] [Base] [Base]

[Fixed] 1 5

[Text] tab Text for on and off Back
Data
set

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Momentary switch

Level display 
  Read device: 16-bit (D300)

Numerical display, 4-digit decimal number 
  Read device: 16-bit (D10)

Numerical display, 5-digit decimal number 
and 1-digit decimal point 
  Read device: 16-bit (D15)

Numerical display, 5-digit decimal number 
and 1-digit decimal point 
  Read device: 16-bit (T10)

Go To Screen switch 
  Return to base screen No. 1.

Go To Screen switch 
  Return to base screen No. 5.

  1) ON (M10)   : Red at ON
White at OFF

  2) OFF (M11)  : White at ON
Green at OFF
3. Drawing fundamentals
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3.4.2 Setting the momentary function to a switch to keep a bit device on (for 
turning on timer 1)

Create a touch switch that keeps a bit device on while the switch is being touched.
(Write device: (M10) = OFF/ON)
When the bit device turns on, the shape of the touch switch changes to that of the on status.

(1) Placing a bit switch on the screen from the menu bar

(2) Configuring the action settings as shown below

1. Click [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the position to place a bit switch.

1. Switch function settings
[Device] : "M10"
[Action] : "Momentary"

1.
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(3) Setting the display format as shown below

1. Settings for off

[Shape] : "FA Control Switch Figure A1: 
57 SW_02_0_W"

[Shape Color] : "White"

2. Settings for on

[Shape] : "FA Control Switch Figure A1: 
35 SW_02_0_R"

[Shape Color] : "Red"
[Blink] : "None"

1.

2.
3. Drawing fundamentals
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(4) Making the settings for switching the displayed shape between on and off (Lamp function) as 
shown below

(5) Setting the text as shown below

1. Lamp function settings
[Bit-ON/OFF]: Selected
[Device]: "M12"
(When M12 is on, the switch is displayed in the 
on status.)

2. Click the  button to complete the 
settings.

1. Settings for off and on

[Font] : "Outline Gothic"
[Text Size] : "16"
[Text Color] : "Black"
[Text style] : "Regular"
[Display Position] : "Center"
[X] : (Center)
[Y] : (Center)
[Text] : "ON"

The settings are the same for both off and on.
Select the [OFF=ON] checkbox.

1.

1.
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(6) Setting the extended function as shown below

3.4.3 Setting the momentary function to a switch to keep a bit device off (for 
turning off timer 1)

Create a new switch by copying and pasting the switch created in section 3.4.2, and set the new switch as shown below.
The following shows how to copy and paste a switch.

Click an original switch. → Click . → Click . → Click the position to place the new switch.

Write device: (M11) = OFF/ON

1. Delay settings
[Delay] : "ON"
[Delay Time] : 2 seconds

2. Click the  button to complete the 
settings.

Switch name
Setting item OFF

Basic tab

[Switch Action]
[Device] : "M11"
[Action] : "Momentary"

[Lamp]

[Bit-ON/OFF]: Selected
[Device] : "M12"

(The display status of the switch is changed to the off status (Green) when the bit device 
M12 turns off.)

[Style] tab Display format
ON : [Shape Color]: "White"
OFF : [Shape Color]: "Green"
[Shape] : "FA Control Switch Figure A1: SW 02_0_"

[Text] tab Text for on and off
[Display Position]: "Center", [Text]: "OFF"

[Text Color]: "Black"

[Extended] tab [Delay] 2 seconds of OFF delay

1.

2.
3. Drawing fundamentals
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3.4.4 Numerical display (D10): Setting a 4-digit number (for surface level 
display)

Display a value between 0 and 9999 as the D10 (16 bits) value.

(1) Clicking  on the object toolbar

(2) Clicking any position on the screen to place a numerical display

(3) Double-clicking the numerical display, and making the settings as shown below
(Use the same procedure as that described in 3.3.2.)

1. Set "D10" for [Device].

2. Set "4" for [Digits (Integral)].

3. Select the [Include signs in the integer portion] 
checkbox.

4. Select the [Style] tab, and set "Frame: Frame_4" 
for [Shape].

5. Select "Blue" for [Frame Color], "Dark White" for 
[Shape Color], and "Black" for [Numerical Color].

6. Click the  button.

1.

2.
3.

4.
5.

6.
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3.4.5 Numerical display (T10): Setting a 5-digit number with 1 digit after the 
decimal point (for timer current value display)

Display a value between 0.0 and 999.9 as the T10 (16 bits) value.

(1) Creating a numerical display by copying and pasting the numerical display created in 3.4.4, and 
setting the new numerical display as shown below
(Use the same procedure as that described in 3.3.3.)

RemarkRemarkRemark

Devices of the timer, counter, and retentive timer

Timer: [Bit device] Contact (TT), coil (TC)
[Word Device] Current value (TN)

Counter: [Bit device] Contact (CT), coil (CC)
[Word Device] Current value (CN)

Retentive timer: [Bit device] Contact (SS), coil (SC)
[Word Device] Current value (SN)

1. Set "TN10" for [Device] to display the current 
value of timer 10 (T10).

2. Set "Real" for [Format].

3. Set "Round down" for [Rounding].

4. Set "3" for [Digits (Integral)].

5. Set "1" for [Digits (Fractional)].

6. Select [Adjust Decimal Point Range].
The GOT automatically adjusts an integer read 
from the PLC CPU as a value with a decimal 
point (Real number), which was set in  and 

.

7. Click the  button.

1.

4.
5. 6.

7.

2. 3.

5.
6.
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3.4.6 Numerical display (D15): Setting a 5-digit number with 1 digit after the 
decimal point (for timer limit display)

Display a value between 0.0 and 999.9 as the D15 (16 bits) value.
Create a numerical display by copying and pasting the numerical display created in 3.4.5, and set "D15" for [Device] in 
the basic tab.

3.4.7 Setting a level display

Read device: 16 bits (D300)

This function indicates the value of a word device relative to the set upper and lower limits by filling the corresponding 
area with the user-selected color (or shows the level display of the word device).
With this function, the ratio of the monitored value to the set limits can be displayed in a closed figure.

(1) Drawing a tank for a level display
Click  on the figure toolbar to draw a polygon.
Set the line color to white.

D100 = 100D100 = 50D100 = 0

0
25
50
75

100

0
25
50
75

100

0
25
50
75

100
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(2) Placing a level display on the screen

1. Select [Object] - [Meter] - [Level] from the menu.

2. Click the top-left corner of the figure drawn in (1) 
to place a level display.

Right-click any position on the screen to cancel 
the arrangement mode.

3. Resize the dotted frame of the level display so 
that the figure is completely inside.

When level display placement is complete, the 
internal coordinate mark ( ) is superimposed 
with the figure, and the color of the figure inverts.

4. Resize the dotted frame of the level display to 
the size of the figure.

Resize the frame so that the heights of the frame 
and the figure are the same.
If they are different, the level display will not 
match the actual value.

The inside of the figure is filled based on the 
frame size of the level display, so all of the figure 
interior will be filled even at a value of 80%.

Lower 
limit

Upper 
limit

Level display 
frame

Device 
value

Display 
direction

When the level display 
is placed in the figure

When no figure 
is set
3. Drawing fundamentals
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POINTPOINTPOINT

If the internal coordinate mark ( ) is not superimposed with the figure

If the internal coordinate mark is not superimposed with the figure, move the mark by using the following 
procedure.
A figure which the mark is not superimposed with cannot be set as the target of the level display.

                

(1) Right-click the dotted frame of the level display, and then click [Edit Touch Area] - [Manual Edit].

 

(2) Drag the internal coordinate mark to a position so that it is superimposed with the figure.

The color of the figure inverts and the figure is set as the target of the level display.

The figure is not set as the target 
of the level display.

The figure is set as the target 
of the level display.

Figure for the 
level display

Level display 
range frame

The internal coordinate mark        changes to        .
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(3) Double-clicking the placed level display, and making the settings as shown below

RemarkRemarkRemark
For the details of the settings described in this section, refer to GT Designer3 (GOT2000) Help or the GT 
Designer3 (GOT2000) Screen Design Manual.

1. Click the  button, and set "D300" for 
[Device].

2. Set [Boundary Color] to the same color as the 
line of the target figure of the level display.
The line color of the figure drawn in (1) is white, 
so [Boundary Color] must also be white.

3. Select a display direction.

4. Set [Upper Limit] and [Lower Limit].
Set the values that match the change range of 
the read device D300 (16 bits).

4. Set "Cyan" for [Level Color].

5. Select "□ 8" for [Level Pattern].

6. Click the  button.

1.
2.

Line color: white

3.
4.

5.
6.

7.

[Direction]: "Up"

Upper limit: 9999

Lower limit: 0
3. Drawing fundamentals
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3.5 Creating an original library
Objects and figures frequently used can be registered in [My Favorites] or a user-created library.
Objects and figures registered in a library can be easily read for use.
This section describes how to register a switch to return to the main menu in a library.

3.5.1 Registering an object

1. Use the [Back] switch on screen No. 5.

2. On the library list, select a library folder to 
register the object.

3. Click  to create [New Library data] in the 
library folder.

(Next page)

3.
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(From previous page)

4. Right-click [New Library data], and then click 
[Edit].

5. The library editor appears.

6. Paste the object to the library editor, and then 
click  to close the library editor and complete 
registration.
3. Drawing fundamentals
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3.5.2 Editing a registered object or figure

Edit an object or a figure registered in the library.

1. Select library data to be edited.

2. Right-click the data, and select [Edit] from the 
menu. (Alternatively, double-click the data.)

3. The library editor appears.
The items edited here are immediately 
reflected in the library data.
To cancel mistaken edits, click  before 
closing the library editor.
The edits are determined after the library 
editor is closed.

1.

2.
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3.5.3 Pasting an object or a figure from the library

Paste an object or a figure registered in the library to the screen.

(1) Reading a user-registered library (User-created library)
Paste the "Back" switch registered in 3.5.1 to the drawing screen.

(2) Reading the preset library (System library)
Read the library preset in GT Designer3.
The system library provides graphically designed figures and objects such as a switch ready for use.

Click.

Click.

System library
3. Drawing fundamentals
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3.6 Operation check 1
Display the screen for writing a project, and then write data to the GOT.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 1.

(2) Test 2
Perform the following test on screen No. 5.

Test object
Item Data set switch

1) Touch operation Touch the switch.

Operation 
result

Screen status The current screen is switched to screen No. 5.

Write device 5 → D0

Read device ───

Test object
Item

Surface level setting (Numerical input)

1) Touch operation Touch the numerical input area.

Operation 
result

Screen status
A key window appears. Enter a value of 7000, and then click the 
[Enter] key of the key window.

Write device 7000 → D10

Read device D10

Value displayed on 
screen

7000
3 - 48 3. Drawing fundamentals
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(3) Test 3
Perform the following test on screen No. 5.

RemarkRemarkRemark
If multiple numerical inputs are placed on the screen, you do not need to close the key window after each input.
Use the arrow keys in the key window to move the cursor to another numeric input and enter a value.

Test object
Item

Timer 1 limit setting (Numerical input)

1) Touch operation Touch the numerical input area.

Operation 
result

Screen status
A key window appears. Enter a value of 100, and then click the 
[Enter] key of the key window.

Write device 1000 → D15

Read device D15

Value displayed on 
screen 100.0

Test object
Item

32-bit data write

1) Touch operation Touch the numerical input area.

Operation 
result

Screen status
A key window appears. Enter a value of 123456.78, and then click 
the [Enter] key of the key window.

Write device 12345678 → D12

Read device D12

Value displayed on 
screen

123456.78

Writing 32-bit data

 44 
SM401

Always 
OFF

DBCD D12
Write 32
-bit data 
Lower 
data

K8Y40
3. Drawing fundamentals
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(4) Test 4
Perform the following test on screen No. 6.
(Touch the "Monitor 1" switch on screen No. 5 to switch the screen to screen No. 6.)
Check that the data set in the data set screen (No. 5) is displayed normally on the monitor screen (No. 6).

RemarkRemarkRemark
To set the data again, touch the "Data set" switch to switch the screen to screen No. 5.

Test object
Item

Surface level display (Level display)

Screen display
Check that the surface level (Water level) display varies within the 
range set in screen No. 5.

Test object
Item

Surface level setting display (Numerical input)

Value displayed on screen Check that the numeric value set in test 2 is displayed.

Test object
Item

Timer 1 limit display (Numerical input)

Value displayed on screen Check that the time limit of timer 1 is set.

Test object
Item

Timer 1 ON
(Momentary)

Timer 1 OFF
(Momentary)

Current value 
(Numerical display)

1) First touch operation
Touch the switch (for 
two seconds). ── ──

Operation 
result

Object shape The switch color 
changes to red.

──
The current value 
(Numerical display) 
increases.

Write device M10: ON ── ──

2) Second touch operation ── Touch the switch. ──

Operation 
result

Object shape
The switch color 
changes to white.

The switch color 
changes to green.

The timer current 
value (Numerical 
display) is reset.

Write device ──

M11: ON
The switch turns off 
two seconds after 
released.

──
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3.7 Using conditions to control the display and 
operation of objects

3.7.1 Setting a state for an object

Set a state for an object to change the color or frame of the object, according to the status of the device.
The following shows the conditions that can be used to change the object display.
• On/off of a monitored bit device, value of a monitored word device
• On/off of a bit device set for the state, value of a word device set for the state

Example) Changing the object color according to the value of a word device being monitored

Create base screen No. 13 as shown below.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

• Word device being monitored
D100

D100 = 40 D100 = 60 D100 = 90

Change the color according to the value of a word device being monitored.

Numerical display (The state settings are required.) 
Depending on the monitor device value, shape
colors change as follows. 
D1000 < 100: Shape color "Black" 
D1000 ≥ 100: Shape color "Red", Blink "Medium"
M1010: OFF: Shape color "Blue"

Touch switch (Stop) 
Decrease the cooling water temperature by turning off M1010.

Go To Screen switch 
Return to base screen No. 1.

Touch switch (Start) 
Increase the cooling water temperature by turning on M1010.
3. Drawing fundamentals
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(1) Using a state to set a numerical display 

1. Click  on the object toolbar, and place a 
numerical display on the screen.

2. Set the items in the [Device] tab as shown below.

[Device] : "D1000"
[Font] : "Outline Gothic"
[Number Size] : "48"
[Digits (Integral)] : "3"
[Include signs in the integer portion]: Selected

3. Set the items in the [Style] tab as shown below.

[Shape] : "Frame: Frame_1"
[Blink] : "None"
[Numerical color] : "White"

4. On the [Style] tab, click [Utilize] to set a state.

5. Click  to create a state setting.

6. Set the state condition (M1010: OFF).
Set the device as shown below.

• Select [Bit].
• Enter "M1010".
• Select [OFF].

7. Set the display color of the object applied when 
the state condition is satisfied.
Set [Shape Color] to "Blue".

(Next page)

2.

7.

4.

5. 6.

3.
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(From previous page)

8. Click  to add the next state setting.

9. Set the state condition (D1000 ≥ 100).
Select "Range" for [Device].

10.Click the [Exp] button, and set the following 
conditional expression for the value of the word 
device to be used for the state condition.
• [Constant]: "100"
• Relational operator: "<="
(For these items, refer to the following captured 
image.)

11.Set the display format of the object applied when 
the state condition is satisfied, as shown below.
• [Shape Color]: "Red"
• [Blink]: "Medium"

12.Click  to display a list of the set states.
Select a state from the list to edit the state.

Click the  button.

11.

8. 9. 10.

Device value to be monitored ($V) / input value ($W)

Relational 
operators

Constant

12.
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(1) State number and priority
A maximum of 64 states (State 0 to 63) can be set for one object.
If conditions overlap between states, the display that results from a satisfied condition with a smaller number 
is prioritized.
The following shows the order of the priority given to displays.

Example) If the conditions for states 1 and 2 are satisfied simultaneously

(2) Changing the priority

Click /  to change the number of the state being edited and its priority.

Example) If the up-arrow button or down-arrow button is clicked when "B" of state 2 is being edited

State number

1

63

0 (normal)

Priority

High

Low The display attribute which must be set for each object. 
If any conditions of other states (1 to 63) are not 
satisfied, the attribute of the state 0 is displayed.

• • • •

The state 1 is applied.

D100: 80

Not displayed

State 1

State 2

Contents to be 
displayed

Display 
condition

50 ≤ D100

0 ≤ D100

Normal

Raise the priority.

Lower the priority.

Normal

Normal

State 1

State 2

State 3

State 0

State 1

State 2

State 3

State 0

State 1

State 2

State 3

State 0

A

A

A

B

B

B

C

C

C

Up

Down
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(2) Setting a touch switch

1. Select [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the position to place a bit switch.

3. Set the items in the [Device] tab as shown below.

• [Device]: "M1010"
• [Action]: "Set"

4. Set the items in the [Style] tab as shown below.

<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

35 SW_02_0_R"
[Shape Color] : "Red"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

36 SW_02_1_R"
[Shape Color] : "Red"

Click the  button.

5. Create another switch by copying and pasting 
the switch just created.

(Next page)

3.
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(3) Placing text figures

(4) Setting a Go To Screen switch

(From previous page)

6. Double-click the new switch, and make the 
settings as shown below.

[Device] tab
• [Action]: "Reset"

[Style] tab
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

43 SW_02_0_L"
[Shape Color] : "Cyan"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

44 SW_02_1_L"
[Shape Color] : "Cyan"

Click the  button.

1.  Place the following text figures on the screen.

"Cooling water temperature"
"˚C"
"Start"
"Stop"

1. Click the Go To Screen switch to return to the 
main menu, which is registered in the library, and 
paste the switch to the screen.

* In later sections, paste the Go To Screen switch 
to return to the main menu when creating a new 
base screen.

Click.Click.
3 - 56 3. Drawing fundamentals
3.7 Using conditions to control the display and operation of objects



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS
3.7.2 Setting a display condition and an operating condition to an object

Conditions (Display conditions/operating conditions/script execution triggers) can be 
set for monitoring and writing operations of each object function.
If a condition is not satisfied, monitoring or operation is stopped or the display of the 
object is cleared.

Create base screen No. 14 as shown below to set a display condition and an operating condition.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.1
Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3

Screen

No.13
Screen

No.14

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Example) Setting a display condition for a numerical display

When a 
condition is not 

satisfied

Stop monitoring 
(The value is not displayed.)

Nothing is displayed.

Monitor 
device value

10

10

10

2

Text setting

Numerical display 
Monitor device: D1300
Display condition M1301: ON
(The display is cleared when the display condition is unsatisfied (M1301: OFF).)

Touch switch (Bit set) 
Write device: M1301
Operating condition M1302: ON
(The screen does not respond to a touch operation when the operating condition
is unsatisfied (M1302: OFF).)

Touch switch (Bit reset) 
Write device: M1301
Operating condition M1302: ON
(The screen does not respond to a touch operation when the operating condition
is unsatisfied (M1302: OFF).)

Running lamp (Bit lamp) 
Monitor device: M1301

Touch switch (Bit alternate) 
Write device: M1302
Operating condition M1301: OFF

Ready lamp (Bit lamp) 
Monitor device: M1302
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(1) Setting a display condition for a numerical display

1. Click  on the object toolbar, and place a 
numerical display on the screen.

2. Set the items in the [Device] tab as shown below.

[Device] : "D1300"
[Digits (Integral)] : "6"
[Fill with 0] : Selected
[Include signs in the integer portion] : Selected

3. Set the items in the [Style] tab as shown below.

[Shape] : "Frame: Frame_1"
[Frame Color] : "White"
[Shape Color] : "Black"

4. Click the [Trigger] tab to set a display condition.

5. Set the display condition to be satisfied when 
M1301 is on.

• [Trigger Type]: "ON"
• [Trigger Device]: "M1301"

6. Click the  button.

2.

3.

6.

4.

5.
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The following lists the conditions (Trigger types) that can be set for objects as display conditions or operating 
conditions.

Trigger type Execution condition Operation

Ordinary None • The device is monitored at the monitoring cycle of the GOT.

ON

The condition is satisfied while the trigger device is on or off.
• When set to an object (Display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

• When set to an object (Operating condition)
While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

OFF

Rise
The condition is satisfied when the trigger device is on or off.
• When set to an object (Display condition)

When the condition is satisfied, the device is monitored only once.
While the condition is not satisfied, the display of the object is retained.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

Fall

Rise/Fall

Sampling

The condition is satisfied at each set cycle.
• When set to an object (Display condition)

When the condition is satisfied, the device is monitored only once.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

Range

Word device value
Example)
Trigger device: D100
Range: 0 < D100 < 100

Condition is satisfied: D100 = 
100
Condition is not satisfied: 
D100 = -100

When the trigger device value is within the set range, the condition is 
satisfied.
• When set to an object (Display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is retained.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

• When set to an object (Operating condition)
While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

ON

OFF

ON

OFF

ON

OFF

ON

OFF

ON ON

OFF OFF

Sampling
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For the details of objects for which display conditions and operating conditions can be set, refer to GT Designer3 
(GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

Bit Trigger
Logical operation result of 
the on/off status of the 
specified bit devices

When the set AND or OR condition matches with the status of the specified 
devices, the condition is satisfied.
• When set to an object (Display condition)

While the condition is satisfied, the device is monitored at the monitoring 
cycle of the GOT.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

• When set to an object (Operating condition)
While the condition is satisfied, the set operation is executed at the 
monitoring cycle of the GOT.
While the condition is not satisfied, the display of the previous object is 
retained.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.

ON Sampling The condition is satisfied while the trigger device is on or off.
• When set to an object (Display condition)

While the condition is satisfied, the device is monitored at the set cycle.
While the condition is not satisfied, the display of the object is deleted.
Operation performed while the condition is not satisfied can be changed 
by changing the setting.OFF Sampling

Trigger type Execution condition Operation

ON

OFF

Sampling

ON

OFF

Sampling
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(2) Setting touch switches ([RUN], [STOP], and [READY] switches)

1. Select [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the position to place a bit switch.

3. Set the items in the [Device] tab as shown below.
• [Device]: "M1301"
• [Action]: "Reset"

4. Set the items in the [Style] tab as shown below.

<Settings for off>
[Shape] :"FA Control Switch Figure A1: 33 

SW_02_0_B"
[Shape Color] : "Blue"
<Settings for on>
[Shape] :"FA Control Switch Figure A1: 36 

SW_02_1_R"
[Shape Color] : "Red"

5. Set the items in the [Text] tab as shown below.

• [OFF=ON]: Selected
• [Text]: "RUN"

6. Select [Set the style and text settings for a switch 
in non-operating state] in the [Extended] tab, and 
click the  button.

(Next page)

3.

4.

5.

6.
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(From previous page)

7. Set the items in the [Style] tab as shown below.

<Settings when the switch does not function>
[Shape] :"FA Control Switch Figure A1: 55 

SW_02_0_BK"
[Shape Color] : "Black"

8. Set the items in the [Text] tab as shown below.

<Settings when the switch does not function>
[Text]: "RUN"

9. Click the [Trigger] tab to set a display condition.

10.Set the operating condition to be satisfied when 
M1302 is on.

• [Trigger Type]: "ON"
• [Trigger Device]: "M1302"

11.Click the  button.

12.Create a [STOP] switch by copying and pasting 
the switch just created.

(Next page)

7.

8.

9.

10.
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(From previous page)

13.Double-click the new switch, and make the 
settings as shown below.
[Device] tab
[Action] : "Reset"

[Style] tab
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

37 SW_02_0_Y"
[Shape Color] : "Yellow"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

36 SW_02_1_R"
[Shape Color] : "Red"
<Settings when the switch does not function>
[Shape] : "FA Control Switch Figure A1: 

55 SW_02_0_BK"
[Shape Color] : "Black"

[Text] tab
<Settings for off and on>
[Text] : "STOP"
[Text Color] : "Black"
<Settings when the switch does not function>
[Text] : "STOP"
[Text Color] : "Gray"

(Next page)
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The on or off status of the set device can be selected to display the object.

[Control displaying/hiding]
The following shows selectable items.

• [ON Display]
• [OFF Display]

(From previous page)

14.Once again, copy and paste the switch just 
created to create a [READY] switch.
Double-click the new switch, and make the 
settings as shown below.
[Device] tab
[Device] : "M1302"
[Action] : "Alternate"

[Style] tab
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

39 SW_02_0_G"
[Shape Color] : "Green"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

36 SW_02_1_R"
[Shape Color] : "Red"
<Settings when the switch does not function>
[Shape] : "FA Control Switch Figure A1: 

55 SW_02_0_BK"
[Shape Color] : "Black"

[Text] tab
[Text] : "READY"

[Trigger] tab
[Trigger Type] : "OFF"
[Trigger Device]: "M1301"
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(3) Placing text figures

(4) Setting the ready lamp and running lamp

1. Place the following text figures on the screen.

"Production volume"
"Line1"

1. Click the docked [Library] tab.

2. Select the [FA Control Lamp 1] folder from the 
display section.

3. A library list appears. Click "1 L_01_B".

4. Click the position to place the ready lamp.

5. Double-click the lamp, and set the item in the 
[Device/Style] tab as shown below.
[Device]: "M1302"

6. Place one more lamp in the same way, and then 
set it as the running lamp.
Set the item in the [Device/Style] tab as shown 
below.
[Device]: "M1301"

1.

2.

3.

5.
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(1) Object with a shape frame set
If a shape frame is set to an object with a display condition set, the object is deleted when the display 
condition is not satisfied, but the shape frame will remain.

(2) Operation performed when the display condition is not satisfied
Operation performed when the condition is not satisfied can be changed by changing the setting in the setting 
dialog.
• Displaying an object when the screen is switched for the first time

When [Display objects immediately after the screen is switched regardless of display conditions] is selected 
and if the screen is switched for the first time, the device is monitored and the object is displayed even 
though the display condition is not satisfied.

• Retaining the display of the object
When [Retain the object display when display conditions are not satisfied] is selected, the display of the 
object is retained when the condition which has been satisfied goes to be not satisfied.

(3) Operation performed when the operating condition is not satisfied
When [Clear the input object] of the [Environmental Setting] window or the [Screen Property] dialog is 
selected, the display of the object is deleted when the condition is not satisfied.

For the details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

Shape
Object

When a display 
condition is satisfied

The shape frame remains displayed.

When a display 
condition is not satisfied

1500
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3.8 Operation check 2
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 13.

Test object

Item
[Start] switch [Stop] switch

Cooling water 
temperature

(Numerical display)

Touch operation (Start) Touch the switch. ──── ────

Operation 
result

Screen status
The switch is 
pressed.

────
The value is counted 
up.

Write device M1010: ON ──── ────

Read device ──── ──── D1000

Screen display ──── ────
If the value reaches 
100, the plate blinks 
red.

Touch operation (Stop) ──── Touch the switch. ────

Operation 
result

Screen status ──── The switch is 
pressed.

The count stops (the 
plate color changes 
to blue), and the 
value decreases.

Write device ──── M1010: OFF ────

Read device ──── ──── D1000
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(2) Test 2
Perform the following test on screen No. 14.

Test object

Item

[READY] 
switch

Ready lamp [RUN] switch [STOP] switch

Production 
volume

(Numerical 
display)

Touch operation 1) ──── ──── Touch the 
switch.

──── ────

Operation 
result

Screen status ──── ────

The status of 
the switch 
does not 
change 
because the 
ready signal is 
off.

──── ────

Write device ──── ──── ──── ──── ────

Read device ──── M1302: OFF ──── ──── ────

Touch operation (Ready) (M1302) Touch the 
switch.

──── ──── ──── ────

Operation 
result

Screen status ──── ON ──── ──── ────

Write device M1302: ON ──── ──── ──── ────

Read device ──── M1302: ON ──── ──── ────

Touch operation 2) ──── ──── Touch the 
switch.

──── ────

Operation 
result

Screen status ──── ON
The switch is 
pressed.

────
The production 
volume is 
displayed.

Write device ──── ──── M1301: ON ──── ────

Read device ──── ──── ──── ──── M1301: ON

Touch operation (Stop) ──── ──── ────
Touch the 
switch.

────

Operation 
result

Screen status ──── ON ────
The switch is 
pressed.

The display of 
the value 
disappears.

Write device ──── ──── ──── M1301: OFF ────

Read device ──── ──── ──── ──── M1301: OFF
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3.9 Using layers to superimpose graphs
This section describes how to use layers to superimpose two graphs.
Create base screen No. 7 as shown below.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Bar graph (back layer) 
It displays the total production volume of each line when
(M1000) is on. 
Read device: D5, D6, D7

Trend graph (front layer) 
It displays the numerical change of each line when (M1000) is on. 
Read device: D2, D3, D4

Bit alternate switch 
Turn on (M1000).

Go To Screen switch 
Return to the base screen No. 1.
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(1) Sequence program

154 
SM401

Always 
OFF

M1000

Line 
operation

M5

Stop 
line

K10
T0

T0
MOV K0 Z0

PLS M6
Input 
graph

RST T0

197 FOR K3

199 
M6

Input 
graph

MOV D200
Numerical 
input

D2Z0
Trend 
graph 1

+ D2Z0
Trend 
graph 1

D5Z0
Bar 
graph 1

INC Z0

+ K9 D200
Numerical 

Numerical 

input

<= K20 D200

input

- K17 D200

input

251 NEXT

252 <= K100 D5
Bar 
graph 1

SET M5
Stop 
line

<= K100 D6
Bar 
graph 2

<= K100 D7
Bar 
graph 3

262 
M1000

Line 
operation

M5

Stop 
line

RST M5
Stop 
line

FMOV K0 D2
Trend 
graph 1

K3

FMOV K0 D5
Bar 
graph 1

K3

MOV K0 D200
Numerica
l input

Numerical 
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3.9.1 Superimposition

Windows can be displayed in superimposition in layers and on the same screen.

 (1) Specifications of superimposition
(2) Using layers
(3) Without using layers
(4) Special superimposition
(5) Precautions

(1) Specifications of superimposition
In superimposition, figures and objects are placed and displayed in the same layer or multiple layers.
(a) Display method

The following shows how to display figures and objects in superimposition.
• Superimposing figures and objects in the same layer

If [Adjust object display order in GOT to the one in GT Designer3] of the [Type Setting] dialog is 
selected, the display order on GT Designer3 is ensured when the figures and objects are displayed on 
the GOT.
If objects are superimposed in the same layer, the objects are not displayed or does not operate 
normally depending on the type of objects.
For the objects that are displayed and operate normally in the same layer, refer to the following.

 (3) Without using layers

• Superimposing figures and objects in the use of the front and back layer
Figures and objects can be displayed in superimposition if they are placed separately in the front layer 
and the back layer.
For the superimposition using the layers, refer to the following.

 (2) Using layers
(4) Special superimposition

In the situation that the front layer and back layer each have figures and objects superimposed in them, 
if [Adjust object display order in GOT to the one in GT Designer3] of the [Type Setting] dialog is selected, 
the display order on GT Designer3 is ensured when the figures and objects are displayed on the GOT.

(b) Windows for which superimposition is enabled
Superimposition is available for the following windows.
• Superimposing figures and objects in the same layer

Base screen, overlap window, superimpose window, dialog window, key window
• Superimposing figures and objects in the use of the front and back layer

Base screen, overlap window, superimpose window, key window
For windows other than those listed above, the object display order on the GOT may differ from that on 
GT Desiger3 because the layers are combined into one layer.
In this case, if [Adjust object display order in GOT to the one in GT Designer3] of the [Type Setting] 
dialog is selected, the display order on GT Designer3 is ensured when the figures and objects are 
displayed on the GOT.

(c) Figures and objects that are displayed in the topmost position in the layer at all times
The following figures and objects are displayed in the topmost position in the layer at all times.
• Alarms: If [Display Type] is set to [Flow]
• Scatter graphs: If [Store Memory] is set
• Figures drawn by the free figure drawing function of the object scripts
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(2) Using layers
A base screen and a window screen consist of two layers: the front layer and the back layer.
Two objects can be superimposed by placing them separately in each layer.

(a) Figures and objects which can be placed in each layer
The following shows the figures and objects which can be placed in each layer.

(b) Screens on which the layers are enabled, and the display order of figures and objects
The display order of figures and objects placed in the front layer and back layer may or may not follow the 
order of the layers.

Layer Available figures and objects

Front layer Figures (Pipings with the lamp attribute), objects

Back layer Figures, objects

Front layer

Back layer 
Displayed behind the front layer.

Actual display

Displayed as a transparent sheet. 
The areas other than the ones on which figures and objects 
are arranged are transparent and the back layer is displayed. 
The part of an object that is in the same color as the 
transparent color has transparency.

    

1254A
Objects on the front layer are 
always displayed at the front.

1254A

    

Superimposed objects are not 
correctly displayed. The order of the 
layers does not depend on the 
settings of the front and back layers.

Front layer

Back layer · When objects are not displayed in the order of the layers

· When objects are displayed in the order of the layers
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The following shows the display order of figures and objects on each screen.

Screen type Layer Display order of objects on the GOT

Base screen

Valid

Displayed in order of the layers.

Windows called on base 
screens by the set overlay 
screen function

Displayed in order of the layers.

Superimpose window

Valid

Displayed in order of the layers.

Windows called on 
superimpose windows by the 
set overlay screen function

Displayed in order of the layers.

Overlap window

Valid

Displayed in order of the layers.

Windows called on overlap 
windows by the set overlay 
screen function

Displayed in order of the layers.

Numerical display (Front layer)

Bar graph (Front layer)

Base screen

Numerical display (Front layer)

Bar graph (Front layer)

Called screen
(Window screen 1)

Numerical display (Front layer)

Bar graph (Front layer)

Superimpose window

Numerical display (Front layer)
Bar graph
(Front layer)

Called screen
(Window screen 1)

Superimpose window

Numerical display (Front layer)

Bar graph (Front layer)

Overlap window

Numerical display (Front layer)

Bar graph
(Front layer)

Overlap window
Called screen
(Window screen 1)
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(c) Transparent colors
The transparent color is set for the front layer.
The part of an object that is placed in the front layer and is in the same color as the transparent color has 
transparency.
To make an object transparent, match the transparent color with the color of the part of the object.
Set the transparent color for the front layer in the [Screen Property] dialog.

This function is not available on windows, such as a dialog window, where the layers are combined into a 
single one when they are displayed on the GOT.
If an object for which the same color as the transparent color of the front layer is set is placed on windows 
such as a dialog window, the object is displayed in the set color without transparency.

Example) If transparent colors are set for superimpose windows and dialog windows

Key window Valid

Displayed in order of the layers.

Dialog window Invalid

The layers are combined into a single layer and displayed.

Screen type Layer Display order of objects on the GOT

Numerical display (Front layer)

Key code switch

Key window

Touch switch
(Front layer)

Comment display
(Back layer)

Dialog window

12451245

1245 1245

Front layer
(Transparent color: 
Black)

Back layer

Bar graph

Numerical display
(Color in the frame: Blue)

Transparent color: 
Black

Since the transparent color 
is different from the color in 
the frame, it does not 
become transparent.

Blue Transparent color: 
Blue

Blue

Since the transparent 
color is the same as the 
color in the frame, it 
becomes transparent.

Actual 
display

Actual 
display

· When the transparent color is set to a superimpose window
(Layers are not combined when displayed on the GOT.)

· When the transparent color is set to a dialog window
(Layers are combined when displayed on the GOT.)

Transparent color: 
Black

Since the transparent color 
is different from the color in 
the frame, it does not 
become transparent.

Blue Transparent color: 
Blue

Blue

Even though the 
transparent color is the 
same as the color in the 
frame, it does not become 
transparent.

The transparent 
color is changed 

to blue.

The transparent 
color is changed 

to blue.
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(d) Superimposing two or more windows using the layers
The following shows how the layers and the transparent colors act when superimpose windows and set 
overlay screen function are used to superimpose and display two or more windows.
• Layer

The front layers and back layers that have been set for two or more windows are combined into a single 
front layer and back layer when the windows are superimposed.
Superimposed objects on the combined layers may not be displayed or operate normally.
When superimposing windows, prevent the objects in the front layers or back layers from being 
superimposed.

Certain objects can be displayed and operate normally.

• Transparent colors
The transparent colors for superimpose windows and called windows are ignored and the transparent 
colors for the base screens are enabled.
To make the objects transparent, match the colors with the transparent colors for the base screens.

Front layer

Back layer

Actual display

Base screen 1 Window screen 1

Window screen 1 
is displayed as a 
superimpose 
window.

Since the objects are superimposed, 
they are not properly displayed.

Lamp color: Red

· When the color of the object is changed according 
   to the transparent color of the basic screen

(The lamp color is changed from red to blue.)

The object on the called screen is 
displayed as the original image.

Does not become 
transparent.

The base screen 
100 is overlaid on 
the base screen 1.

Transparent color: 
Red

Transparent color: 
Black

Base screen 1
(Basic screen)

Base screen 100
(Called screen)

Front 
layer

Back 
layer

Actual 
display

· When the called screen is displayed as it is
(The lamp color is red.)

The transparent color of the basic figure 
is enabled and the lamp color (unwanted 
area) becomes transparent.

Becomes 
transparent.
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(3) Without using layers
Certain objects can be displayed and operate normally even when they are superimposed in the same layer.
The following lists the objects that can be superimposed in the same layer.

(a) Superimposition with touch switches
Touch switches without figures and text can be used in superimposition with the other objects.

The following lists the objects that can be superimposed with touch switches.

*1 To superimpose a numerical display and a text display, place them in separate layers.

 (2) Using layers
*2 An alarm display with a touch operation arranged for it cannot be superimposed with touch switches.

When superimposing touch switches with objects, do not make the following settings for the touch 
switches.
• Selecting an item other than [None] for [Shape] in the [Style] tab
• Setting [Reverse switch area] if [None] has been selected for [Shape] in the [Style] tab
• Selecting [Text] for [Text Type] in the [Text] tab and then inputting a text to [Text]

Combination Reference

Touch switch and other objects (other than the numerical input and text input) (a) Superimposition with touch switches

Level object and numerical display/comment display (b) Superimposition with level objects

Parts display and parts display (c) Superimposition of parts displays

Object that can be superimposed with touch switches

Lamp Numerical display*1 Text display*1 Date display

Time display Comment display Parts display Parts movement

Historical data list display Alarm display*2 Level object Panel meter

Line graph Trend graph Bar graph Statistics bar graph

Statistics pie graph Scatter graph Historical trend graph

· Combination of a touch switch and the other objects

· Level display + numerical display/comment display

· Parts display  + Parts display

· Figure + Object

The object is displayed 
on the figure.

+

+

+

+

50

5050

Touch switch
(without figures)

Lamp display

Although the touch switch is not displayed, 
it responds when touched.
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(b) Superimposition with level objects
The following lists the objects that can be superimposed with level objects.

• Number of objects that can be superimposed with level objects
In superimposing level objects with objects, two or more objects can be superimposed with a single level 
object.

• Setting example
Depending on the display mode of the objects with which level objects are superimposed, the displays of 
the level objects differ.
Example 1) If [Transparent] is selected for [Display Mode] of a numerical display, numerical input, or 

comment display
The numerical display color and text color are displayed as they are.

Example 2) If [XOR] is selected for [Display Mode] of a numerical display, numerical input, or comment 
display

When the target object is superimposed on the fill color portion of the level object, the color of the 
overlapping portion is inverted in the target object.

(c) Superimposition of parts displays
Two or more parts can be displayed in superimposition.
Select [Overwrite] for [Display Mode] of parts displays.

(4) Special superimposition
By using superimpose windows, the set overlay screen function, and multiple placements on the same screen, 
up to eight objects including touch switches, numerical inputs, and text inputs set for each window can be 
superimposed.

Object that can be superimposed with touch switches

Numerical display Numerical input Text display

20 48 98

FULL FULLFULLFULL

Parts display A
(Displays the parts No. 1 at rise of M10.)

Parts display B
(Displays the parts No. 2 at rise of M20.)
Parts display C
(Displays the parts No. 3 at rise of M30.)

Three parts displays are 
superimposed and placed.

Parts display A 
is displayed.

M10 = OFF → ON M20 = OFF → ON

Parts display B 
is displayed.

M30 = OFF → ON

Parts display C 
is displayed.
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(a) Special method for superimposing touch switches, numerical inputs, and text inputs
• Superimposition with superimpose windows

Superimpose windows are superimposed in front of the base screen, and displayed as a single window.

• Superimposition with the set overlay screen function
Calling base screens and window screens on basic screens (Base screens and superimpose windows), 
this function displays them as a single screen.

• Superimposition by multiple placements on the same screen (for touch switches only)
Up to six touch switches can be superimposed and displayed on the same screen.

POINTPOINTPOINT

Setting two or more actions for a single touch switch
If switches are used, a set of actions arranged when two or more touch switches are superimposed can be 
imposed on a single touch switch.

Superimpose window 1

Superimpose window 2

Base screen

Basic screen
(Base screen)

Set overlay screen

Basic screen
(Base screen)

Touch switches which are superimposed 
on the same screen (Up to six switches)
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(b) Actions for superimposed touch switches, numerical inputs, and text inputs
• Number of objects that have their actions enabled

Actions for superimposed objects are enabled for up to six objects including touch switches, numerical 
inputs, and text inputs when these objects are superimposed using the set overlay screen function or 
they are placed on the same screen. If superimpose windows 1 and 2 are used, actions for up to eight 
objects are enabled.
Actions for touch switches, numerical inputs, and text inputs coming after eighth are not enabled.

• Key window actions in superimposition
Of two or more superimposed numerical inputs or text inputs, only the first enabled numerical input or 
text input opens the touch key window if [Display when touched] has been selected for the key window 
action in the [Key Window Advanced Setting] tab of the [Screen Property] dialog.
The other objects do not work.

(c) Order of priority according to the combination of superimposed windows
The following shows the order of priority given to actions for touch switches, numerical inputs, and text 
inputs, according to the combination of superimposed windows.

9
8
7
6
5
4
3
2
1

Base screen

Called screen
(Base screen)

Superimpose 
window 1, 2

Multiple placements on 
the same screen

Action order of 
objects

Does not operate.

Number of objects that 
have their actions enabled
Actions of up to eight objects are 
performed by using the superimpose 
window 1 and 2.

Called screen (1 to 99)
Front layer

Basic screen

Back layer
Basic screen

Front layer
Basic screen

Back layer
Basic screen

Front layer
Basic screen

Base screen 

Back layer
Basic screen

Touch

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

Called screen (1 to 99)

Superimpose 
window 2 

Superimpose 
window 1 

A
ct

io
n 

or
de

r o
f o

bj
ec

ts

O
bj

ec
ts

 w
ho

se
 a

ct
io

ns
 a

re
 e

na
bl

ed
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• Order of actions for called screens
Actions for called screens are enabled in order of the set overlay screen function displaying the called 
screens.

• The number of called screens that can have the objects on them enabled
Superimposed objects including touch switches, numerical inputs, and text inputs on a maximum of 99 
called screens are enabled.
If 100 or more screens have been called, the touch switches, numerical inputs, and text inputs on the 
screens called after the hundredth do not work.
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(d) Application example
The following shows enabled touch switches, numerical inputs, or text inputs set on two or more screens.
The numbers 1 to 99 added to called windows indicate the order in which windows are called on base 
screens or window screens.

2) 8)7)

8)

Layer

Front

Back

Front

Back

Front

Base screen

Back

Object which does not operate
Object which operates

Basic screen

Called screen 99

Called screen 5

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

Called screen 99

Called screen 5

Called screen 4

Called screen 3

Called screen 2

Called screen 1

Basic screen

8) 8)

5)

6)

7)

6)

7)

4)

5)

3)

5)

6)

6)

4)

5)

6)

4)

5)

4)

3) 7)

2)

3)

2)

3)

4)

1)

2) 5)

6)

1)

2)

3)

1)

2)

3)

4)

1)

Superimpose 
window 1

Superimpose 
window 2

7)

Screen type

1) to 8): Order of action to be enabled

TouchTouchTouchTouchTouchTouch

1) 1) 7)

A
ct

io
n 

or
de

r
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(5) Precautions

(a) Superimposing in the same layer the figures and objects that are always displayed in the topmost position 
in the layers
If the following figures and objects are superimposed on the same layer, they may not be displayed 
normally depending on the settings made for them.
• Alarms: If [Display Type] is set to [Flow]
• Scatter graphs: If [Store Memory] is set
• Figures drawn by the free figure drawing function of the object scripts
To superimpose the objects of each type listed above, place them in the separate layers.

(b) Displaying objects with the XOR synthesis
• If neither figure nor object has been placed behind objects that have been placed in the front layer

If neither figure nor object has been placed behind the objects for the XOR synthesis, the objects 
integrate into the XOR synthesis with the transparent color of the front layer.

• Integrating into the XOR synthesis with figures
Place objects in the back layer.

(c) Superimposing objects with [Simultaneous Press] set for them
If keys with simultaneous presses disabled are superimposed, the keys do not work even if they are 
touched.
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3.9.2 Setting a trend graph

Place a graph that displays fluctuations in the quantity of output produced by lines 1, 2, and 3 for each line on the front 
layer.

(1) Clicking  on the object toolbar, and placing an object on the screen

(2) Configuring the data settings

1. Click the position to place the object.

2. Double-click the object to open the setting 
dialog.

1. Set [Number of Pens] to "3".

2. Set [Points] to "5".

(Next page)

2.1.
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(From previous page)

3. Set the pen that shows the quantity of output 
produced by line 1 as shown below.
[Device] : "D2"
[Line Attribute] : [Line Style]: "―"

[Line Width]: "3 Dot"
[Line Color]: "White"

4. Set the pen that shows the quantity of output 
produced by line 2 as shown below.
[Device] : "D3"
[Line Attribute] : [Line Style]: "―"

[Line Width]: "3 Dot"
[Line Color]: "Red"

5. Set the pen that shows the quantity of output 
produced by line 3 as shown below.
[Device] : "D4"
[Line Attribute] : [Line Style]: "―"

[Line Width]: "3 Dot"
[Line Color]: "Green"

6. Set [Lower Limit] to "0".

7. Set [Upper Limit] to "100".

3.
4.

6.
7.

5.
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(3) Configuring the style settings

(4) Configuring the extended function setting

1. Set the scale of the "Left" axis position as shown 
below.
[Axis Position] : "Left"
[Main Scale] : [Scale Points]: "3"
[Scale Value] : [Value]: "3"

[Lower Limit]: "0"
[Upper Limit]: "100"

2. Set the scale of the "Bottom" axis position as 
shown below.
[Axis Position] : "Bottom"
[Main Scale] : [Scale Points]: "6"
[Scale Value] : [Value]: "6"

[Lower Limit]: "0"
[Upper Limit]: "5"

3. Clear [Main Scale] and [Scale Value] for the 
"Top" and "Right" axis positions.

1. Set [Layer] to "Front".

1.

2.

1.
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(5) Configuring the display condition settings

(6) Making settings on the screen

1. Set [Trigger Type] to "Sampling" and set 
[Sampling] to "10 (x100ms)" so that values are 
detected in the 1-second period.

2. Click the  button.

1. Enlarge the size of the graph for adjustment.

1.

2.
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3.9.3 Setting a bar graph

Place a graph that displays comparison of the total quantity of output produced by lines 1, 2, and 3 for each line on the 
back layer.

(1) Clicking  on the object toolbar, and placing an object on the screen

(2) Configuring the data settings

1. Set [Number of Pens] to "3".

2. Set the pen that shows the total quantity of 
output produced by line 1 as shown below.
[Device]: "D5", [Graph]: "White", [Pattern]: 
"NONE"

3. Set the pen that shows the total quantity of 
output produced by line 2 as shown below.
[Device]: "D6", [Graph]: "Red", [Pattern]: 
"NONE"

4. Set the pen that shows the total quantity of 
output produced by line 3 as shown below.
[Device]: "D7", [Graph]: "Green", [Pattern]: 
"NONE"

5. Set [Lower Limit] to "0".

6. Set [Upper Limit] to "100".

7. Set [Reference Value] to "0".

1.

2.
3.

5.
6.
7.

4.
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(3) Configure the style settings

(4) Configuring the extended function setting

(5) Making settings on the screen

1. Set the upper and lower limits of the scale value 
range as shown below.

[Lower Limit]: "0" (Y)
[Upper Limit]: "100" (Y)

1. Set [Layer] to "Back". (Default)

2. Click the  button.

1. Enlarge the size of the bar graph to match that of 
the trend graph.

(Next page)

1.

1.
2.
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(From previous page)

2. Select the bar graph and trend graph.

3. Select [Edit] - [Align] - [Custom] from the menu.

4. Select [Center] for both the horizontal and 
vertical alignment, and click the  button.

5. The two graphs are shown overlapping one 
another.

4.
3. Drawing fundamentals
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3.9.4 Switching a displayed layer

Switch layers on the screen to check the placed objects.

(1) Displaying the front layer

(2) Displaying the back layer

RemarkRemarkRemark
For the details of the layer settings, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) 
Screen Design Manual.

1. Click [Layer: Front].

2. Only the trend graph placed on the front layer is 
displayed.

1. Click [Layer: Back].

2. Only the bar graph placed on the back layer is 
displayed.

1.

1.
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3.9.5 Setting a bit alternate toggle switch (for graph operations)

Create a touch switch that turns on or off a bit device each time the switch is touched. (Operation starts when the device 
M1000 turns on.)

(1) Placing a bit switch on the screen from the menu bar

(2) Configuring the settings as shown below
(For the shape, click the [Shape] button to open the dialog, and select "FA Control Toggle Figure" and then "35 
TG_02_0_R" from the library.)

(3) Clicking the  button to complete the settings

 

1. Click [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the position to place a bit switch.

Setting item Setting

[Device] tab
[Switch Action]

[Device] M1000

[Action] [Alternate]

[Lamp] [Bit-ON/OFF], M1000

[Style] tab Display format
(Same for on and off)

[Shape] FA Control Toggle Figure: 35 TG_02_0_R

[Shape Color] Red
3. Drawing fundamentals
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3.9.6 Setting a Go To Screen switch

Read the switch to return to screen No. 1 (Main menu), which is registered in the library in section 3.5, and paste the 
read switch to the screen.

(1) In the library workspace, select the switch to return to the main menu from [My Favorites].

(2) Drag and paste the switch to screen No. 7.

RemarkRemarkRemark
For the details of the graphs, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen 
Design Manual.
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3.10 Operation check 3
Display the screen for writing a project, and then write data to the GOT.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.
Check that the graphs created on the front layer and back layer in screen No. 7 are displayed normally.

(1) Test 1
Perform the following test on screen No. 7.

Test object
Item

Toggle switch
(TL)

Trend graph Bar graph

1) First touch operation Touch the switch. ──── ────

Operation 
result

Object shape The toggle switch is 
moved right.

M1000: The value of 
the graph changes 
when this device 
turns on.

M1000: The value of 
the graph increases 
when this device 
turns on.

Write device M1000: ON ──── ────

Read device ──── D2: D3: D4 D5: D6: D7

2) Second touch operation Touch the switch. ──── ────

Operation 
result

Object shape
The toggle switch is 
moved left.

M1000: The value of 
the graph is reset 
when this device 
turns off.

M1000: The value of 
the graph is reset 
when this device 
turns off.

Write device M1000: OFF ──── ────

Read device ──── ──── ────
3. Drawing fundamentals
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3.11 Setting a window screen
Create window screen No. 1 to be displayed on the base screen, and set its display 
format.

Window screen No. 1 is composed of the following three types and five windows.
• Overlap windows 1 and 2: Displayed and superimposed on the base screen.
• Superimpose windows 1 and 2: Combined and displayed on the base screen as a single screen.
• Dialog window: Displayed on the top.

Screen
No.8

Screen
No.6

Screen
No.7

Screen
No.5

Screen
No.17

Screen
No.14

Screen
No.15

Screen
No.16

Screen
No.19

Screen
No.22

Screen
No.10

Screen
No.11

Screen
No.1

Screen
No.13

Screen
No.23

Screen
No.24

Screen
No.20

Screen
No.3

Set a title by placing a text figure.

Window display switch (dialog window) 
It closes the dialog window.

Window close switch (superimpose window) 
It closes the superimpose window.

· Overlap window 1
· Overlap window 2
· Superimpose window 1
· Superimpose window 2

Window display switch (overlap window) 
It displays window screen No. 1 as an overlap window.

Window display switch (superimpose window) 
It displays window screen No. 1 as a superimpose window.

Window display switch (dialog window) 
It displays window screen No. 1 as a dialog window.
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(1) Setting screen switching devices

The following shows the settings.

1. Select [Common] - [GOT Environmental Setting] 
- [Screen Switching/Windows] from the menu.

2. Select [1] in [Overlap Window].

Click the  button, and set "D1" as the device.

3. Select [2] in [Overlap Window].

Click the  button, and set "D51" as the 
device.

4. Select [1] in [Superimpose Window].

Click the  button, and set "D26" as the 
device.

5. Select [2] in [Superimpose Window].

Click the  button, and set "D52" as the 
device.

6. Select [Dialog Window].

Click the  button, and set "D53" as the 
device.

7. Click the  button.
The settings are now completed.

Item Device

Overlap window 1 D1

Overlap window 2 D51

Superimpose window 1 D26

Superimpose window 2 D52

Dialog window D53

2.
3.

4.
5.

6.
7.
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(2) Creating a window screen

(3) Placing a text figure on the window screen

1. Select [Screen] - [New] - [Window Screen] from 
the menu.

2. The setting dialog appears. Check that [Screen 
Type] is "Window Screen".

3. Click the  button.

Window screen No. 1 appears on the screen.

1. Use a text figure to place a character string.

2. Draw a square (dotted line) that shows the 
range of the window screen.

2.

3.

1.

2.
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(4) Setting a switch that displays overlap window 1

1. Select [Object] - [Switch] - [Go To Screen 
Switch] from the menu, place a Go To Screen 
switch on the screen, and double-click the 
switch.

2. Set "Overlap Window 1" for [Screen Type].

3. Select "Fixed" for [Next Screen], and set "1" for 
[Screen No.].

4. Set the items in the [Style] tab as shown below.
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

35 SW_02_0_R"
[Shape Color] : "Red"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

38 SW_02_1_Y"
[Shape Color] : "Yellow"

(Next page)

2.
3.
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5. Click the [Text] tab.

6. Set [Text Color] to "White".

7. Set [Display Position] to "Center".

8. Enter the following character string in [Text].
"Overlap
  1"

9. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

10.Click the  button.

5.

6.
7.

8.

9.

10.
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(5) Setting a switch that displays overlap window 2

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (4).

2. Set "Overlap Window 2" for [Screen Type].

3. Select "Fixed" for [Next Screen], and set "1" for 
[Screen No.].

4. Click the [Text] tab.

5. Enter the following character string in [Text].
"Overlap
  2"

6. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

7. Click the  button.

2.
3.

4.

5.

6.

7.
3. Drawing fundamentals
3.11 Setting a window screen

3 - 99



(6) Setting a switch that displays superimpose window 1

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (4).

2. Set "Superimpose Window 1" for [Screen Type].

3. Select "Fixed" for [Next Screen], and set "1" for 
[Screen No.].

4. Set the items in the [Style] tab as shown below.
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

37 SW_02_0_Y"
[Shape Color] : "Yellow"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

40 SW_02_1_G"
[Shape Color] : "Green"

(Next page)

2.
3.
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(From previous page)

5. Click the [Text] tab.

6. Set [Text Color] to "Black".

7. Set [Display Position] to "Center".

8. Enter the following character string in [Text].
"Superimpose
  1"

9. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

10.Click the  button.

5.

6.
7.

8.

9.

10.
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(7) Setting a switch that displays superimpose window 2

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (6).

2. Set "Superimpose Window 2" for [Screen Type].

3. Select "Fixed" for [Next Screen], and set "1" for 
[Screen No.].

4. Click the [Text] tab.

5. Enter the following character string in [Text].
"Superimpose
  2"

6. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

7. Click the  button.

2.
3.

4.

5.

6.

7.
3 - 102 3. Drawing fundamentals
3.11 Setting a window screen



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS
(8) Setting a switch that displays the dialog window

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (6).

2. For the [Screen Type], select "Dialog Window".

3. Select "Fixed" for [Next Screen], and set "1" for 
[Screen No.].

4. Set the items in the [Style] tab as shown below.
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

41 SW_02_0_O"
[Shape Color] : "Orange"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

36 SW_02_1_R"
[Shape Color] : "Red"

(Next page)

2.
3.
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5. Click the [Text] tab.

6. Set [Text Color] to "Black".

7. Set [Display Position] to "Center".

8. Enter the following character string in [Text].
"Dialog"

9. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

10.Click the  button.

5.

10.

6.
7.

8.

9.
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(9) Setting a switch that closes superimpose window 1 and is placed on window screen No. 1

1. Select [Object] - [Switch] - [Word Switch] from 
the menu to place a touch switch (word switch) 
on the screen.

2. Double-click the touch switch placed on the 
screen.

3. Click the  button, and set "D26" for [Device].

4. Select [Constant], and set "0".
(Setting "0" hides the window screen.)

5. Set the items in the [Style] tab as shown below.
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

43 SW_02_0_L"
[Shape Color] : "Cyan"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

40 SW_02_1_G"
[Shape Color] : "Green"

(Next page)

3.

4.

5.
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6. Click the [Text] tab, and set the text to be 
displayed on the touch switch.

7. Set [Text Color] to "Black".

8. Set the text to be displayed on the touch switch 
as shown below.
[Display Position]: "Center"
[Text]: "Close 
            Superimpose1"

9. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

10.Click the  button.

7.

10.

9.

8.

6.
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(10) Setting a switch that closes superimpose window 2 and is placed on window screen No. 1

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (9).

2. Double-click the touch switch placed on the 
screen.

3. Click the  button, and set "D52" for [Device].

4. Click the [Text] tab, and set the text to be 
displayed on the touch switch.

5. Set the text displayed on the touch switch as 
shown below.

[Display Position]: "Center"
[Text]: "Close

Superimpose2"

6. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

7. Click the  button.

3.

4. 6.

5.

7.
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(11) Setting a switch that closes the dialog window and is placed on window screen No. 1

1. Place a new Go To Screen switch on the screen 
by copying and pasting the Go To Screen switch 
created in (9).

2. Double-click the touch switch placed on the 
screen.

3. Click the  button, and set "D53" for [Device].

4. Click the [Text] tab, and set the text to be 
displayed on the touch switch.

5. Set the text displayed on the touch switch as 
shown below.
[Display Position]: "Center"
[Text]: "Close
            Dialog"

6. Select the [OFF=ON] checkbox to display the 
same character string when the switch is on.

7. Click the  button.

3.

4. 6.

5.

7.
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(12) Setting the display position of window screen No. 1
The following describes how to set the display position of window screen No. 1 to display the screen as overlap 
window.

1. Select [Object] - [Window Position] - [Overlap1] 
from the menu.

2. Click a position, where the window screen will 
be displayed.

3. The display position of window screen No. 1 
(Overlap window 1) is set.

4. Repeat steps  through  to set the display 
positions of overlap window 2 and superimpose 
windows 1 and 2.

"+" is on the top left of the window screen.

1. 3.
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RemarkRemarkRemark
If the display positions are not set for the overlap windows or superimpose windows, the window screen is 
displayed in the center of the base screen.

The display position of the dialog window cannot be set. (It is displayed in the center of the screen.)

For the details of the settings in this section, refer to the following manuals.
 Screen switching device: GT Designer3 (GOT2000) Help or GT Designer3 (GOT2000) Screen Design Manual
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3.11 Setting a window screen



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS
3.12 Operation check 4
Display the screen for writing a project, and then write data to the GOT.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.
Check that the comments are displayed normally on screen No. 8, and window screen No. 1 is displayed normally with 
overlap windows 1 and 2, superimpose windows 1 and 2, and the dialog window.

(1) Test
Perform the following test on screen No. 8 and window screen No. 1.

(a) Displaying/closing a window screen (Screen No. 8) with the touch switches

(b) Closing the window screen (Window screen No. 1) with the touch switches

Test object
Item

Over 1
(Overlap window)

Overlap window 1
[×]

Over 2
(Overlap window)

Overlap window 2
[×]

1) Touch operation Touch the switch. ―――― ―――― ――――

Operation 
result

Screen 
display

Window screen No. 
1 appears. ―――― ―――― ――――

2) Touch operation ―――― Touch [×]. ―――― ――――

Operation 
result

Screen 
display

――――
Window screen No. 
1 closes.

―――― ――――

3) Touch operation ―――― ―――― Touch the switch. ――――

Operation 
result

Screen 
display

―――― ―――― Window screen No. 
1 appears.

――――

4) Touch operation ―――― ―――― ―――― Touch [×].

Operation 
result

Screen 
display

―――― ―――― ――――
Window screen No. 
1 closes.

Test object

Item

Super 1
(Superimpose 

window)

Super 2
(Superimpose 

window)

Close super 1
(Superimpose 

window)

Close super 2
(Superimpose 

window)

5) Touch operation Touch the switch. ―――― ――――

Operation 
result

Screen 
display

Window screen No. 
1 appears.

―――― ―――― ――――

6) Touch operation ―――― Touch the switch. ―――― ――――

Operation 
result

Screen 
display ――――

Window screen No. 
1 appears. ―――― ――――

7) Touch operation ―――― ―――― Touch the switch. ――――

Operation 
result

Screen 
display

―――― ――――
Window screen No. 
1 closes.

――――

8) Touch operation ―――― ―――― ―――― Touch the switch.

Operation 
result

Screen 
display

―――― ―――― ――――
Window screen No. 
1 closes.

Test object
Item

Dialog
(Dialog window)

Close dialog
(Dialog window)

1) Touch operation Touch the switch. ――――

Operation result Screen display Window screen No. 1 
appears.

――――

2) Touch operation ―――― Touch the switch.

Operation result Screen display ―――― Window screen No. 1 closes.
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(c) Controlling display of the window screens from the PLC

"X30 to X3F"
Digital switch Digital switch

"X20 to X2F"

PLC CPU (Q training equipment)

Set dialog 
window 
No. 

Set superimpose 2 
No.

Set superimpose 1 
No.

Set overlap 
window 2 
No.

Set overlap 
window 1 
No.

Set base 
screen 
No.

1 9 4 2 4 1 3 6 MELSEC-Q

D/A OUTPUTA/D INPUT

X3F X30                 X2F X20

Y6F Y60                Y5F Y50                Y4F Y40
Y70

Y78

X0

X8

Y71

Y79

X1

X9

Y72

Y7A

X2

XA

Y73

Y7B

X3

XB

Y74

Y7C

X4

XC

Y75

Y7D

X5

XD

Y76

Y7E

X6

XE

Y77

Y7F

X7

XF

ON

OFF

ON

OFF

0 1 0 8

 

0 0 0 1

Switching the base/window screen

 59 
SM401

Always 
OFF

X0

Set base 
screen 
No.

BINP K2X20
Base 
screen 
0 to 99

D0
Switch 
base 
screen

X1

Set overlap 
window 1
No.

BINP K2X28
Overlap 
window 1

D1
Switch 
overlap 
window 1

X6

Set overlap 
window 2 
No.

BINP K1X30
Overlap 
window 2

D51
Switch 
overlap 
window 2

X7

Set 
superimpose 
1 No.

BINP K1X34
Superimpose 
1

D26
Switch 
superimpose
1

X8

Set
superimpose 
2 No.

BINP K1X38
Superimpose
2

D52
Switch 
superimpose
2

X9

Set dialog 
window 
No.

BINP K1X3C
Dialog 
window

D53
Switch 
dialog 
window
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3.13 Offset function
The offset function enables change in device numbers to be read or written by object 
functions, without complicated operations.

• Usage example of the offset function
Change the device number set as the monitoring target of an object by adding the value of the device set with the 
offset function (Offset device).

Create a screen as shown below.

Device set for the 
numerical display

Offset
device value

Device actually 
monitored

D100 0 → D100

D100 1 → D101

D100 2 → D102

... ... ...

D100 10 → D110

Screen
No.8

Screen
No.6

Screen
No.7

Screen
No.5

Screen
No.17

Screen
No.14

Screen
No.15

Screen
No.16

Screen
No.19

Screen
No.22

Screen
No.10

Screen
No.11

Screen
No.1

Screen
No.13

Screen
No.23

Screen
No.24

Screen
No.20

Screen
No.3

Write device: D1500 (offset device)

Monitor device: D1510
Offset device: D1500

Numerical display (Production volume)

Text setting

Bar graph

Monitor device: 
Line1: D1511
Line2: D1512
Line3: D1513

It displays the total production volume 
of each line. 

Numerical input (Line)
It changes the monitoring target of the numerical 
display. 

The monitoring target changes depending on 
the numerical input (line) value.
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(1) Setting a numerical display with the offset function

1. Click  on the object toolbar, and place a 
numerical display on the screen.

2. Set the items in the [Device] tab as shown below.

[Trigger Device] : "D1510"
[Font] : "Outline Gothic"
[Number Size] : "32"
[Digits (Integral)] : "4"
[Fill with 0] : Selected

3. Set the item in the [Style] tab as shown below.

[Shape]: "Frame: Frame_1"

4. Set the item in the [Extended] tab.
Set the offset device.
Select [Use offset] and set "D1500" as the 
device.

5. Click the  button.

2.

3.

4.

5.
3 - 114 3. Drawing fundamentals
3.13 Offset function



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
 

FU
N

D
A

M
EN

TA
LS
(2) Setting a numerical input (for changing the monitoring target of the numerical display)

1. Click  on the object toolbar, and place a 
numerical input on the screen.

2. Set the items in the [Device] tab as shown below.

[Device] : "D1500"
[Font] : "Outline Gothic"
[Number Size] : "32"
[Digits (Integral)] : "4"
[Fill with 0] : Selected

3. Set the item in the [Style] tab as shown below.

[Shape]: "Frame: Frame_1"

2.

3.
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(3) Setting a bar graph

1. Click  on the object toolbar, and place a bar 
graph on the screen.

2. Set the items in the [Data] tab as shown below.

[Number of Pens]: "3"
[Direction] : "Vertical"
[Device] : "D1511"
[Graph] : "Blue"/"Yellow"/"Red" 

(In order from the top)
[Pattern] : "8"
[BG Color] : "White"/"White"/"White"
[Lower Limit] : "0"
[Upper Limit] : "1000"

3. Set the items in the [Style] tab as shown below.

[Scale] : "2" (Y)
[Scale Value] : "3" (Y)
[Lower Limit] : "0" (Y)
[Upper Limit] : "1000" (Y)
[Graph Width] : "60"
[Offset to Graph Frame] : "50"
[Width + Space] : "120"

4. Click the  button.

2.

3.

4.
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(4) Placing text figures

(5) Setting a Go To Screen switch

1. Place the following text figures on the screen.

"Line1", "Line2", "Line3"
"Line"
"Production volume"

1. Drag and paste the switch to return to the main 
menu, which is registered in 3.5.1, from the user 
library to the desired position.

Click.Click.
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3.14 Operation check 5
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 15.

Test object

Item
Line (Numerical input)

Production volume 
(Numerical display)

Touch operation 1) Touch the numerical input area. ───

Operation 
result

Screen status
A key window appears. Enter a value 

of 1, and then click  of the key 
window.

The value of the 
selected line is 
displayed.

Write device 1 → D1500 ───

Read device ─── D1511

Value displayed on screen 1 Value of line 1

Touch operation 2) Touch the numerical input area. ───

Operation 
result

Screen status
A key window appears. Enter a value 

of 2, and then click  of the key 
window.

The value of the 
selected line is 
displayed.

Write device 2 → D1500 ───

Read device ─── D1512

Value displayed on screen 2 Value of line 2

Touch operation 3) Touch the numerical input area. ───

Operation 
result

Screen status
A key window appears. Enter a value 

of 3, and then click  of the key 
window.

The value of the 
selected line is 
displayed.

Write device 3 → D1500 ───

Read device ─── D1513

Value displayed on screen 3 Value of line 3
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3.15 Parts display and movement functions
User-created figures registered as parts can be called and displayed by using 
objects.

3.15.1 Parts

(1) Parts
BMP files, JPEG files, and PNG files imported to GT Designer3 and figures can be registered as parts.

(2) Objects that can display parts
Registered parts can be displayed by using the following objects.

(a) Parts display
The registered parts are displayed based on the value of a device.

Type Description Remarks

Part

Displays the figure registered as a part. 
Example) Registrable figures as parts

• The parts are required to be registered 
in advance.

 GT Designer3 (GOT2000) Help or 
GT Designer3 (GOT2000) Screen Design 
Manual

Mark

Switches the figure colors which are registered as the parts corresponding to 
the change of device status.
Because one part can display different images, the registration of multiple 
parts is not necessary and the capacity of the GOT memory can be saved.

• The parts in BMP format, JPEG format, 
or PNG format cannot be used.

• Draw the area of the figure, whose color 
is to be changed, in white.

• While fixed parts are being displayed, 
switching to multiple colors cannot be 
executed.

   The display is only in a single color.

Screen
No.8

Screen
No.6

Screen
No.7

Screen
No.5

Screen
No.17

Screen
No.14

Screen
No.15

Screen
No.16

Screen
No.19

Screen
No.22

Screen
No.10

Screen
No.11

Screen
No.1

Screen
No.13

Screen
No.23

Screen
No.24

Screen
No.20

Screen
No.3

Shape Text · BMP file 
· JPEG file 
· PNG file

White Blue Red

D100 = 0 D100 = 50 D100 = 100
The display color of the white space can be changed.

Registered parts

Parts
No. 1

Parts
No. 2

Parts
No. 3

D10 D101

Parts No. 1 is displayed. Parts No. 3 is displayed.

3
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(b) Parts movement
Registered parts are displayed in different positions based on the value of a device.

Create base screen No. 16 as shown below to set the parts movement function.

Registered parts

Parts
No. 1

Parts No. 2 is displayed.

D10 D102 3

Parts
No. 2

Parts
No. 3

Parts No. 3 is displayed 
at the specified position.

Parts switching device: M1200
Position device: D1200

Parts movement

It starts the parts movement.
Write device: M1210: ON

Touch switch (Start)

It stops the parts movement.
Write device: M1210: OFF

Touch switch (Stop)

Monitor device: D1210

Numerical display 
(Number of moved wagons)

Parts switching device: M1210 
OFF: Stop 
ON: Operating

Parts display

It counts how many times the wagon 
moved to the right.
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3.15.2 Registering a part

Register a part to be displayed by using the parts movement.

(1) Reading a BMP file
The following shows how to import a BMP file to GT Designer3 and register the file as a part.

1. Select [Figure] - [Import Image Data] from the 
menu.

2. When the [Open a File] dialog appears, select 
"Wagon.bmp", and click the  button.

3. Click a position on the screen. The illustration of 
the wagon appears.
3. Drawing fundamentals
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(2) Registering the figure as a part

1. Select the target figure.

2. Drag the figure below [Parts] in the project 
workspace.

3. The [Parts Property] dialog appears.

Enter "1" for [No.] and "Wagon" for [Name], and 
then click the  button.

4. Registration is completed.

5. Delete the figure selected and dragged in (1) and 
(2).

6. Use the procedure in (1) and (2) above to 
register the following figures as parts as well.
"Running.bmp" [No.]: 2, [Name]: "Running"
"Stopped.bmp" [No.]: 3, [Name]: "Stopped"

Drag

Registered parts
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3.15.3 Setting a parts display

(1) Setting a parts display

1. Select [Object] - [Parts Display] - [Bit Parts] from 
the menu.

2. Click the position to place a part.
Double-click the placed part.

3. Set the items in the [Device/Style] tab as shown 
below.
[Parts Switching Device] : "M1210"
<Settings for on>
[Parts No.] : "2", "Running"
<Settings for off>
[Parts No.] : "3", "Stopped"

4. Click the  button.

3.

4.
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3.15.4 Setting a parts movement

(1) Setting a parts movement

1. Select [Object] - [Parts Movement] - [Bit Parts] 
from the menu.
The [Bit Parts Movement] dialog appears.

2. Set the part to be displayed.
[Parts Switching Device]:
A device that determines which part to display.
Changing the value of this device switches the 
part to be displayed.
Make the settings as shown below.

[Parts Switching Device]: "M1200"

3. Set the movement method of the part.
• [Device]:

A device that controls the display position for 
the part.
Changing the value of this device
displays the part in different positions.

• [Move Way]:
Select a way to move the parts from the 
options "Position", "Line", and "Point".

Make the settings as shown below.
[Device]: "D1200"
[Move Way]: "Line", [Maximum]: "5"

4. ON/OFF attribute:
Select a part to display when the part switching 
device is on or off.

ON/OFF attribute:
On : Select "1" for [Parts No.].
Off : Select "1" for [Parts No.].

(Note: The part is not displayed if 0 is 
selected.)

5. Click the  button.

6. Set the line that indicates the movement range of 
the part.
(Only when [Line] is selected for [Move Way])

7. Click the start point on the drawing screen.

8. Move the cursor and click the end point.

2.
3.

5.

4.

7. 8.
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POINTPOINTPOINT

Moving parts
The following three types of ways are available to move parts.
(1) [Position]

Parts are displayed with the coordinates on one-dot basis.
By changing the value of the position device, the display position can be changed on one-dot basis.

(2) [Line]
Parts are moved across the set start point and end point.
Set the minimum value to the start point and the maximum value to the end point. The part display position 
changes according to the position device value and is relative to the start and end points on the line across the 
two points.

(3) [Point]
Parts are displayed at the specified display position (Point).
To set points, register a polygonal line having several points (Parts movement route).
The part is displayed at the position with the same point No. as the position device value.

* If [Point] is specified for [Move Way], the parts movement route, in which the parts are displayed, must be set.
(Select [Object] - [Parts Movement] - [Parts Move Route] from the menu.)

1) (30, 90)

2) (200, 16)

3) (130, 170)

Position device (X-axis coordinate): D100

Position device (Y-axis coordinate): D101

1) 2) 3)
30

90

200

16

130

170

→

→

→

→

Setting image Movement image

End point (Max.: 100)

Start point (Min.: 0)

Position device: D100

80%

20%D100: 100

D100: 20

D100: 0

1

2

3 4

5

6

Setting image Movement image

Parts movement route
Point

Position device: D100 5 1 2→ →
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(2) Setting touch switches ([Start]/[Stop] switches)

1. Select [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the position to place a bit switch.

3. Set the items in the [Device] tab as shown below.

[Device] : "M1210" 
[Action] : "Set" 

4. Click the [Style] tab.

5. Set the items in the [Style] tab as shown below.

<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

33 SW_02_0_B"
[Shape Color] : "Blue"
<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

44 SW_02_1_L"
[Shape Color] : "Cyan"

6. Click the [Text] tab.

7. Set the item in the [Text] tab as shown below.
[Text]: "Start" (for both on and off)

Click the  button.

8. Create another switch by copying and pasting 
the switch just created, and set the new switch 
as shown below.

[Device] tab
[Action] : "Reset"

[Style] tab
[Shape Color] (for off) : "Red"
[Shape Color] (for on) : "Purple"

[Text] tab
[Text] : "Stop"

4.

5.

6.

7.

Drag
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(3) Setting a counter (Numerical display)

(4) Setting a text figure and an illustration

1. Click  on the object toolbar, and place a 
numerical display on the screen.

2. Set the items in the [Device] tab as shown below.

[Device] : "D1210"
[Font] : "Outline Gothic"
[Number Size] : "36"
[Digits (Integral)] : "6"
[Fill with 0] : Selected

3. Click the [Style] tab.

4. Set the item in the [Style] tab as shown below.
[Shape] : "Frame_Fixed Width: Frame_1"

Click the  button.

1. Place the following text figure on the screen.
"Number of wagons"

2. Use the same procedure as (1) Reading a BMP 
file in 3.15.2 to read "Conveyor.bmp" to GT 
Designer3 to place the conveyor.

2.

3.

4.
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3.16 Operation check 6
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 16.

Test object

Item
[Start] switch [Stop] switch Parts display

Wagon
(Parts 

movement)

Number of 
wagons

(Numerical 
display)

First touch operation
Touch the 
switch.

──── ──── ──── ────

Operation 
result

Screen status
The switch is 
pressed. ──── Operating

The wagon 
moves from left 
to right.

────

Write device M1210: ON ──── ──── ──── ────

Read device ──── ──── ────
D1200
M1210: ON ────

Screen display ──── ──── Operating

After the wagon 
reaches the 
right edge, the 
next wagon 
appears.

The counter 
counts up.

Second touch operation ────
Touch the 
switch. ──── ──── ────

Operation 
result

Screen status ────
The switch is 
pressed. Stopped

The wagon 
stops. ────

Write device ──── M1210: OFF ──── ──── ────

Read device ──── ──── ──── M1210: OFF ────
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3.17 Recipe setting

3.17.1 Recipe

This function reads and writes the values of the specified devices by turning on or off 
the devices.

 Recipe file
The device values read from controller devices are saved in a recipe file.
The device values saved in the recipe file can be edited on a personal computer.
In addition, the recipe file data can be written to devices.

 Reading or writing device values using recipe files
(1) Writing device values without using recipe files

The values set with GT Designer3 in advance are saved into the built-in memory (user area) of the GOT.
The set values are written into controller devices by turning on and off the write trigger device.
Recipe files are not required for the following cases.

• When only writing values to controller devices is executed
• When displaying and editing values to be written on a personal computer are not required

1. Configure the recipe setting with GT Designer3.
Configure the setting not to use recipe files.

2. Write the set data into the GOT.

3. Write the values set with GT Designer3 into the controller devices with a write trigger.

POINTPOINTPOINT

How to read values from controller devices
Use a recipe file.
When no recipe file is used, the values can be written only by turning on or off the devices.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Setting on GT Designer3

Write trigger: OFF → ON
(Write the set values to devices.)

D10
D11

Device Device value

D12

150
250
350 D10  150

D11  250
D12  350

Write the set data into 
the GOT.
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(2) Reading or writing device values using recipe files
Reading and writing device values using recipe files can be used for the process management and production 
management on a personal computer.
The following shows how to read or write device values using recipe files.

(a) Reading or writing values by turning on or off devices

1. Configure the recipe setting with GT Designer3.
Configure the setting to use recipe files.

2. Write the set data into the GOT.

3. Read device values of the controller with a read trigger.

4. The read values are saved in a recipe file.

5. Store the recipe file in the personal computer.

6. Display and edit the file stored at above Step 5 on the personal computer.

7. Store the edited recipe file in the GOT.

8. Write the values to the controller devices with a write trigger.

D10 50
D11 100
D12 150

D10 500
D11 600
D12 700

Store the edited recipe file 
to the GOT.

Write trigger: OFF → ON
(Write the set values to devices.)

D10
D11

Device Device value

D12

500
600
700

Store the recipe file in the personal computer.
Recipe 

file

D10 50  → 500
D11 100  → 600

Device Device value

D12 150  → 700

Display and edit the recipe file on a personal computer.

(Read device values.)Recipe 
file

D10
D11

Device Device value

D12

150 →  50
250 → 100
350 → 150

Read trigger: OFF → ON

D10
D11 250

Device Device value

D12 350

Setting on GT Designer3

Write the set data into the GOT.

150

The device values are saved in a recipe file.
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Converting the created recipe file into a Unicode text file or a CSV file
Recipe files created by the recipe function are in the binary file format (*.G2P).
To display and edit a recipe file on a personal computer, convert the file into a Unicode text file or a CSV file.
The following shows how to convert a recipe file into a Unicode text file or a CSV file.

• Converting a file with GT Designer3
• Converting a file with the utility
• Converting a file with devices

(1) Creating a Unicode text file or a CSV file with GT Designer3
Convert the binary file stored in the data storage into a Unicode text file or a CSV file with GT Designer3.
Since the file is converted with GT Designer3, no processing load is put on the GOT.

Display or edit the converted Unicode text file or the CSV file on a personal computer.

Recipe file Data storage Recipe fileData storage
3. Drawing fundamentals
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(2) Creating a Unicode text file or a CSV file with the utility
Convert the binary file stored in the data storage into a Unicode text file or a CSV file with the utility.
A Unicode text file or a CSV file can be created without using GT Designer3.

1. Select a G2P file in [Recipe information] of the utility and touch the [G2P → CSV] button or the 
[G2P → TXT] button to convert the file.

2. Store the created Unicode text file or CSV file into a personal computer by one of the following methods.
• Transfer with GT Designer3.

Select [Communication] → [Read from GOT] from the menu to transfer a file to the personal computer.
• Save a stored recipe file using the data storage or USB memory to the data storage, and read the data 

in the data storage using the personal computer.

3. Display or edit the converted Unicode text file or the CSV file on a personal computer.

Touch the [G2P → CSV] button or the [G2P → TXT] button.

Recipe file Data storage Recipe fileData storage
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(3) Creating a Unicode text file or a CSV file with an external control device
Turning on a specified external control device converts a binary file stored in the data storage into a Unicode 
text file or a CSV file.
The following settings are required to convert a binary file into a Unicode text file or a CSV file.
• External control information (recipe common setting)
• File conversion external control (recipe (file save tab))

Turning on the external control device b8 (Convert Recipe File signal) converts a binary file into a Unicode text 
file or a CSV file.
Example) Setting and operation for converting a binary file (*.G2P) into a Unicode text file (*.txt)
• External control device: D100
• Recipe No. storage device: D101
• External notification device: D200

To convert a file using an external control device, you need to write a recipe No. of the recipe file to be 
converted into the recipe No. storage device before converting the recipe file.
Even though the external control device b8 (Convert Recipe File signal) is turned on before the recipe No. is 
written, the recipe file is not converted into a Unicode text file or a CSV file.

Turning on the external control device b9 (Reverse-convert Recipe File signal) converts a Unicode text file or 
a CSV file into a binary file.

Binary 
file

G2P TXT

File conversion

ON

ON

Turn on D100.b8.

Unicode 
text file

The recipe file of the recipe No. 50 is 
converted into a Unicode text file.

Convert Recipe File signal 
(D100.b8)

Recipe File Converting 
Notification signal (D200.b8)

This signal turns off 
when D100.b8 is off 
and when the 
conversion processing 
is completed.

Store 50 to D101.
3. Drawing fundamentals
3.17 Recipe setting

3 - 133



HINTHINTHINT

Precautions for executing the recipe function
(1) When the number of devices which are read or written is large

Note that monitoring of other object functions, key inputs and other processes will not be executed until the 
recipe function is completed.
<How to check whether the recipe function is running>
To check whether the recipe function is running, set a lamp or another object which monitors the Recipe 
Processing signal of the System signal 2-1 on the GOT.
The System signal 2-1 is a signal used for sending notifications from the GOT to the controller or users.
When the recipe function is running, b10 of the System signal 2-1 turns on.

System signal 2-1

(2) CSV files stored in the data storage
CSV files are created in the data storage for each recipe setting.

(3) Specifying a common trigger device to read or write device values
Setting an external control device enables controlling all recipe settings.
Use an external control device when you read or write device values with a common trigger device.

Recipe name File name (can be changed to any name)
Recipe function 1 RECIP001.CSV
Recipe function 2 RECIP002.CSV
Recipe function 3 RECIP003.CSV

b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

Recipe Processing signal

Recipe Processing 
signal

Recipe Processing 
signal

The lamp turns on while the recipe 
function is being executed.

The lamp turns off when the recipe 
function execution is completed.

Recipe No. 3
Recipe No. 2Recipe No. 1

Specify recipe Nos., record Nos., and trigger conditions to execute 
reading or writing device values with a common trigger device.
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Device details

*1 When [External Control Device] is set, [Recipe No. Storage Device] and [Record No. Storage Device] are set with sequence 
device numbers.

Device Bit number Signal name Description

External control device*1

Controls the reading or writing of device values of the recipe specified by [Recipe No. Storage Device] 
and [Record No. Storage Device].

b0 Record Write Trigger signal
ON: Values are written to controller devices.
OFF: -

b1 Record Read Trigger signal
ON: Values are read from controller devices.
OFF: -

b2 to b7 Use prohibited -

b8 Convert Recipe File signal
ON: The conversion of recipe files is executed.
OFF: -

b9
Reverse-convert Recipe File 
signal

ON: The reverse conversion of recipe files is 
executed.
OFF: -

b10 to b14 Use prohibited -

b15
Clear Recipe Processing Error 
signal

ON: A recipe processing error is cleared.
OFF: -

Recipe No. storage device*1 -
Stores the recipe No. for reading or writing device 
values with [External Control Device].
(1 to 32767)

Record No. storage device*1 -
Stores the record No. for reading or writing device 
values with [External Control Device].
(1 to 2000)
3. Drawing fundamentals
3.17 Recipe setting

3 - 135



3.17.2 Hardware required for the recipe function

(1) Hardware required for the recipe function
To use the recipe function, the following hardware must be installed to the GOT.

Required hardware Application

Data storage
(needed only to read device values)

Saves device values as a G2P (binary) file, Unicode text 
file or CSV file.
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3.17.3 Recipe function

Setting the recipe function with the recipe number, block, and record enables you to manage multiple pieces of recipe 
information with one recipe setting.

(1) Recipe number
Recipe numbers are used for identifying the target recipe settings for reading or writing device values.
Set the recipe number within the range of 1 to 32767.
However, the maximum number of recipe settings to be created is 2500.

(2) Block
Blocks are units for setting device numbers randomly and different device types.
Up to 2048 blocks can be set for one recipe setting.

(3) Record
Records are units for identifying a group of device values to be read or written to.
By setting device values to be written to a controller by record units, multiple values can be set for the same 
device.
Up to 2000 records can be set for one recipe setting.

32767

Recipe No. 100Recipe No. 10Recipe No. 1

Maximum 
2500 recipes

Block 1

Block 2
Block 3
Block 4

Number of devices for each recipe setting (total number of devices of all blocks)
256 records or less: Maximum 65536 devices

Number of devices for each block

Maximum 2000 records

Number of blocks for each recipe setting: Maximum 2048 blocks

257 records or more: Maximum 8192 devices

256 records or less: Maximum 32768 devices
256 records or more: Maximum 8192 devices
When the device type is [Text], 2048 devices can be set regardless of the number of records.

D10 100
D11 200

300D12

(Write)

D100.b0 Record Write Trigger signal
(External control device.b0) : OFF → ON
D101 "Recipe No. Storage device" : 2
D102 "Record No. Storage device" : 1

Control reading or writing device 
values with a common trigger device!

D10
D11

Device Record 1

D12

550
650
750

500
600
700

Record 2
D10 100

200
150

D11 250
D12 300 350

<Recipe No. 2><Recipe No. 1>

"External control device" : D100
"Recipe No. Storage device" : D101
"Record No. Storage device" : D102

Device Record 1 Record 2
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3.17.4 Screen example for the recipe setting

Create base screen No. 17 as shown below, and check the recipe operation.

3.17.5 Numerical input setting for recipe operation tests

Write device: D20 to D24 (16 bits) for 5 words

(1) Click  on the object toolbar.

(2) Click on the screen to place an object.
(3) Set the items as follows.

(4) Click the  button.

(5) To set D21 to D24, copy the object by following POINT below.
The settings of the numerical input are complete.

1. [Type]: "Numerical Input"

2. [Device]: "D20"

3. [Number Size]: "36"

4. [Fill with 0]: Selected

[External control] 
Record write trigger switch 
Recipe No. Storage device
Record No. Storage device

: D27.b0
: D28
: D29

[Control for recipe No. 1]
Record No. Storage device
Write trigger switch 
Read trigger switch

[Numerical inputs for recipe operation tests] 
Write device: D20 to D24 (16 bits) 
5 words

: D25
: M23
: M24

1.

3.
4.

2.
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To copy an object multiple times, you can just change the device number and copy it.

(1) Select the original copy of the object.

(2) Select [Edit] - [Consecutive Copy] from the menu.
The [Consecutive Copy] dialog appears. Set the items as follows.
3. Drawing fundamentals
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3.17.6 Recipe setting

1. Select [Common] - [Recipe] - [Recipe Common 
Setting].

2. Set the external control information in the recipe 
common setting.

[External Control Device]: "D27"
[Recipe No. Storage Device]: "D28"
[Record No. Storage Device]: "D29"

Click the  button.

3. Select [Common] - [Recipe] - [Recipe].

4. Click the  button.

(Next page)

1.

2.

3.

4.
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(From previous page)

5. Set the [Basic] tab.

[Recipe No.]: "1"
[Recipe Name]: "Recipe 1"
[Recipe File]:"Use a recipe file (read and write)"
[File Format]: "CSV"

[Write Trigger 1]: "M23 ON"
[Read Trigger 1]: "M24 ON"
[Record No. Device]: "D25"

6. Set the [Device] tab.

[Block Number]: "1"
[Record Number]: "2"
[Device Type]: "Signed BIN16"

[Device]: "D20"
[Points]: "5"
[Display Type]: "Signed Dec"

No. Record 1 Record 2

D20 30 1

D21 31 2

D22 32 3

D23 33 4

D24 34 5

Click the  button.

7. Click the  button.

5.

6.

7.
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3.17.7 Setting a switch for the record write trigger

When D27 turns on, the recipe of the recipe and record numbers stored in D28 and D29 is written.

(1) Select [Object] - [Switch] - [Bit Switch] from the menu and click on the screen to place a touch 
switch.

(2) Set the touch switch as follows.

Set the [Device] tab as follows.

1. Set the switch action.
[Device]: "D27.b0"
[Action]: "Alternate"

2. Set how to switch the ON/OFF display of the 
touch switch.

When the bit device D27 is on, the touch switch 
of the ON shape is displayed.
Select "Bit", and set [Device] to "D27.b0".

3. Set the [Style] tab as follows.

Set the display format.
<Settings for off>
[Shape] : "FA Control Switch Figure A1: 

103 SW_04_0_G"
[Shape Color] : "Green"

<Settings for on>
[Shape] : "FA Control Switch Figure A1: 

99 SW_04_0_R"
[Shape Color] : "Red"

Set the [Text] tab as follows.

4. Set the text to be displayed on the touch switch.

Enter "Record
write trigger".

[Text Color]: "Black"

Check that [OFF=ON] is selected.

5. Click the  button.

The settings of the record write trigger switch are 
complete.

1.

2.

3.

4.

5.
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3.17.8 Setting a write trigger switch

When M23 turns on, the recipe of the record number stored in D25 is written.

(1) Create a new switch by copying and pasting the switch created in 3.17.7.

(2) Change the settings of the copied switch as follows.

(3) Click the  button to complete the settings.
The settings of the write trigger switch are complete.

Setting item Setting

[Device] tab
[Switch Action] [Device]: "M23"

[Lamp] [Device]: "M23"

[Text] tab [Text] "Write trigger"
3. Drawing fundamentals
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3.17.9 Setting a read trigger switch

When M24 turns on, the recipe of the record number stored in D25 is read.

(1) Create a new switch by copying and pasting the switch created in 3.17.7.

(2) Change the settings of the copied switch as follows.

(3) Click the  button to complete the settings.
The settings of the read trigger switch are complete.

Setting item Setting

[Device] tab
[Switch Action] [Device]: "M24"

[Lamp] [Device]: "M24"

[Text] tab [Text] "Read trigger"
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3.18 Operation check 7
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.
Check that the recipe function operates properly on screen No. 17.

Perform a recipe function test on screen No. 17.

Test object

Setting item
Numerical input Display SD card

1) Set the numerical inputs, and then touch 
"Record write trigger".

Recipe No. storage device: 1 
(D28)
Record No. storage device: 1 
(D29)

D20: 30, D21: 31
D22: 32, D23: 33
D24: 34

───

2) Set the numerical inputs, and then touch 
"Record write trigger".

Recipe No. storage device: 1 
(D28)
Record No. storage device: 2 
(D29)

D20: 1, D21: 2
D22: 3, D23: 4
D24: 5

───

3) Set the numerical inputs, and then touch 
"Write trigger".

Record No. device: 1
(D25)

D20: 30, D21: 31
D22: 32, D23: 33
D24: 34

───

4) Touch "Read trigger". ─── ───
Check that a CSV file is 
created.
3. Drawing fundamentals
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3.19 Document display function
The document display object displays a document created with a specific application such as Microsoft Word or 
Microsoft Excel.
As the GOT can display documents such as specification sheets or manuals, you can check a troubleshooting procedure 
or operating procedure during monitoring accordingly.

(1) Available document types
The document display function can display the documents created with the following applications.
• Microsoft® Word • Microsoft® Excel • Microsoft® PowerPoint
• PDF data • Image file (JPEG or BMP)

(2) Hardware required for the document display function
To use the document display function, the following hardware must be installed to the GOT.

(3) Extended system application required for the document display function
As shown below, "Document Display" of the extended system application is required.
The required extended system application is automatically selected when the package data is written.

Required hardware Application

Data storage Stores document data converted into an image.
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3.19.1 Procedure for displaying documents

Use Document Converter to convert Microsoft Word, Excel, PowerPoint and PDF 
data or an image file into a JPEG file for the document display, and then use the 
document display function to display the data on the touch panel.

POINTPOINTPOINT

Before using Document Converter, install the following software in the personal computer.
• Document Converter (installed from the CD-ROM of GT Works3)
• Ghostscript GPL8.50 or later*1*3 (The function is not supported by Ghostscript GPL9.00 or later.) (Free 

software)
• PostScript printer driver supplied with Windows®*2

• Microsoft® Office® 2000, Microsoft® Office® XP, Microsoft® Office® 2003*1

*1 The version of the software whose operations have been validated by Mitsubishi Electric Corporation is 8.50.
*2 Only the application for creating the document to be used is required.
*3 After the installation is completed, an addition to environment variables is required.

For the details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Image data 
(JPEG, BMP)

PDF

Document file JPEG file for the document display

Document ID: 3

Document ID: 1

Document ID: 2

Document Converter

GT Designer3

Object setting

GOT2000 (document display)

Convert the document file into the JPEG file 
for the document display!

SD card

Document 
(Word, Excel, 
PowerPoint)
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3.19.2 How to convert a document with Document Converter

The following table lists the details of each setting item.

1. Click [Start] → [All Programs] → [MELSOFT 
Application] → [GT Works3] → [Document 
Converter] from the menu to start Document 
Converter.

2. Make the settings as shown below.
[Document ID]: 1
[Document Name]: Document_test
[File Path]: **:\ Document.doc
[Output Path]: **:\

3. Click the  button.

4. After completion of conversion, click the  
button.

5. Save the document to the SD card. Insert the SD 
card to the GOT and close the cover of the SD 
card interface.

Item Description

[Document ID] Sets the ID (1 to 255) of a converted document.

[Document Name]
Sets the name of the converted document to a name that suits the purpose of uses.
Up to 32 characters can be entered.

[File Path] Specifies the path name of the file to be converted by clicking the [Browse] button.

[Output Path]

Specifies the path name of the personal computer where a converted file is output by clicking the 
[Browse] button.
The converted file is output to the following folder structure.
\DOCIMG\ (Document ID)\ (Output size: L/M/S)\IMG*****.jpg

As the output size, L means large, M means medium, and S means small.
A page number is sequentially assigned to *****.

Example) Document ID: 1 and output size L (large)
Output path: \DOCIMG\001\L\IMG00001.jpg

[Output Page]
Specifies the pages to be converted.
(Only if the file to be converted is Word, Excel, PowerPoint or PDF file)

[Output Page Head 
Number]

Specifies the first page number (1 to 65535) of a converted file.
(Specify 20 when the first page number is page 20.)

Starts to convert a document.

Exits Document Converter.

Adjusts the image quality of a converted document.
It can be adjusted after document conversion.

2.

3.

4.
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(1) User Account Control of Windows® 8, Windows® 7, and Windows Vista®

When Ghostscript runs with administrator privileges, use Document Converter with administrator privileges as 
well.
For information on how to run the software with administrator privileges, refer to the following.

 Manual and Help for Windows® 8, Windows® 7 and Windows Vista®

(2) JPEG file after conversion
(a) Size of the JPEG file

The converted JPEG file (large, medium, and small) size will be the following for an A4-sized document.
Large: 816 × 1168  Medium: 656 × 928  Small: 400 × 584

(b) Folder configuration of the storage location of the JPEG file (DOCIMG) after conversion
Do not change the folder configuration of DOCIMG.
If the folder configuration of DOCIMG is changed, the GOT cannot recognize the files.

(c) Storing files to a data storage
When saving converted files in the data storage, save the DOCIMG folder containing the child folders in 
the root directory.
If the DOCIMG folder is saved in a folder other than the root directory, the GOT cannot recognize the 
files.

Set screen No. 23 as shown below.

Document display screen

Document display key 
[←], [→], [↑], and [↓] scroll the screen. 
[Page<] and [Page>] move pages. 
[Zoom in] enlarges the screen. 
[Zoom out] shrinks the screen.
3. Drawing fundamentals
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3.19.3 Placing and setting a document

Set the document display function to screen No. 23.

1. Select [Object] - [Document Display], and click on 
the screen.

The document display screen appears. Double-
click it.

2. The setting dialog appears. Make the settings as 
shown below.

[Document Type] : "Document Converter 
Output File"

[Initial Display Size] : "Large"
[Document ID] : "1"
[Page No.] ("Fixed") : "1"

3. Click the  button.

3.

2.
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3.19.4 Touch switch for the document display

Set the document display key on screen No. 23.

1. Click the docked [Library] tab.

Select [Library] - [FA Metal_N Document Display 
Key], and then click [1 DOC01_B]. Move the 
cursor to the position where the key is to be 
placed.

2. Click on the screen to place the key.

The document display key is placed.

1.

Drag
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3.19.5 Operating objects by the gesture (object gesture function)

Use gestures, such as a flick, to scroll, zoom in or out displayed contents.

(1) Scroll
Flick the document display to scroll the document.
The document display can be scrolled in eight directions as follows.

Example) Scroll the display leftward.

(2) Next page and previous page
Flick the display with the edge of the document displayed to change the page.
(a) When displaying the upper end of the document

Flick the page downward to change to the previous page. (Previous page)
(b) When displaying the bottom end of the document

Flick the page upward to change to the next page. (Next page)
(c) When displaying the left end of the document

Flick the page rightward to change to the previous page. (Previous page)
(d) When displaying the right end of the document

Flick the page leftward to change to the next page. (Next page)
Example) Next page

Document display

Document display
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(3) Zooming in and out the document
Pinch in or out the document display to zoom out or in the document display each at the three sizes in 
sequence.
One pinch in zooms out the displayed document by one size smaller than the current display size.
One pinch out zooms in the displayed document by one size larger than the current display size.
Example) Zoom in the document.

RemarkRemarkRemark
To use the object gesture function, select [Use the gesture function] in the type setting of GT Designer3.

For the details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

Document display
3. Drawing fundamentals
3.19 Document display function
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3.20 Comment display

3.20.1 Comment display

A comment is text registered by a user in GT Designer3.
Register a comment to a comment group in advance to display in multiple object 
functions.

(1) Displaying comments in the comment group using the comment display function
This function displays comments registered to the comment group.
It displays the comment of the comment No. that corresponds to a device value to be monitored.
You can switch the column of the display comment by using the language switching device.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

D100 = 2
D200 = 2

Column No. 1 Column No. 2

D100 = 1
D200 = 1

D100 = 2
D200 = 1

Convey stopped

No. 1 Operating
Convey stopped
Inspecting
Emergency stopped
CompleteNo. 5

No. 2
No. 3
No. 4

Comment group No. 1

Specify the column No. with 
the language switching device.

The comment No. 1 
in the column No. 1 
is displayed.

The comment No. 2 
in the column No. 2 
is displayed.

The comment No. 2 
in the column No. 1 
is displayed.
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RemarkRemarkRemark

(1) Register the comments that are displayed in the comment display in advance.
(2) The following three types of comment display are available.

• Comment display (bit)
This function displays the comment corresponding to the on/off status of a bit device.
It switches between two types of comments depending on the status.

• Comment display (word)
This function displays the comment corresponding to the value of a word device.

• Comment display (simple)
This function displays comments without setting a device.

Operating

Production line status

Conveyor stopped

Production line status

Comment of when 
the bit device is off

Comment of when 
the bit device is on

X10 = ONX10 = OFF

D100

The comment No. 1 
is displayed.

Production line status

D100

The comment No. 10 
is displayed.

Production line status

D100

The comment No. 100 
is displayed.

Production line status

Conveyor stopped CompleteOperating

1 10 100

The comment No. 1 
is always displayed.

Production line status

Operating

Comment No. 1
3. Drawing fundamentals
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3.20.2 Registering a comment

 Maximum number of comment registrations
Up to 500 comment groups can be registered, and up to 32767 rows × 30 columns of comments can be registered to 
one comment group.

 Maximum number of characters that can be registered to one comment
A comment can be created with 1 to 1024 characters.
A line feed is counted as two characters.

 Creating a multi-line comment
(a) To insert a line feed, press the [Alt] + [Enter] keys at the end of the first line.

(b) The GOT displays a multi-line comment as follows.

 Text size for the comment display
Set the text size of the display comment in the dialog for each object setting.

Line1 is running. Press the  Alt  +  Enter  keys.

Line is running.

Line is running.

Y70 is on.

Display range

Y70 is on.
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 Comment display attribute
Some object functions which display comments may have a display attribute which cannot be displayed.
For restrictions on a comment of each object, refer to sections which explain each object in GT Designer3 
(GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

The display attributes are settable for each comment.
The display attributes used to display comments differ for each object.
○: Use the display attribute of comments  ×: Do not use the display attribute of comments

*1 You can select whether to use the object settings or the comment setting for displaying the comment.
*2 The comment is displayed according to the object settings.
*3 The display attribute of the comments is used only when [Comment Color (System Alarm Fixed Color)] is set as the switching 

method in [Alarm Text Color Switching].

Object Text color Invert Blink
HQ 

character
Text style

Shadow 
color

Touch switch ○*1 × × ○ ○*1 ○*1

Lamp ○*1 × × ○*1 ○*1 ○*1

Comment display ○ ○*1 ○*1 ○*1 ○*1 ○*1

Historical data list display ×*2 × × ×*2 ×*2 ×*2

Alarm display (user), simple alarm display ×*2 × × ×*2 ×*2 ×*2

User alarm popup display ○*3 × × ×*2 ×*2 ×*2
3. Drawing fundamentals
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3.20.3 Setting a comment display using a bit device

Create base screen No. 19 as shown below.

When (XF) = ON, "Error" is displayed and when (XF) = OFF, "Normal" is displayed.

(1) Clicking  of  on the object toolbar and selecting , and placing a bit comment

(2) Setting a comment display

1. Double-click the comment display (bit) to 
display the setting dialog.

2. Click the  button, and set [Device] to "XF".

(Next page)

2.
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(From previous page)

3. Click the [Comment] tab to set a displayed 
comment.

4. Deselect "OFF=ON".

5. Set text to be displayed for the off status.
[Display Type]: Select "Text".

6. Enter a comment to be displayed for the off 
status.
Enter "Normal".

7. Set [Text Color] to "Green".

8. Set "Font" in [Text Settings].
[Font]: "Outline Gothic"
[Text Size]: "36"

9. Click the [ON] button to set the text to be 
displayed for the on status.

10.Select "Text".

11.Set a comment to be displayed for the on 
status.
Enter "Error".

12.Set [Text Color] to "Red".

13.To use the blink display, select a blink type.

14. Click the  button.

4.
5.
6.

7.
8.

3.

10.

9.

11.
12.
13.

14.
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(3) Setting the object on the screen
Adjust the size of the object frame so that the object displays the whole comment.

POINTPOINTPOINT

• Clicking the ON or OFF button on the display setting toolbar switches between the on and off status, and 
displays each status comment.

• If the comment length of the on or off status varies as shown below, adjust the size of the display range.
(Example) ON: "Warning: Water level reaches the upper limit", OFF: "Normal"

Switch the comment display using the on or off button on the display setting toolbar, and adjust the 
size of the display range for the comment which has the longer text than another one.

1. Move the cursor on the handle of the frame to 
change it to the resizing one. Drag the handle to 
the point where the whole comment can be 
displayed.

2. Release the left mouse button when the desired 
display range is determined.
The settings of the comment display (bit) are 
complete.

ON OFF
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• When [Adjust Text Size] is selected in the object setting dialog, the text is resized automatically according to the 
object size.
The minimum text size to be adjusted is settable with [Minimum Size].
The following shows the objects for which [Adjust Text Size] and [Minimum Size] are settable.
• Touch switch
• Bit lamp
• Word lamp
• Comment display
• Alarm display

If a part of the text extends off the display frame, the text appears differently according to the setting of [Adjust 
Text Size] as shown below.

If the HQ font is used, the appearance of the font may change after the change of the size.
If the appearance has been changed, adjust the size of the object so that the appearance returns to that of the 
HQ font.

Object and text to be displayed
[Adjust Text Size]

Selected Not selected

ABCDEFGH

Display 
frame

Character 
string to be 
displayed

The text size is automatically adjusted 
so that the character string fits in the 
display frame.

ABCDEFGH

The portion of the character string that 
has been extending off the frame starts a 
new line to fit in the display frame.

ABCDE
FGH

ABCDEFGHIJK

Display 
frame

Character 
string to be 
displayed

The character string is aligned to the 
left in the display frame and the portion 
is not displayed.

ABCDEFGHI

If the portion of the character string still 
extends off the frame even in the text 
size set for [Minimum Size]

ABCDE
FGHIJ

If the portion of the character string 
still extends off the frame even when 
it starts a new line, the portion is not 
displayed.
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3.20.4 Setting a comment display using a word device

Display "Error 1" to "Error 4" depending on the numerical values 1 to 4 of the word device (D17).

(1) Registering a displayed comment
To display a comment depending on a numerical value of the word device, register displayed comments in 
advance.

1. Select [Common] - [Comment] - [Open] from the 
menu.

2. The [Open Comment Group] dialog appears. 
Double-click [New].

3. The [Comment Group Property] dialog appears. 
Enter "Error" as the title of a comment group, 
and click the  button.

4. The comment list dialog appears.

5. Click the comment field of the comment to be 
registered.

(Next page)

2.

3.

5.
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(From previous page)

6. Enter a comment to be displayed.
Enter "Error 1".

7. Set [Text] to "Red".

8. Click the  button to create comment No. 2.

9. Create comment No. 2 to 4 as shown below by 
following the steps listed in  to .
Comment No. 2: "Error 2", [Text]: "Blue"
Comment No. 3: "Error 3", [Text]: "Cyan"
Comment No. 4: "Error 4", [Text]: "Magenta"

6.

8.

7.

5. 7.
3. Drawing fundamentals
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POINTPOINTPOINT

(1) How to select multiple comments
When multiple comments exist, select all the comments as follows.
• Click the upper left cell ([Column No.]).
• Right-click and select the [Select All] menu.

(2) Utilizing comments among different projects
Right-click to paste a comment to a different project.

(3) Setting the text, invert, blink, high quality font, style and solid in a batch
Select a column, and set the items with the column selected to create the same settings in a batch.
(a) Select a column.

(b) Change the settings with the column selected.

(c) The same settings are created in a batch.
3 - 164 3. Drawing fundamentals
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(2) Setting a comment display

(a) Click  on the object toolbar.
Once the object display position is determined on the screen, adjust the size of the comment display range.

RemarkRemarkRemark
For the details of the settings described in this section, refer to GT Designer3 (GOT2000) Help or the GT 
Designer3 (GOT2000) Screen Design Manual.

1. Double-click the comment display (word) to 
display the setting dialog.

2. Click the  button, and set [Device] to "D17".

3. Set the display shape frame to "61 Frame:  
Frame_1".

4. Set [Shape Color] to "White".

5. Click the [Comment] tab to set the display 
method of the comments.

6. Select the display method of the comments.
To display comments with a word device, select 
"Indirect Device".

7. Set "Comment No." to 1.
(It is not related to the display of the GOT.)

8. Click the  button.

2.
3.

4.

6.

7.

8.
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3.21 Setting the language switching function
This function switches comments displayed on the screen to other languages 
(English and Chinese) in a batch.

Example) Switching the language with the comment display (word)

Set screen No. 19 as shown below.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Comment display (word) 
(Specify a comment No.)

Language switching device 
(Specify a column No.)

D100 1 D100 2 D100 2 

D200 1 D200 1 D200 2 

Emergency stop limit 
switch operated.
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3.21.1 Setting the language switching device

To use the language switching function, set the language switching device.
The settings for the language switching device are common in the project.

1. Select [Common] → [GOT Environmental 
Setting] → [Language Switching] from the menu.

2. The [Environmental Setting] window appears.

3. Select [Use Language Switching].

4. Set [Language Switching Device] to "D1100".

5. Click the  button.

1.

3.
4.

5.
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3.21.2 Registering a comment group

(1) Creating a new comment group (title)

(2) Creating a new comment group (operating status)

1. Select [Common] - [Comment] - [New Comment 
Group] from the menu.

2. The [Comment Group Property] dialog appears. 
Make the settings as shown below.
[Group No.] : "2"
Title : "Comment Group 1"
Column No. : Select "1" and "2".
[KANJI Region] : "Japan"

Click the  button.

3. The No. 2 comment group 1 comment list dialog 
appears.
Enter the comments as shown below.
Column No. 1: "ラインA生産状況 "
Column No. 2: "Line A production condition"

Click the  button to close the window.

1. Select [Common] - [Comment] - [New Comment 
Group] from the menu.

2. The [Comment Group Property] dialog appears. 
Make the settings as shown below.
[Group No.] : "3"
Title : "Comment Group 2"
Column No. : Select "1" and "2".
[KANJI Region] : "Japan"

Click the  button.

(Next page)

2.

3.

2.
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(From previous page)

3. The No. 2 comment group 2 comment list dialog 
appears.
Enter the comments as shown below.
Column No. 1: "稼働中 "
Column No. 2: "Operating"

4.  Click the  (New Row) button.

3. Enter the following comments.
(Comment No. 2)
Column No. 1 : "コンベア停止中 "
Column No. 2 : "Conveyer stopped"

(Comment No. 3)
Column No. 1 : "点検中 "
Column No. 2 : "Inspecting"

(Comment No. 4)
Column No. 1 : "異常停止中 "
Column No. 2 : "Emergency stopped"

(Comment No. 5)
Column No. 1 : "完了 "
Column No. 2 : "Complete"

Click the  button to close the window.

3.

4.

5.
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Precautions when using the language switching function and comment display
(1) Using [Language Switching Preview Column No.] on the toolbar when creating a screen

Using [Language Switching Preview Column No.] affects all of the object settings.
Example: When [Language Switching Preview Column No.] is set to 2 and alarms are set, the comments for 

the basic, middle, and upper alarms cannot be displayed. (The comment group of the alarm is set 
only in column No. 1.)

(2) Using the language switching for a comment group and alarms during training
Example: When the column number is set to 2 in the comment group and the alarms are checked, "No 

message" is displayed. (The comment group of the alarms is set only in column No. 1.)

Setting the KANJI region
This setting is required to use the kanji characters for comments.
It is not the language setting. Thus, the default setting (Japan) is not required to be changed for the language which 
does not have kanji characters (such as English).

Displaying KANJI characters other than those of Japanese
To display KANJI characters other than those of Japanese, install a system font which supports them.
If the supported system font is not installed in the GOT, the Japanese KANJI characters will be displayed.

RemarkRemarkRemark

Copying Excel text to a comment
Paste multiple-row text in Excel into the comment list in the following procedure.

(a) Copy multiple rows in Excel.
(b) Right-click the row or column to paste comments in the comment list.
(c) Select [Paste from Excel] from the displayed menu to paste the comments.
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3.21.3 Setting a comment display

(1) Setting a comment display (simple)

(2) Setting a comment display (word)

1. Select [Object] - [Comment Display] - [Simple 
Comment] from the menu.

2. Click on the screen to place a simple comment.

3. Set [Comment Group No.] to "2".

4. Set [Preview Column No.] to "1".

5. Set [Comment No.] to "1".

6. [Font] : "Outline Gothic"
[Text Size] : "36"
[Alignment] : "X:  Y: "

7. Click the  button.

1. Select [Object] - [Comment Display] - [Word 
Comment] from the menu.

2. Click on the screen to place a word comment.

3. Set the item in the [Device/Style] tab as shown 
below.
[Device] : "D1120"

(Next page)

5.
6.

7.

3.
4.

3.
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(From previous page)

4. Select the [Comment] tab.

5. Set the items in [Comment Group] as shown 
below.

[Group No.] : "Fixed"
"3"

6. [Font] : "Outline Gothic"
[Text Size] : "36"
[Alignment] : "X:  Y: "

7. Set [Display Type] of [Comment] to "Indirect 
Device".

8. Set the preview number to "1".
Click the  button.

5.

6.

7.

8.
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3.21.4 Setting a touch switch (for language switching)

(1) Setting a word switch

1. Select [Object] - [Switch] - [Word Switch] from 
the menu.

2. Click on the screen to place a word switch.

3. Set the items in the [Device] tab as shown below.

• Operation setting
[Device] : "D1100"
[Setting Value] : Select [Constant].

  Set it to "1".

4. Set the item in the [Style] tab as shown below.

<Settings for off>
[Shape] : "FA Control Switch Figure 

A1: 107 SW_04_0_LB"
[Shape Color] : "Cyan"
<Settings for on>
[Shape] : "FA Control Switch Figure 

A1: 37 SW_02_0_Y"
[Shape Color] : "Yellow"

(Next page)

3.

4.
3. Drawing fundamentals
3.21 Setting the language switching function

3 - 173



(From previous page)

5. Select the [Text] tab.

6. [Text]: Enter "Japanese".

Click the  button.

7. Create another switch by copying and pasting 
the switch created above in steps  to .

8. Double-click the new switch, and make the 
settings as shown below.

[Device] tab
[Setting Value]: Select "Constant", and set it to 
"2".

[Text] tab
[Text]: Enter "English".

Click the  button.

6.

1. 6.
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3.22 Operation check 8
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 19.

(2) Test 2
Perform the following test on screen No. 19.
When X2, X3, X4 and X5 are turned on, the comments display "Error 1" to "Error 4" by using the sequence 
program.

Test object

Item
Comment display using a bit device

1) PLC test switch (XF) Turn on the switch.

Operation 
results

Screen status "Error" is displayed.

Write device ───

Read device ───

2) PLC test switch (XF) Turn off the switch.

Operation 
results

Screen status "Normal" is displayed.

Write device ───

Read device ───

Test object

Item
Comment display using a word device

1) PLC test switches (X2, X3, X4, and X5) Turn on and off each switch.

Operation 
results

Screen status

When only X2 is on: "Error 1" is displayed.

When only X3 is on: "Error 2" is displayed.

When only X4 is on: "Error 3" is displayed.

When only X5 is on: "Error 4" is displayed.

Write device ───

Read device ───

 108 
SM401

Always 
OFF

X2

Error 1
MOVP K1 D17

Error 
data

X3

Error 2
MOVP K2 D17

Error 
data

X4

Error 3
MOVP K3 D17

Error 
data

X5

Error 4
MOVP K4 D17

Error 
data
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(3) Test 3
Perform the following test on screen No. 19.

Test object

Item

Data write switch
(English)

Data write switch
(Japanese)

Comment display
(Operating status)

Comment display
(Line A production 

condition)

Touch operation (English) Touch the switch. ─── ─── ───

Operation 
results

Screen status The switch is pressed. ───
The comment display 
changes to the English 
display.

The comment display 
changes to the English 
display.

Write device D1100: 2 ─── ─── ───

Read device ─── ─── D1120 D1110

Touch operation (Japanese) ─── Touch the switch. ─── ───

Operation 
results

Screen status ─── The switch is pressed.
The comment display 
changes to the 
Japanese display.

The comment display 
changes to the Japanese 
display.

Write device ─── D1100: 1 ─── ───

Read device ─── ─── D1120 D1110
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3.23 Alarm functions

3.23.1 Alarm functions

Set the alarm functions in the alarm observation, and the set alarms are displayed in 
the alarm display or alarm popup display.

 Alarm type
The GOT collects the following alarms.

(1) User alarm
With this function, a user-created comment can be displayed as an alarm message when an alarm occurs.
Use this function when displaying an alarm created by a user.

(2) System alarm
This function displays the error code and the error message when an error occurs in the GOT, controller, or 
network.
Use this function when displaying an error occurred in the GOT, controller, or network.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3
Screen

No.1

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of the 

power supply unit.

M100: OFF → ON
M101: OFF → ON

Error occurred

400 The communication with CPU failed. 16:40:30 

9   AC down has been detected. 

803 The transient error has occurred.
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 Types of alarm functions
Set the alarm functions in the user alarm observation or the system alarm observation.
The alarms set in the alarm observation are displayed in the alarm display (user), alarm display (system), or alarm 
popup display.

Alarm functions

Alarm popup display

Alarm settings

SystemUser

+

SystemUser

Alarm display

User System

Alarm display 
(User)

Alarm display 
(System)

User System

System alarm
System alarm

System alarmUser alarm

User alarm
User alarm

User alarm System alarm

System alarm 
observation

User alarm 
observation
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 Relation among alarm observation, alarm display, and alarm popup display
The alarm observation, alarm display, and alarm popup display can be set individually.
The following usages are available.

(1) Arranging various displays by one alarm observation

(2) Creating multiple alarm observation settings and switching them in a single screen

+

Comment
Jun. 1, 2004
Error date and time

Temperature anomaly

Setting alarms 
in the alarm observation

Alarm ID 1

Arranging alarms 
in the alarm display

Alarm display

Single line display

Multiple lines display

Comment
Jun. 1, 2004

Jun. 1, 2004

Jun. 1, 2004

Error date and time
Temperature anomaly

Fuse error

Oil error

Displaying the alarm ID 1 in a 
single line 
(Set it on the objects arranged 
in the alarm display.)

Displaying the alarm ID 1 in 
multiple lines 
(Set it on the objects arranged 
in the alarm display.)

Various settings are available for each display object! 
(Such as the initial display hierarchy, touch mode, 
display items, and display condition)

+
Switch

Alarm ID 1 
(Setting it in the alarm 
observation)

Alarm ID 2 
(Setting it in the alarm 
observation)

Alarm display

GD0 = 1: Displays the alarm of the alarm ID 1. 
GD0 = 2: Displays the alarm of the alarm ID 2.

Comment
Jun. 1, 2004

Jun. 1, 2004

Jun. 1, 2004 Oil error

Error date and time
Temperature anomaly

Fuse error

Set the switching device of the 
alarm ID for GD0.
(Setting it in the alarm display)

Create multiple alarm observation settings and 
switch them to display alarms in a single screen!

Setting alarms 
in the alarm observation

Arranging alarms 
in the alarm display
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(3) Setting whether to display the alarm popup display

POINTPOINTPOINT

Alarm ID
Creating multiple user alarm observation settings is possible. The alarms are identified with each alarm ID.
Specify the alarm ID when placing the object in the alarm display (user) to display the alarm of the specified alarm 
ID.

+
A 1254

348B
A 1254

348B

Setting alarms 
in the alarm observation Setting alarms in the alarm popup display

(The alarm message 
pops up.)

(The alarm message 
does not pop up.)

(The alarm message 
pops up.)

Alarm popup display

Alarm ID 1

Alarm ID 2

Alarm ID 3

Jun. 1, 2004 13:20 Power supply unit error

Setting the alarm popup 
display 
(Setting alarms in the alarm 
popup display)

Whether the error message pops up 
can be set for each alarm 
observation setting.

Only the alarm ID 1 and alarm ID 3 error 
messages pop up.

Error date and time Comment Restored Error date and time Comment Restored Error date and time Comment Restored

Comment Level Group Error date and time Comment Restored

Setting alarms in the alarm observation

User alarm

Alarm ID 1 Alarm ID 2

Multiple alarms can be set!

System alarm

Arranging alarms in the alarm display

Set the alarm display to 
display the alarm ID 1.

Set the alarm display to 
display the alarm ID 2.

Set the alarm display to 
display system alarms.

Base screen 3 
(It displays all the system 
alarms.)

Base screen 2 
(It displays the alarm date and 
time, comment, and restored 
date set in the alarm ID 2.)

Base screen 1 
(It displays the alarm date and 
time, comment, and restored 
date set in the alarm ID 1.)

Set the alarm display to 
display the alarm ID 1.

Window screen 1 
(It displays the alarm comment, 
level, and group set in the 
alarm ID 1.)

Window screen 2 
(It displays the current 
system alarm.)

Set the alarm display to 
display system alarms.
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3.23.2 Alarm observation

There are the user alarm observation and system alarm observation for the alarm observation.

(1) User alarm observation
Users can set a comment and monitor alarms.

(2) System alarm observation
You can monitor the following alarms with the system alarm observation.
• CPU error: Displays a CPU error as an alarm.
• GOT error: Displays a GOT error as an alarm.
• Network error: Displays a network module error as an alarm.

3.23.3 Alarm display

There are the alarm display (user) and alarm display (system) for the alarm display.

(1) Alarm display (user)
It displays the comment set by a user.
To display the comment registered in the comment group, set a comment in the basic comment, middle alarm 
comment, or upper alarm comment in the setting dialog of the user alarm observation, and read the alarm 
information to the alarm display (user).

The alarm detail display can be displayed on the comment window, base screen, and window screen. By using 
the switching device of the alarm ID from the PLC, the alarm in the user alarm observation dialog can be 
displayed.

(2) Alarm display (system)
• CPU error: Displays a CPU error as an alarm.
• GOT error: Displays a GOT error as an alarm.
• Network error: Displays a network module error as an alarm.

With the above settings, the type of alarms to be monitored is selectable.
The alarm events are displayable by alarm type, enabling you to rapidly grasp the alarm information.
3. Drawing fundamentals
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Create screen No. 22 as shown below.

3.23.4 Setting and arranging a user alarm

Double-click [Comment] - [New] in the [Project] window and add the following comments.

[Registered comments]

POINTPOINTPOINT

Before setting the above comments, set "Language Switching Preview Column No." to No. 1.
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(1) Creating a new user alarm observation setting

1. Right-click [Project] - [Alarm] - [User Alarm 
Observation], and select [New] in the [Project] 
window.

The setting dialog of [User Alarm Observation] 
appears.

2. Click the [Basic] tab and set the items as shown 
below.

[Alarm ID] : "1"
[Alarm Name] : "User alarm 1"
[Popup Display] : Selected
[Stored Number] : "6"
[Full Notification Signal Device] : "M210"

3. Click the [Device] tab and set the items as shown 
below.

[Watch Cycle] : 1000 ms
[Alarm Points] : "6"
[Device Setting] : "Random"

4. Click the [Alarm Hierarchy Setting] button.

(Next page)

Right click

2.

3.

4.
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[Device and comment No. assignment]

(From previous page)

5. The [Alarm Hierarchy Setting] dialog appears. 
Make the settings as shown below.

• [Upper Comment]
6: Upper alarm comment: "Random"

• [Middle Comment]
5: Middle alarm comment: "Random"

• [Basic Alarm Comment]
4: Basic alarm comment: "Random"

• [Detail Display]
2: Comment group 1: "Random"

6.   Click the  button.

No. [Device] [Alarm 
Range]

[Basic Alarm 
Comment No.]

[Middle 
Comment No.]

[Upper Comment 
No.] [Detail Display] [Detail No.] [Level]

1 XA ON 1 1 3 [Comment 
Window] 1 1

2 XB ON 2 1 3 2

3 XC ON 3 1 1 3

4 XD ON 1 2 3 1

5 XE ON 2 2 2 2

6 XF ON 3 2 2 3

(Next page)

5.

6.
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[Alarm hierarchy image]

(From previous page)

7. Click the [External Output] tab and set the items 
as shown below.

[History Number Storage] : "D120"
[Generated Number Storage] : "D121"

8.   Click the  button.

7.

8.

Basic alarm

Middle alarm

Upper alarmLine A Line B

Control unit

Device A Device B

XC 
3

Drive module Control unit

XF 
3

XE 
2

Device A

Power supply unit Drive module Power supply unit

Device B

Line C

XB 
2

XA 
1

XD 
1 Level
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(2) Setting the number of histories and occurrences, level, and full notification

[Number of histories]

[Number of occurrences]

1. Click  on the object toolbar, and place a 
numerical display (number of histories and 
occurrences) on the screen.

[Number of histories]
[Device]: "D120"
[Digits (Integral)]: "2"
[Fill with 0]: Selected

[Number of occurrences]
[Device]: "D121"
[Digits (Integral)]: "2"
[Fill with 0]: Selected

2. Click the  button.

[Level] 3. Click  on the object toolbar, and place a 
numerical input on the screen.

[Level]
[Device]: "D122"
[Digits (Integral)]: "2"
[Fill with 0]: Selected

4. Click the  button.

5. Click  on the object toolbar, and place a 
lamp display (bit) on the screen.

[Full notification setting]
[Device]: "M210"

<Settings for off>
[Shape] : "Real Lamp Figure 2: 68 03_0_R"
[Shape Color]: "Red"

<Settings for on>
[Shape] : "Real Lamp Figure 2: 67 03_1_R"
[Shape Color]: "Red"

6. Click the  button.

1.

1.

3.

5.
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(3) Setting the alarm display (user)
1. Select [Object] - [Alarm Display] - [Alarm 

Display (User)].

2. Click on the screen to place a user alarm.

3. Set the items in the [Alarm Setting] tab as 
shown below.

[Display Alarm] : Select "User Alarm".
[Alarm ID] : Fixed to "1", 

"User alarm 1"
[Display Type] : "Fixed"
[Initial Display Hierarchy]: "Upper"
[Touch Mode] : "Operation"

4. Set the items in the [Display] tab as shown 
below.

[Attribute] [Digits] [Title] [Date/Time Format]

[Occurred] 20 [OCCURRED] **/**/** **:**

[Comment] 30 [COMMENT] -

[Status] 6 [STATUS] -

[Checked] 8 [CHECK] **:**

[Level] 14 [LEVEL] -

(Next page)

3.

4.
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(From previous page)

5. Set the items in the [Text] tab as shown below.

[Target] : "Level"
[Level]
1 : "Red"
2 : "Orange"
3 : "Yellow"

6. Set the items in the [Extended] tab as shown 
below.

[Switching Device]: Select [Level].
[Level] : "D122"

7. Click the  button.

5.

6.

7.
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(4) Setting the switch for the alarm display
Set the touch switch used for displaying and moving an alarm display cursor, and displaying alarm details.

(a) Placing the touch switch for the alarm display on the screen
The touch switch for the alarm display is registered in the library of GT Designer3. Set it by reading from 
the library.

1. Select "FA Metal_N Alarm Key 1" from "FA 
Metallic_N" in the [Library] window.

2. The library image list window appears. Select 
"ALM01_B".

3. Click on the screen to place a touch switch for 
the alarm display.

2.

1.
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(b) Settings and functions of the touch switch for the alarm display
You can change the touch switch type for the alarm display by setting the key code value of the touch 
switch.
To change the functions of the alarm display touch switch explained in the previous page, follow the 
procedure below.

1. Right-click the touch switch and select 
[Ungroup].

2. Change the value in [Key Code] in the [Property] 
sheet or others.

Note) Usually, changing the value in the key 
code is not necessary because the key 
code has been set for the data in the 
system library.

1.

2.
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The following shows the types of the touch switch for the alarm display and values of the key code.

Switch name Description Key code

[Cursor ON] Displays the cursor. FFB0H

[Cursor OFF] Hides the cursor. FFB1H

[Up] Moves the cursor upward. (Displays the next page when the cursor is hidden.) FFB2H

[Down] Moves the cursor downward. (Displays the next page when the cursor is hidden.) FFB3H

[Check] Displays the date/time of the selected alarm data. FFB4H

[Check all] Displays the date/time of all alarm data. FFB5H

[Delete] Deletes the selected restored alarm data. FFB6H

[Delete all] Deletes all restored alarm data. FFB7H

[Detail] Displays detail information. FFB8H

[Reset] Resets the specified device. FFB9H

[Save] Saves alarm data to a memory card. FFBBH

[Ladder] Starts the sequence program monitor (ladder) and searches for alarm devices. FFBCH

[Upper hierarchy] A switch for the alarm display. It cannot be used for this function. FFC2H

[Lower hierarchy] A switch for the alarm display. It cannot be used for this function. FFB8H

[Specified jump]
Displays the data obtained at the time stored in the display position time 
specification device. (Time specification jump function)

FFBEH
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(5) Setting the one-touch ladder jump function
To search for set devices automatically when starting the sequence program monitor (ladder) by using the 
special function switch, set as follows.
(a) Setting an error lamp

(b) Setting a one-touch ladder jump function switch

1. Select [FA Control] - [FA Control Lamp 1] - 
[2 L_01_R] from the library workspace, and place 
it on the screen.

2. Set the item in the [Device/Style] tab as shown 
below.
[Device] : "Y70"

3.  Click the  button.

1. Select [Object] - [Switch] - [Special Function 
Switch].

Double-click the switch to display the setting 
dialog.

2. Set [Switch Action] to "Sequence Program 
Monitor (Ladder)".

(Next page)

2.

3.

2.
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(From previous page)

3. Select [Use One-touch Ladder Jump].

4. Set a device to be searched for in [Ladder 
Search Device].

In this example, set "Y70".

5. Click the [Style] tab and select a shape used for 
the switch.

6. Click the [Text] tab and set the following item.

[Text]: "One-touch 
ladder jump 
(Y70)"

7. Select "OFF=ON".

8. Click the  button.

4.

5.

3.

6.

8.

7.
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(6) Operation check (one-touch ladder jump function switch)

Test object
Item

Lamp One-touch ladder jump Screen

5) PLC test switch (X2) Turn on X2.

Operation result Screen status ON ── ──

6) Touch operation (one-touch ladder jump) ── Touch the switch. ──

Operation result Screen status ── ── ──

7) Touch operation of a normally open contact 
(M2003)

Touch the normally open contact (M2003), and then touch [Find] - [Factor search].

Operation result Screen status ── ──
The ladder block of the factor search result is 

displayed.

 141 
X2

Error 1
M2000

Stamping
error

X3

Error 2

 144 
X4

Error 3
M2001

Welding 
error

 146 
X5

Error 4
M2002

Inspection 
line 
trouble

 148 
M2000

Stamping
error

M2003
Production 
line 
trouble

M2001

Welding 
error

 151 
M2002

Inspection 
line 
trouble

Y70
Error

M2003

Production 
line 
trouble
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3.23.5 Alarm popup display

The GOT displays alarms whether or not the target object for the alarm popup display is placed.
Even a long comment can be displayed in the alarm popup display by scrolling across the screen from right to left.

 How to use the alarm popup display
User alarms and system alarms can be displayed.

POINTPOINTPOINT

To use the popup display, set the above items and select [Popup Display] in the user alarm observation.

For each base screen, the position of the alarm popup display and whether to display or not can be set.
For the details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

1. Select [Common] - [Alarm] - [Alarm Popup 
Display].

2. Select [Use Alarm Popup Display].

3. Set [Display Alarm] to "User Alarm".
· "User Alarm"
· "System Alarm"
· "User Alarm + System Alarm"
Any above three settings can be selected.

4. Set [Initial Display Hierarchy] to "Upper".

5. Set [Touch Mode] to "Stage Hierarchy Switching/
Detail Display".

2.
3.

4.
5.
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3.24 Operation check 9
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.

(1) Test 1
Perform the following test on screen No. 22.

Test object
Item

Device writing Comment display Status Check
Number of 
histories

Number of 
occurrences

1) PLC test switch (XA)

XA ON Check Line C. ── ── 1 1

2) Select the history of "Check Line C." by touching "Cursor ON" and "Lower hierarchy".

── An error occurs in the device A. ── ── 1 1

3) Select the history of "An error occurs in the device A." by touching "Cursor ON" and "Lower hierarchy".

Display the comment window. ──
An error has occurred in the power 

supply unit.
Occurred ── 1 1

4) Select the history of "An error has occurred in the power supply unit." by touching "Cursor ON" and "Lower hierarchy".

Display the comment window. ── Line A status ── ── 1 1

5) Touch "Upper hierarchy" to switch the comment.

Touch the switch once. ── An error occurs in the device A. ── ── 1 1

6) Touch "Upper hierarchy" to switch the comment.

Touch the switch once. ── Check Line C. ── ── 1 1

7) PLC test switches (XB, XC, XD, XE, and XF)

↓ XB ON

Turn on XB to XF to display the 
following comments.

Check Line B.
Check Line C.
Check Line A.

── ── 2 2

↓ XC ON ── ── 3 3

↓ XD ON ── ── 4 4

↓ XE ON ── ── 5 5

↓ (Full notification (M210: ON): 
The lamp turns on.)

XF ON ── ── 6 6

8) Touch "Cursor ON", "Lower hierarchy", and "Upper hierarchy" to check the alarm data and where the alarm occurs.
→ (Refer to [Alarm hierarchy image].)

9) Select the history of "Check Line B." by touching "Cursor ON" and "Lower hierarchy".

── An error occurs in the device B. ── ── 6 6

10) Select the history of "An error occurs in the device B." by touching "Cursor ON" and "Lower hierarchy".

──
An error has occurred in the drive 

module.
Occurred ── 6 6

──
An error has occurred in the control 

unit.
Occurred ── 6 6

11) PLC test switch (XF)

XF OFF
An error has occurred in the control 

unit.
Restored ── 6 5
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Test object
Item

Device writing Comment display Status Check
Number of 
histories

Number of 
occurrences

12) Select an item to be deleted by deleting or touching directly the restored history of XF, or touching "Cursor ON", "Down", and "Up".

(Full notification (M210: ON): The lamp 
turns off.)

── ── ── ── 5 5

13) Touch "Upper hierarchy" to switch the comment.

Touch the switch once. ── An error occurs in the device B. ── ── 5 5

14) Touch "Upper hierarchy" to switch the comment.

Touch the switch once.

── Check Line B. ── ── 5 5

── Check Line C. ── ── 5 5

── Check Line A. ── ── 5 5

15) Touch the level (numerical input object) and input 3.

Narrow down the alarms with the level 1. D122 → 3 Check Line A. ── ── ── ──

16) Touch the level (numerical input object) and input 0.

Narrowing down the alarms is canceled. D122 → 0

Check Line B. ── ── 5 5

Check Line C. ── ── 5 5

Check Line A. ── ── 5 5

17) PLC test switches (XB, XC, XD, and XE)

↓ XB OFF

Check Line B.
Check Line C.
Check Line A.

── ── 5 4

↓ XC OFF ── ── 5 3

↓ XD OFF ── ── 5 2

↓ XE OFF ── ── 5 1

18) Touch the blinking comment "Check Line C.", "An error occurs in device A.", 
or "An error has occurred in the power supply unit." in the bottom of the screen (alarm popup display).

Display the comment window. ── Line A status ── ── 5 1
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3.25 Sequence program monitor (ladder)

3.25.1 Features

With the sequence program monitor (ladder) function, you can use the GOT to monitor or edit the sequence program of 
a controller in the ladder diagram format and change the current device values.
This function supports the display switching (decimal or hexadecimal format), the display of the device comments written 
to a PLC CPU, and the display language switching.
This function also supports the search for a contact which causes a fault, reducing the causal analysis time.

Screen of the sequence program monitor (ladder)

Functions available on the ladder monitor screen

Function Description

Search 
operation

Device search Displays a ladder block containing the specified device.

Contact point 
search

Displays a ladder block containing the specified contact.

Coil search Displays a ladder block containing the specified coil.

Step search Displays a ladder block with the specified step number.

Ladder end 
search

Displays the last ladder block in a sequence program.

Defect search
Searches the ladder blocks for the conductive or non-conductive status of the contact which turns 
on or off a specific coil on the sequence program.

Touch search
Searches for the device coil corresponding to the contact touched on the monitor screen, or 
searches for the contact corresponding to the device coil touched on the monitor screen.

Display switching Displays word devices in decimal or hexadecimal format, or displays device comments.

Test operation Perform test operations such as changing device values.

Hard copy Saves the screenshots of ladders in the BMP or JPEG format.
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The following shows features of the sequence program monitor (ladder).

 Editing sequence programs on the GOT
Sequence programs are editable in the ladder diagram format by using the sequence program monitor (ladder).

The following screens are displayed with the sequence program monitor (ladder).
• PLC read screen
• Ladder monitor screen
• Ladder editor screen

 Switching display formats, device comment display, and languages
The following methods are available.

• Switching whether to display or hide device comments
• Switching languages for file names of sequence programs, comments, and others

(1) Device comment display switching
Whether to display or hide device comments used in sequence programs can be switched.

(2) Language switching
Preparing a comment file created in either of the following character codes enables character code switching of 
the header and comment of a file following the language switching in the utility.
• Shift JIS code
• GB code
• Big5 code
• KS code
• ASCII code

When comment files created in each character code are stored in a data storage, you can switch the language 
to display a comment by switching comment files, regardless of the language selected in the utility.

X10

Touch a position to input a contact.

Y22

Input the contact (Always OFF).

SM401X10

Y22
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 Displaying registered ladder blocks is available
On the [Ladder registration monitor] window, displaying registered ladder blocks is available.

21

85

87

90

M12

Y43

Y44

21

Ladder registration monitor window

M12

Y43

Y44

Y45

Y46

Y6F

Y70

Y71

Y72

M13

M110

M111

M112

90 Y72

M112

24
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 Enhanced interaction with objects (One-touch ladder jump function)

(1) Interaction with the special function switch
The automatic PLC read or the device automatic search can be executed at startup of the sequence program 
monitor (ladder) by the following method. Place a special function switch on a user-created screen, specify the 
search file and search device in the special function switch setting, and then touch the special function switch.
Even an operator who is not familiar with the equipment inside can trace the cause of the equipment error 
without fail with simple operations. Thus, the time for the abnormal stop can be shortened.
Example) Coil searching by touching a special function switch

(2) Interaction with the alarm display (user) or simple alarm display
The sequence program monitor (ladder) can be started to search for a device having an alarm by the following 
method. Select an alarm in the alarm display, and touch a key code switch (Display ladder (Ladder Editor)).

Touch the special function button of error process.

(User-created screen)

Operation flow screen

Home position

Lifter down Lifter down

Hand close

Lifter up Lifter up

Forward Back

Hand open

X13X13

X10X10

M52M52 M54M54
M53M53

M53M53

M53M53 M55M55
M54M54

M54M54

Lifter upLifter up

Lifter up

Forward

Hand closeHand close

(Ladder monitor screen)

· Ladder Search Device: M53 
· Ladder Search Mode: Coil

Special function switch setting

The sequence program 
monitor (ladder) starts 
and searches for coil 
"M53" automatically.

"Forward operation M54" was not turned on since 
the lifter upper-end sensor (X10) was not turned on.

Lifter Lifter 
lower endlower end

Lifter Lifter 
upper endupper end

Select an alarm and touch the key code switch.

(User-created screen)

Display Ladder 
(Ladder Editor)

M12M12

X13X13

Y43

(Ladder monitor screen)

 · Code setting: FFBD

The search result is displayed.

Key code switch settings

Error date and time Comment

Aug. 1, 2009 13:30:14 Fuse error

Temperature anomalyAug. 1, 2009 14:46:49

Y44

Y45

Y46

The sequence program 
monitor (ladder) starts 
and searches for the 
device of alarm 
automatically.
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3.25.2 System configuration

This section explains the system configuration of the sequence program monitor (ladder).
For connection type settings and precautions concerning the communication unit, cable, and connection type, refer to 
the GOT2000 Series Connection Manual.

 Target controller

*1 Except the Q02PHCPU, Q06PHCPU, Q12PHCPU, Q25PHCPU, Q12PRHCPU, and Q25PHCPU
For creating a multiple CPU system with the Q00CPU, Q01CPU, Q02CPU, Q02HCPU, Q06HCPU, Q12HCPU, and/or 
Q25HCPU, use CPUs with the function version B or later.

*2 Only the PLC CPU area (CPU No. 1) in the Q170MCPU can be monitored.

 Connection type
(○: Available, ×: Unavailable)

*1 The LCPU does not support the connection type.
*2 When connecting the GOT with the LCPU, use L6ADP-R2.
*3 For the MELSECNET/10 connection, use a QCPU and network module (QJ71LP21, QJ71LP21-25, QJ71LP21S-25, 

QJ71LP21G, and QJ71BR11) with function version B or later.
*4 This connection type indicates the CC-Link IE Controller Network connection.
*5 This connection type indicates the CC-Link IE Field Network connection.
*6 This connection type cannot be used to connect a Q00JCPU, Q00CPU, Q01CPU, Q02CPU, Q02HCPU, Q06HCPU, Q12HCPU 

or Q25HCPU.
*7 This connection type indicates the CC-Link connection (Intelligent device station).
*8 This connection type indicates the CC-Link connection (via G4).
*9 When the CC-Link IE Field Network Ethernet adapter module is used, the ladder editor cannot be used.

 Required extended system applications
The following system applications are required.
• Sequence program monitor
• GOT platform library
• GOT function expansion library

(1) Extended system application
Write the package data that contains the extended system applications for the sequence program monitor 
(ladder) to the GOT.
For the communication method with the GOT, refer to GT Designer3 (GOT2000) Help or the GT Designer3 
(GOT2000) Screen Design Manual.

(2) Space for the extended system application
To install an extended system application to the GOT, enough space in the user area is required.
For information on how to check the available space of the user area and the other data in the user area, refer to 
GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

 Required hardware
The following hardware is required.

Controller

QCPU (Q mode)*1, motion controller CPU (Q series)*2

LCPU

CNC (C70)

Function Connection type between a GOT and the monitored controller

Name Description
Bus 

connection
*1

Direct CPU 
connection

*2

Computer 
link 

connection

Ethernet 
connection

*9

MELSECNET/H 

connection*1, 
MELSECNET/10 

connection*1*3

CC-Link IE 
Controller 

connection*1*4,
CC-Link IE Field 
connection*5*6

CC-Link 
connection

ID*7 G4*8

Sequence 
program 
monitor 
(ladder)

Monitors and edits a 
sequence program in the 
ladder diagram format, or 
changes current device 
values of the program.

○ ○ ○ ○ ○ ○ ○ ○

Required hardware

Data storage (such as an SD card and a USB memory)
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3.25.3 Operations for display

This section explains how to display the sequence program monitor (ladder) screen after the GOT is turned on.

1. Turn on the GOT.

2. Display the sequence program monitor (ladder) screen.
Display the screen by one of the following methods.
• Using the special function switch (Sequence program monitor (ladder)) set in the project

For information on how to set a special function switch, refer to GT Designer3 (GOT2000) Help or the GT 
Designer3 (GOT2000) Screen Design Manual.
If the project has not been written into the GOT yet, start the device monitor directly from the utility.

• Starting from the utility
In the utility, touch [Monitor] → [Seq.program monitor(Ladder)] from the main menu.
For how to display the utility, refer to the GOT2000 Series User's Manual (Utility).

3. Set the channel number, network number, station number, and CPU number in the communication setting dialog.

4. Read data from the PLC and display the [Program List] window.
Reading data from the PLC is not required when the GOT is restarted, because sequence programs and comment 
files are stored in a data storage with the sequence program monitor (ladder).

5. Select a program in the program list to display the ladder monitor screen.

6. Display the ladder editor screen from the edit menu of the ladder monitor screen.

For the details of the GOT display operations, refer to the GOT2000 Series User's Manual (Monitor).

The next section explains how to operate the ladder editor screen.
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3.25.4 How to operate ladder editor screen

On the ladder editor screen, editing sequence programs, finding devices, and displaying comments are available.
The following explains how to operate the ladder editor screen.

 Ladder editor screen
The following explains the layout of the ladder editor screen, and the functions of the menus and operation keys on 
the screen.

No. Item Display contents

1) PLC name Displays the label set in the PLC name setting for the target PLC CPU.

2) Connection destination
Displays the CH No., network No., station No., and CPU No. of the target PLC CPU as shown 
below.
CH No. network No.-station No. / CPU No.

3) Drive name Displays the source drive of the controller from which the displayed sequence program is read.

4) Program name Displays the file name of the displayed sequence program.

5) Number of steps Displays the number of steps for the displayed sequence program.

6) Keys Keys for the operations on the ladder editor screen.

7) Ladder display area

Displays the read sequence program.
By touching a contact, coil, output, statement, or note, the item is highlighted and the [Enter 
ladder program] window is displayed.
Touch [Show comments] from the [Display] menu to display the comments, statements or 
notes.
Touch [Hide comments] from the [Display] menu to hide the comments, statements or notes.
Displays the first step number of ladder blocks.
Touching the first step number of ladder blocks highlights the touched position, and displays the 
[Enter ladder program] window.

8) Message display area Displays error messages.

1) 2) 3) 4) )

1) 2) 3) 4) 5)

6)

7) 6)

8)
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(1) [Enter ladder program] window
Edit a sequence program.
(a) Displayed screen

The following table lists the displayed contents.

(b) Key functions

No. Item Display contents

1) Ladder symbol display area Displays the ladder symbol selected in the ladder display area.

2) Text display area

Displays devices, sequence programs, statements, and notes selected in the ladder 
display area.
The cursor is displayed at the position where text is input.
If devices, sequence programs, statements, and notes are not fully displayed in the 
display area, move the cursor to the border of the side where the display was cut, and 
touch the cursor to scroll the displayed contents.
Only one-byte alphanumeric characters can be input for statements and notes.
If characters other than one-byte alphanumeric characters input on GX Works2/GX 
Developer are deleted on the GOT, they cannot be input again.

3) Keys Used for the operations in the [Enter ladder program] window.

Key Function

Closes the [Enter ladder program] window. The displayed contents are not reflected.

Touch the key to input a normally open contact.

Touch the key to input a normally closed contact.

Touch the key to input a leading edge pulse.

Touch the key to input a trailing edge pulse.

Touch the key to input a leading edge pulse rejection.

Touch the key to input a trailing edge pulse rejection.

Touch the key to input conversion of the operation result to leading edge pulse.

1)

1)

3)

3)

3)

(Reduced size)

2)

2)
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Touch the key to input conversion of the operation result to trailing edge pulse.

Touch the key to input a coil.

Touch the key to input an application instruction.

Touch the key to input a vertical line.

Touch the key to delete a vertical line.

Touch the key to input a horizontal line.

Touch the key to delete a ladder.

Inserts one row in the specified position.

Deletes the specified row.

Inserts one column in the specified position.

Deletes the specified column.

Reflects the displayed contents, and closes the [Enter ladder program] window.

Reduces the size of the [Enter ladder program] window.

Changes the [Enter ladder program] window from the reduced size to the default size.

Switches the alphabetic characters between the uppercase and the lowercase.

Key Function
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(c) Inputting or deleting ladders
• Inputting contacts or instructions

(Operation example: Inputting a contact (X0))

1. Touch a position to input a contact (X0).

2. The [Enter ladder program] window appears.

3. Touch the  key.
The ladder symbol corresponding to the touched 
key is displayed on the ladder symbol display 
area. Input X0 in the text display area, and touch 
the  key.

4. The contact (X0) is input.
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• Deleting contacts or instructions
(Operation example: Deleting a contact (X0))

1. Touch a contact (X0) to be deleted.

2. The [Enter ladder program] window appears.

3. Touch the  key.
Touch the end position of the contact (X0).

4. The contact (X0) is deleted.

Touch an end position.
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• Inputting vertical lines or horizontal lines
(Operation example: Inputting a vertical line)

1. Touch a position to input a vertical line.

2. The [Enter ladder program] window appears.

3. Touch the  key.
Touch the end position to input the vertical line.

4. The vertical line is input.

Touch an end position.
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• Deleting vertical lines or horizontal lines
(Operation example: Deleting a vertical line)

1. Touch the vertical line to be deleted.

2. The [Enter ladder program] window appears.

3. Touch the  key.
Touch the end position of the vertical line to be 
deleted.

4. The vertical line is deleted.

Touch an end position.
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• Inserting rows or columns
(Operation example: Inserting a row)

• Deleting rows or columns
(Operation example: Deleting a row)

1. Touch a position to insert a row.

2. The [Enter ladder program] window appears.

3. Touch the  key.
The [Enter ladder program] window is closed, and 
the row is inserted.

4. Touch the row to be deleted.

5. The [Enter ladder program] window appears.

6. Touch the  key.
The [Enter ladder program] window is closed, and 
the row is deleted.

Insert row

Delete row
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3.25.5 Key functions

The following shows the functions of the operation keys on the ladder editor screen.

Key Function

Returns the screen to the last screen that is displayed right before the ladder editor screen appears.
The key is disabled when the last screen is the GOT utility screen or user-created monitor screen.

Displays the [Edit] menu.

Displays the [Find/Replace] menu.
When the [Find/Replace] menu is displayed, touching the key closes the menu.

Converts the editing program to the execution program.

Displays the [Display] menu.

Displays the [Online] menu.

Exits the ladder editor screen and returns to the screen where the ladder editor screen was started.

Scrolls the display up or down one line.

Scrolls the display up or down one page.
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3.26 Security function

3.26.1 Security function

Set the security for objects, the screen display and operation, the read operation, 
and the utility operation.
You can restrict the user who operates the GOT by setting the security.
The GOT security includes the screen security, the functional operation security, and 
the data transfer security.
This section explains the screen security.

With the screen security, by setting the security level (0 to 15) per object and screen, the screen display can be changed 
according to the user's security level.
Change the security level by either of the following two authentication methods: operator authentication and level 
authentication.

(1) Operator authentication
The operator authentication is an authentication method to change the security level with the operator 
information set for each operator.
To record the user information, use the operation log function in combination.
To strengthen the security, set the automatic logout and the password expiration date.
The operator authentication includes the following authentication types.

(a) Operator authentication with a password
The operator is authenticated with an operator name and password that are input by the user.
When using the operator authentication with a password, install the extended function (operator 
authentication) to the GOT.

Screen
No.8

Screen
No.6

Screen
No.7

Screen
No.5

Screen
No.17

Screen
No.14

Screen
No.15

Screen
No.16

Screen
No.19

Screen
No.22

Screen
No.10

Screen
No.11

Screen
No.1

Screen
No.13

Screen
No.23

Screen
No.24

Screen
No.20

Screen
No.3

A

Security level: 2

348B348B

Line No. 1
1254A 1254

Cancel

Security level: 10

348B348B

Line No. 1
A 1254A 1254

Input the operator name and 
password to set to high 
security level.

The screen displays the objects 
according to the set security level.

Cancel

GOT

Operator name:      TARO
Password:              MITSUBISHI

Authentication succeeds!

Input the operator name 
and the password.
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(b) Operator authentication with an external authentication device
The operator is authenticated with the external authentication ID that is input using an external 
authentication device.
You can use an RFID controller or a barcode reader as an external authentication device by connecting 
them to the channel No. 8 with the RFID function.

When using the operator authentication with an external authentication device, install the extended 
functions (operator authentication and RFID) to the GOT.

(2) Level authentication
The level authentication is an authentication method with a password set for each security level.

POINTPOINTPOINT

Up to 32 uppercase and lowercase alphabetic characters, numbers, one-byte spaces, and the symbols below are 
usable for a password.
! " # $ % & ' ( ) * + , ` - . / : ; < = > ? @ [ \ ] ^ _ { | } 

When the password set for each security level is forgotten, security levels cannot be changed.
Always make a note of the registered password.

RemarkRemarkRemark
For the details of the security function, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) 
Screen Design Manual.

POINTPOINTPOINT

Precautions for system applications
(1) Operator authentication

When the operator authentication is used, required extended functions differ depending on the authentication 
method.

Authentication type Required extended function

Operator authentication with a password Operator authentication

Operator authentication with an external 
authentication device

Operator authentication, RFID

GOT

Operator name:                  TARO
External authentication ID: 98760001

Authentication succeeds!

OK

RFID tag RFID controller

External authentication ID: 98760001

Input the external authentication ID 
from an external authentication device.

An operator authentication 
succeeded.
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3.26.2 Operation log function

The history of operations performed on the GOT can be saved to an SD card.
Operation histories can be used to specify the cause of troubles occurring at the production site.

(1) Items that can be recorded with the operation log function

(2) Saving operation logs
For the data recorded with the operation log function, binary files (*.G20) are created in drive A (SD card), drive 
B or E to G (USB), or drive X (current drive).
In a created operation log file, up to 65500 operations can be recorded.
When the number of logs exceeds 65500, another operation log file is newly created. (A version is assigned to 
the created operation log file.)

(3) Managing operation log files
(a) You can save operation log files in days or weeks.

Saved operation log files can be deleted automatically after a certain period of time.
(b) You can specify the size of operation log files (total size of all operation log files) to be saved to the SD 

card.
When the size exceeds the specified one, the oldest operation log file is automatically deleted.

HINTHINTHINT

Versions of operation log files
When no operation log file exists, the version starts from 0000, and is incremented by one every time a new file is 
created.
After the version reaches 9999, 0000 is assigned to a new file.

Items in the operation log function

GOT screen display, Application switching, Time change,

System language switching, Operator authentication, Password authentication,

Screen switching, Station No. switching, Language switching,

Object (Touch switch, Numerical input, ASCII input, Alarm history, Advanced alarm display),

Operation panel, Object script, Log corruption information

558
197

700
197

OPELOG_20090406_0000.G1O

65500 records

OPELOG_20090406_0000.G1O

65500 records

OPELOG_20090406_0001.G1O

1 record

Production line
A Line
B Line

Change target amount
A Line
B Line
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(4) Displaying operation log information
(a) Displaying by using a GOT's utility

Operation logs can be checked and the files can be managed by the [Operation Log Information] utility.

(b) Saving in a CSV file or Unicode text file then displaying on a personal computer
A created operation log file is saved as a binary file (*.G20).
With this binary file, a CSV file or Unicode text file can be created to display the data on a personal 
computer.

POINTPOINTPOINT

For the details of the settings described in this section, refer to GT Designer3 (GOT2000) Help or the GT 
Designer3 (GOT2000) Screen Design Manual.

Unicode text / CSV file
Log file
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3.26.3 Screen setting example

This section explains an example of creating screens with the security function setting as follows.
For the authentication method, the security level authentication is used.
On the created screen, the following settings are configured.

Screen No. 10

(1) Disable the screen switching to screen No. 11 unless the security level is changed to 1 with the password (level 
1).

Base screen No. 10

Screen No. 11

(1) Disable the touch switch unless the security level is 2 or more.

(2) Reset the security level to 0 by logging out.

Base screen No. 11

Numerical display setting 
  (It displays the current security level.) 
  Device

Touch switch (Go To Screen switch) 
  Switch action 
  
  Security (display) 
  Security (input)

Touch switch (special function switch) 
  Switch action 

  Security (display) 
  Security (input)

: D9

: Login/logout  
  (Operator)

: Level 0
: Level 0

: Switching the base 
  screen to No. 11
: Level 0
: Level 1

Numerical display setting 
  (It displays the current security level.) 
  Device

Touch switch (Go To Screen switch)  
  Switch action
  
  Security (display) 
  Security (input) 

Touch switch (special function switch) 
  Security (display) 
  Security (input) 

: Switching the base 
  screen to No. 10
 : Level 0
: Level 0

: Level 2
: Level 0

: D9

Touch switch (special function switch) 
  Switch action 

  Security (display) 
  Security (input)

: Login/logout  
  (Operator)

: Level 0
: Level 0
3. Drawing fundamentals
3.26 Security function

3 - 217



3.26.4 Operator authentication setting

Configure the settings to perform the authentication with the operator information set for each user.

RemarkRemarkRemark
The value of security level is stored in the device that stores the security level status (security level device).
Changing the operator to the one who has a different security level changes the current security level.

1. Select [Common] - [GOT Environmental Setting] 
- [Security] from the menu.

2. Select the [Screen Security] tab.

3. Select "Operator".

4. Set a device to store the security level of the 
GOT.

Select "Store the operator security level to the 
device". Then click the  button and set the 
security level device to "D9".

5. Click the  button.

2.
3.
4.

5.

The display changes according to the changed security level.

Sta.

Product 
qty

Line control

Sta.

Product qty

Line control

RUN

500

Current security 
level: 1

Current security 
level: 10

The operator with the security 
level 10 logs in.
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3.26.5 Object settings of base screen No. 10 (Security setting)

(1) Create a touch switch to switch the screen to base screen No. 11 with the following setting.

(2) Set the security level for the touch switch created in (1).

Switch name
Setting item

No. 11
Open

[Next Screen] 
tab

[Screen Type]
Screen type

[Base]

[Next Screen] [Fixed]: "11"

[Text] tab
[Text]
(ON/OFF)

No. 11
Open

1. Click the [Extended] tab.

2. Set [Display] and [Input] in Security Level as 
shown below.
[Display]: "0"
[Input]: "1"

3. Click the  button.

1.

2.

3.
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RemarkRemarkRemark
For the numerical input function, the ASCII input function, and the touch switch function, you can set the security 
levels for input and display.

Example) When the security is set for the numerical input function

(3) Create a touch switch to display the password entry screen.
(a) Select [Object] - [Switch] - [Special Function Switch] from the menu, and place a touch switch.
(b) Configure the setting as follows. (Do not set the security level.)

(4) Create a numerical display to display the current security level of the GOT with the following 
setting.
(Do not set the security level.)

Switch name
Setting item

Login

[SP Function] 
tab

[Switch Action] [Login/Logout (Operator)]

[Style] tab [Shape]

OFF
[FA Control Switch Figure A1: 97 SW_04_0_B]

[Shape Color]: "Blue"

ON [FA Control Switch Figure A1: 98 SW_04_1_B]
[Shape Color]: "Blue"

[Text] tab
[Text]
(ON/OFF) Login

Object name
Setting item

Numerical display

[Device/Style] 
tab

[Device] [Device]: "D9"

[Format]
[Format] : "Signed Decimal"
[Digits] : "6"

Production 
volume

Security level
Input: 5    Display: 10

[Security level 5]
600

600
Production 
volume

This level displays only numerical values. 
Inputting them is unavailable.

[Security level 10]

600
Production 
volume

This level displays the cursor 
to input the numerical values.
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3.26.6 Object settings of base screen No. 11 (Security setting)

Create a new touch switch for the test whose security level is 2 by copying and pasting the switch created in (3) of 3.26.5.

(1) Change the settings of the copied switch as shown below.

(2) Create a numerical display to display the current security level of the GOT by copying and pasting 
the numerical display created on base screen No. 10.

(3) Create a touch switch to perform a logout. (Do not set the security level.)
Copy and paste the switch created in (3) of 3.26.5, and change the text to "Logout".
The value of the security level device (D9) is set to 0 when a logout is performed.

(4) Create a touch switch to switch the screen to base screen No. 10.
After logging out, you cannot open screen No. 11 without performing the operator authentication on screen No. 
10 again.

(a) Select [Object] - [Switch] - [Go To Screen Switch] from the menu, and place a Go To Screen switch.
(b) Set the Go To Screen switch as shown below.

(Do not set the security level.)

Switch name
Setting item Security test switch

[SP Function] 
tab [Switch Action] [Utility]

[Text] tab [Text] (ON/OFF) [Utility]

[Extended] 
tab

[Security Level]
[Display]: "0"
[Input]: "2"

Switch name
Setting item

Return to No. 10

[Next Screen] 
tab

[Screen Type] [Base]

[Next Screen] [Fixed]: "10"

[Style] tab [Shape]

OFF
[FA Control Switch Figure A1: 97 SW_04_0_B]

[Shape Color]: "Blue"

ON
[FA Control Switch Figure A1: 98 SW_04_1_B]

[Shape Color]: "Blue"

[Text] tab
[Text]
(ON/OFF) Return to No. 10
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3.26.7 Adding operators

Add operators with different levels of the operator authentication.

1. Hold down the upper left corner of the GOT 
monitor screen for two seconds.

2. Touch [Operator authentication].

3. Touch [Operator management].

(Next page)

Touch the upper-left corner of the 
utility call key for two seconds.

Touch 
[Operator authentication].

Touch 
[Operator  
management].
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(From previous page)

4. Touch the [Add] button.

5. Set the items on the [Operator information edit] 
screen as shown below.
[Operator name]: "TARO"
[Level]: "1"
[Password]: "123"

6. Touch the  button.

7. In the same way, add another operator as 
follows.
[Operator name]: "JIRO"
[Level]: "2"
[Password]: "456"

8. Touch the  button.

(Next page)

Touch
 [Add].

5.

6.

7.

8.
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(From previous page)

9. Operator information is saved. Touch the 
 button.

9.
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3.26.8 Setting the operation log function

Set the following to save the history of operations performed on the GOT.

1. Select [Common] - [GOT Environmental Setting] 
- [Operation Log] from the menu.

2. Select "Collect operation logs".

3. Click the  button.

2.

3.
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3.27 Operation check 10
Write all data to the GOT on the screen for writing monitor data.
Reset the PLC CPU using the RESET switch, and then switch its state to RUN.
Check that the security function operates properly on screen No. 10 and 11.

(1) Test 1
Perform the test of the security function on screen No. 10.

Test object

Item
Numerical display

Touch switch (operator 
authentication)

Touch switch (No. 11 Open)

1) First touch operation ──── ──── Touch the switch.

Operation result ──── ──── The switch does not operate.

2) Second touch operation ──── Touch the switch. ────

Operation 
result

Display/
operation

"1" is displayed.

The login screen is 
displayed. Enter the operator 

name "TARO" and the 
password "123", and then 

click [Enter].

────

Write 
device

──── D9: 1 ────

Read 
device

D9: 1 ──── ────

3) Third touch operation ──── ──── Touch the switch.

Operation 
result

Display/
operation

──── ────
The current screen is 

switched to screen No. 11.

Write 
device

──── ──── D0: 11
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(2) Test 2
Perform the test of the security function on screen No. 11.

(3) Test 3
Check the operation log on the GOT.

Test object

Item
Numerical display Touch switch (Utility) Touch switch (Logout)

1) First touch operation ──── Touch the switch. ────

Operation 
result

Display/
operation

"2" is displayed.

On the login screen, enter 
the operator name "JIRO" 

and the password "456", and 
then click the [Enter] to 

switch the operator.

────

Write 
device ──── D9: 2

Read 
device D9: 2 ──── ────

2) Second touch operation ──── Touch the switch. ────

Operation 
result

Display/
operation

────
The utility screen is 

displayed.
────

Write 
device

──── ──── ────

3) Third touch operation ──── ──── Touch the switch.

Operation 
result

Display/
operation ──── ────

The operator account is 
logged out.

Write 
device ──── ──── D9: 0

Test object

Item
Operation log information

Check the [Operation Log 
Information] utility. ────

Check that the operation log 
file is created. ────
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3.28 Script function

3.28.1 Script function

The script function is a function to control the GOT display with a GOT original 
program.
This function helps reduce the load of controlling the GOT display on the system side 
(such as a PLC CPU or microcomputer).

(1) Various screen controls available together with the GOT
Using the script function enables the following operations that could not be achieved by the GOT alone.
(a) Operations together with other object functions

• The status of multiple bit devices can be indicated by one lamp.
• A specific part can be displayed if any of the bit devices is on, and hidden if all of them are off.
• When a numerical value is input, the part which indicates that it has already been input is pasted next to 

the input numerical display frame.
• One touch switch can perform multiple operations corresponding to the status in multiple situations.
• As soon as the alarm list (system alarm) detects an error, the error handling screen can be automatically 

displayed.
(b) Processing complicated arithmetic operations

• Polynomial operations can be expressed simply in a line, which are difficult for ladder programs to 
express.

• In addition to four arithmetic operations, scripts can be used for various application arithmetic operation 
functions such as trigonometric and exponential functions.

(c) No limit on application
• You can obtain a target date using an entered date and interval (number of days in between).

What is the date after 345 days from May 20, 2013? → April 30, 2014
• You can obtain the corresponding day of the week from an entered date.

What day of the week was February 21, 1961? → Tuesday.

(2) Easy system maintenance
With the script function, the controllers can be programmed to handle machine control only, so the system 
maintenance becomes much easier.

(3) Simple programming language
Scripts are in a language similar to C language, so you can easily make a program with elementary 
programming knowledge.

(4) Using a commercially-available text editor for programming
You can use your familiar text editors (including Microsoft® Windows® standard Notepad and WordPad) to write 
programs efficiently.

(5) Operating conditions settable for each script
Various conditions (Ordinary, ON, OFF, Rise, Fall, Rise/Fall, ON Sampling, OFF Sampling, When closing a 
screen (for window screens only)) can be set as triggers for a script, so script execution can be scheduled.
In addition to the above conditions, the execution of an object script can be tied to an input to the object, display 
on the object, or a touch on a touch switch.

Screen

No.8
Screen

No.6
Screen

No.7
Screen

No.5

Screen

No.17
Screen

No.14
Screen

No.15
Screen

No.16
Screen

No.19

Screen

No.22

Screen

No.10
Screen

No.11

Screen

No.1

Screen

No.13

Screen

No.23
Screen

No.24
Screen

No.20
Screen

No.3

Ladder program Script

[w:D5]=([w:D1]-[w:D2])/100+([w:D3]-[w:D4])-100;
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(6) A wide variety of the debug functions
Since scripts and C language are similar, you can simulate the scripts by making minor corrections using a 
general C language complier or debugger (such as Microsoft® Visual C++).
Complicated scripts including many control statements can be debugged easily by using them.
The system monitor function is useful for debugging controllers using the GOT.
The test function and the device monitor function are available to check conditional branches in a script. By 
monitoring the GOT special register (GS), error information and scripts in execution can be easily checked.

(7) Grammar check for created scripts available
You can check the validity of the syntax of created scripts using GT Designer3 before executing the scripts on 
the GOT. This check improves the programming efficiency.

(8) Conversion of the script language of Digital Electronics Corporation (D-script)
You can convert the script language (D script/global D script) created with the Digital package and operate it on 
the GOT.

RemarkRemarkRemark

(1) Settings of operating conditions and a syntax check
The settings of operating conditions and a syntax check can be done when a monitor screen is created with 
GT Designer3.
For the details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design 
Manual.

(2) Conversion of the script language of Digital Electronics Corporation
Convert the script language, created with the Digital package, with GT Converter2.
For the details of convertible data and the conversion method, refer to the GT Converter2 Version3 Operating 
Manual.

(9) Types of the script function
The following three types of script functions are provided.

[Project script]
(a) Targets for setting and operation

Project scripts are settable for the whole project to run.
(b) The GOT condition under which project scripts can be executed

Project scripts can always be executed while the GOT is in the online processing.
(c) Operating conditions of scripts

Scripts are executed when the operating conditions set for each script are satisfied.
(d) Maximum number of scripts

Up to 256 scripts can be set for one project.
(e) Number of registrable script data

For script data sets, up to 32767 project scripts and screen scripts are registerable in total.

POINTPOINTPOINT

Applications of project scripts
Project scripts operate to the whole project, and thus they provide the convenience if they are used as follows.
Example) As soon as the alarm display (system) function detects an error, an error handling screen can be 

automatically displayed.

Precautions when setting a project script
The monitor device of a project script is always operating.
Note that displaying the monitor screen may take long when the number of monitor devices is large.
Depending on devices where you write the operation result of scripts, some time (called assignment delay) is 
needed for writing the result to the device when the operation of a script is complete.
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[Screen Script]
(a) Targets for setting and operation

Screen scripts are settable for the following screens to run.
• Base screen*1, *2

• Window screen*1, *2 (when displayed as a superimpose window or overlap window)
*1 Screens called by the set overlay screen function are also the targets of screen scripts.
*2 The screens displayed by the parts display function are not the targets of screen scripts.

(b) The GOT condition under which screen scripts can be executed
Screen scripts can be executed when the following two conditions are satisfied.
• The GOT is in the online process.
• The target screen is displayed.

(c) Operating conditions of scripts
Scripts are executed when the operating conditions set for each script are satisfied.

(d) Maximum number of scripts
Up to 256 scripts can be set for one screen (including the screen called by the set overlay screen function).

(e) Number of registrable script data
For script data sets, up to 32767 project scripts and screen scripts are registerable in total.

POINTPOINTPOINT

Precautions when setting a screen script
Note that it takes longer time than usual for the monitor screen to display when the number of monitor devices in 
the screen script is large.
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[Object Script]
(a) Targets for setting and operation

Object scripts are set and operate for the following objects.

(b) The GOT condition under which scripts can be executed
Object scripts can be executed when all the following four conditions are satisfied.
• The GOT is in the online process.
• The screen where the target object is placed has been displayed.
• The target object has been displayed or in operation.
• The target object has no limit on its operations by the security function.

(c) Operating conditions of scripts
Scripts are executed when the operating conditions set for each script are satisfied. The execution is also 
tied to an input to the object, the display on the object, and a touch operation on a touch switch.

(d) Maximum number of scripts
For a single object for numerical input and text input, both an input object script and a display object script 
can be set.
For a single object for other than numerical input and text input, either an input object script or a display 
object script can be set.

POINTPOINTPOINT

Precautions when setting an object script
Note that it takes longer time than usual for the monitor screen to display when the number of monitor devices in 
the object script is large.

Targets for setting and operation of the object script function

Touch switch ([Switch] only), Bit lamp, Word lamp, Numerical display, Numerical input,

Text display, Text input, Date display, Time display, Comment display,

Level object, Panel meter, Line graph, Trend graph, Bar graph,

Statistics bar graph, Statistics pie graph, Scatter graph, Historical trend graph,

Parts display, Parts movement
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3.28.2 Screen setting example of scripts and object scripts

In this section, create base screen No. 24 as shown below.

POINTPOINTPOINT

Performing script initial operation (screen/object) only when switching screens
Enable the initial operation of scripts only when a screen is switched.
Set the [Option] tab in the [Script] window. (The check box is selected by default.)
For example, by setting the rise of GB40 (always ON) as the trigger, the script is executed only when a screen is 
switched.
Note that the operation is not available when the offset is used.

3.28.3 Example for an efficient application of 
           the script function 
■ Lamps which change display objects 
   according to multiple conditions

3.28.5 Example for application of the object 
           script function 
(1) Data operation by a numerical input script

3.28.5 Example for application of the object 
           script function 
(2) To start blinking after set time
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3.28.3 Example for an efficient application of the script function

This section explains an example for an efficient application of the script function.
For the details on specifications, settings, and restrictions of the script function, refer to GT Designer3 (GOT2000) Help 
or the GT Designer3 (GOT2000) Screen Design Manual.

 Lamps which change display objects according to multiple conditions
(1) Desired function

The function of a lamp to display the control statuses of three lines controlled with touch switches cannot be set 
on the GOT.

(2) Application of the script function
The comment and the color of the lamp vary according to the combination of the line control switches that have 
been touched.

POINTPOINTPOINT

Store values for all combinations of the switches in the devices.

Line1 Line3Line2

Stop all lines

Line1 Line3Line2

Stop all lines

All lines stopped Line1 and 3 running

Monitor screen Monitor screen

When the "Stop all lines" button is pressed, all the 
lines stop and the screen displays the comment 
"All lines stopped". Then, the lamp turns on.

Line 1 and 3 start running and the screen 
displays the comment "Line 1 and 3 
running". Then, the lamp turns on.

Line1 Line3Line2

Stop all lines

All lines stopped

Line1 Line3Line2

Stop all lines

Line1 and 2 running

Line1 Line3Line2

Stop all lines

Line1 running
3. Drawing fundamentals
3.28 Script function

3 - 233



(3) Setting example
(a) Devices to be used

(b) Relevant object settings

Device type Application

D40 Control lamp display device

M101 Control line1 device

M102 Control line2 device

M103 Control line3 device

M100 Stop all lines device

Object type Application Setting

Lamp display function
Comment display, lamp 
function

<[Device/Style] and [Text] tab>
[Word]•••[Device]: "D40"
 Display range: $V==0, Text color: Yellow, Text: All lines stopped
 Display range: $V==1, Text color: Green, Text: Line1 running
 Display range: $V==2, Text color: Green, Text: Line2 running
 Display range: $V==3, Text color: Green, Text: Line3 running
 Display range: $V==4, Text color: Cyan, Text: Line1 and 2 running
 Display range: $V==5, Text color: Cyan, Text: Line1 and 3 running
 Display range: $V==6, Text color: Cyan, Text: Line2 and 3 running
 Display range: $V==7, Text color: Magenta, Text: Line1, 2 and 3 running

Touch switch (Bit) To control line1
<[Device] tab>
[Bit-ON/OFF]•••[Device]: "M101", [Action]: "Alternate"

Touch switch (Bit) To control line2
<[Device] tab>
[Bit-ON/OFF]•••[Device]: "M102", [Action]: "Alternate"

Touch switch (Bit) To control line3
<[Device] tab>
[Bit-ON/OFF]•••[Device]: "M103", [Action]: "Alternate"

Touch switch (Bit) To stop all lines
<[Device] tab>
[Bit-ON/OFF]•••[Device]: "M100", [Action]: "Set"
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(c) Script settings (approximately 9k bytes)

Item Description

[Trigger Type] [Ordinary]

[Data Type] [Signed BIN 16]

Script description

if(([b:M101]==OFF)&&([b:M102]==OFF)&&([b:M103]==OFF)){ //When line 1, 2, and 3 are off,
[w:D40]=0; //0 is stored in D40.

}

if(([b:M101]==ON)&&([b:M102]==OFF)&&([b:M103]==OFF)){ //When line 1 is on, and 2,3 are off,
[w:D40]=1; //1 is stored in D40.

}

if(([b:M101]==OFF)&&([b:M102]==ON)&&([b:M103]==OFF)){ //When line 2 is on, and 1,3 are off,
[w:D40]=2; //2 is stored in D40.

}

if(([b:M101]==OFF)&&([b:M102]==OFF)&&([b:M103]==ON)){ //When line 3 is on, and 1,2 are off,
[w:D40]=3; //3 is stored in D40.

}

if(([b:M101]==ON)&&([b:M102]==ON)&&([b:M103]==OFF)){ //When line 1, 2 are on, and 3 is off,
[w:D40]=4; //4 is stored in D40.

}

if(([b:M101]==ON)&&([b:M102]==OFF)&&([b:M103]==ON)){ //When line 1, 3 are on, and 2 is off,
[w:D40]=5; //5 is stored in D40.

}

if(([b:M101]==OFF)&&([b:M102]==ON)&&([b:M103]==ON)){ //When line 2, 3 are on, and 1 is off,
[w:D40]=6; //6 is stored in D40.

}

if(([b:M101]==OFF)&&([b:M102]==ON)&&([b:M103]==ON)){ //When line 1, 2, 3 are on,
[w:D40]=7; //7 is stored in D40.

}

if ([b:M100]==ON){//When the Stop all lines switch is turned on,
rst([b:M101]); //line 1 is turned off.
rst([b:M102]); //line 2 is turned off.
rst([b:M103]); //line 3 is turned off.
rst([b:M100]); //the Stop all lines switch is turned off.

}
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 Automatic screen switching function for the error handling screen
(1) Do you need the following function?

If the detail display (error handling screen) appears automatically upon an occurrence of an alarm, you do not 
need to touch a switch.
However, the detail display screen cannot be displayed without performing the touch input by a single touch 
operation or touch switch under present conditions.

(2) Application of the script function
When one of the devices from X2 to X5 that are set in [Alarm Display (User)] of base screen No. 24 turns on 
(when an error occurs), the corresponding detail display window is displayed automatically.
• When X2 turns on: Window screen 2 appears on the screen.
• When X3 turns on: Window screen 3 appears on the screen.
• When X4 turns on: Window screen 4 appears on the screen.
• When X5 turns on: Window screen 5 appears on the screen.

POINTPOINTPOINT

• Since the corresponding window screen is displayed upon an error occurrence, the setting of the alarm display 
(user) function in base screen No. 1 cannot be checked.

• After the screen switching, the target bit device is reset automatically.

Line A feed conveyor stopped.

Check the power of the line A 
feed conveyor.

After checking the power, press 
the RUN switch.

RUN

Monitor screen Error handling screen (detail display)

A 1254 348B

Line A feed conveyor stopped.

An alarm 
occurred The error handling screen 

appears automatically 
when an alarm occurs.

Base screen No. 24

Base screen No. 24

×

Window 
screen 2

Base screen No. 24

×

Window 
screen 3

Base screen No. 24

×

Window 
screen 4

Base screen No. 24

×

Window 
screen 5

Ordinary monitor screen

Detail display screen

Detail display screenDetail display screen

Detail display screen

X4 turns on. 
→ Window screen 4 appears.

X2 turns on. 
→ Window screen 2 appears.

X3 turns on. 
→ Window screen 3 appears.

X5 turns on. 
→ Window screen 5 appears.
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(3) Setting example
(a) Devices to be used

(b) Script setting (approximately 1k byte)

Device type Application

D1 Overlap window 1 screen switching device

X2 to X5 User alarm device

Item Description

[Type] Project script

[Trigger Type] [Ordinary]

[Data Type] [Signed BIN 16]

Script description

if ( [b:X2] == ON ) { //When alarm 1 occurs,
     [w:D1] = 2; //detail display window screen 2 is displayed.
 }
if ( [b:X3] == ON ) { //When alarm 2 occurs,
     [w:D1] = 3; //detail display window screen 3 is displayed.
 }
if ( [b:X4] == ON ) { //When alarm 3 occurs,
     [w:D1] = 4; //detail display window screen 4 is displayed.
 }
if ( [b:X5] == ON ) { //When alarm 4 occurs,
     [w:D1] = 5; //detail display window screen 5 is displayed.
 }
3. Drawing fundamentals
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3.28.4 Object script function

This is the script function that operates for each object.
The following three types of object scripts are provided.

 Input object script
Input object scripts are executed for objects that input numerical values.

Application example
Changes the value to be written to a device according to the input value.

 Display object script
Display object scripts are executed for objects that display text and lamps.

Application example
Changes the color of numerical display and lets the value blink when the value is not changed for 5 seconds. (Notifies 
that a device value update has been stopped.)

 Switch object script
Switch object scripts are executed for touch switches ([Switch] only).

Application example
Displays or hides a touch switch so that the switch can be touched only when a touch operation is necessary.

For the details of the setting of the [Script] or [Operation/Script] tab for each object, refer to the following.

*1 For the input object script
*2 For the display object script

Object script type Target object

Input object script Numerical input*1, Text input*1

Display object script

Bit lamp, Word lamp, Numerical display, Numerical input*2, 
Text display, Text input*2, Date display, Time display,
Comment display, Level, Panel meter, Line graph, Trend 
graph, Bar graph, Statistics bar graph,      
Statistics pie graph, Scatter graph, Historical trend graph, 
Parts display, Parts movement

Switch object script Touch switch ([Switch] only)

45605000

When -145 is written When 456 is written

759759

123 123
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 Functions of object scripts
(1) Object internal variables

Object internal variables are variables that have been allocated to inputs or outputs of objects.
By using object internal variables, the monitor device values of an object can be operated and the operation 
result can be displayed on the object.

(2) Object property
With object properties, you can read or change (write) the settings for an object drawn with GT Designer3.
The settings for the object on the screen can be changed automatically if the object property is changed during 
monitoring.

(3) Free figure drawing function
Figures (such as a line, rectangle, circle, and character), comments, and others can be drawn on an object.

POINTPOINTPOINT

Operating conditions under which the free figure drawing function does not perform the drawing
To use the free figure drawing function, execute object scripts under the operating conditions other than those 
described below.
If the free figure drawing function is executed under the following operating conditions, no figure is drawn and no 
error occurs.

• Key code input
• Input fixation
• Device writing

(4) Screen control function
The screen control function controls redrawing or erasing of screens and objects.

(5) Script user ID
A script user ID number is an arbitrary number that is set for an object script.
If the object script causes an error, the script user ID of the object script is stored in the GOT special register 
(GS).

HINTHINTHINT

Setting method by using script user IDs
By setting different user ID numbers for all object scripts, you can identify the object script that has caused an error.

(6) Operating conditions of scripts
The execution of an object script can be tied to an input to the object, display on the object, or a touch on a touch 
switch, according to the object script type.
It is also possible for object scripts to be executed under conditions other than those described above.

(7) Maximum number of scripts
For a single object for numerical input and text input, both an input object script and a display object script can 
be set.
For a single object for other than numerical input and text input, either an input object script or a display object 
script can be set.
Note that it takes longer time than usual for the monitor screen to display when the number of monitor devices in 
the object script is large.
3. Drawing fundamentals
3.28 Script function

3 - 239



 Operating condition
Object scripts are executed when all the following conditions from (1) to (4) are satisfied.
Even only one of the following conditions that is not satisfied prevents object scripts from being executed.

(1) On the screen of the GOT, the arranged target object has been displayed.
The screen on which the target object is arranged must be displayed under the condition that the GOT and 
controller are connected.

(2) The target object has been displayed or operating.
The target object must be displayed or in operation.

(3) The target object has no restriction imposed by the security function of the GOT.
When the security function is used, the object with the object script set at a high security level must not be 
restricted while it is on display or in operation.

(4) The operating condition of the script is satisfied.
The object script can be executed when the operating condition set for it is satisfied.

 Execution unit
Object scripts are executed one by one.
Even when multiple operating conditions are satisfied, the scripts are not processed simultaneously.

 Execution order
Object scripts are executed in numerical order of object ID.

 Execution status
Object scripts are processed as shown below according to the script status.

*1  For the details of fatal errors and execution errors, refer to the following.

POINTPOINTPOINT

Precautions when setting an object script
Note that it takes longer time than usual for the monitor screen to display when the number of monitor devices in 
the object script is large.

Script status Processing

Waiting for turn
• The script waits for the processing turn according to the execution order.
• When the turn has come, the script enters the "Waiting for execution" status.

Waiting for execution

• The processing differs depending on the operating condition.
   Satisfied : The script enters the "Execution" status.
   Not satisfied: The script enters the "Waiting for turn" status, and the next script enters the "Waiting for 

execution" status.

Execution

• When the script has ended, the processing result is written to the PLC CPU and the script enters the 
"Waiting for turn" status.
The next script enters the "Waiting for execution" status.

• If a fatal error occurs, execution of the script stops and the script enters the "Stop" status. *1

• If an execution error occurs, execution of the script stops and the script enters the "Waiting for turn" 
status. *1

Stop • The "Stop" status is held until the error history is cleared.
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3.28.5 Example for application of the object script function

This section explains application examples of the object script function.
For the details on specifications, settings, and restrictions of the script function, refer to GT Designer3 (GOT2000) Help 
or the GT Designer3 (GOT2000) Screen Design Manual.

(1) Data operation by a numerical input script
Data operation is performed when a device value is written.

Screen image Operation of each object

[Numerical input]: When the written value is 0 or greater, 
the written value is multiplied by 10.
When the written value is less than 0, 
the written value is set to 5000.

Item Description

[Data Type] [Signed BIN16]

[Trigger Type] [Input Fixation]

[Device] D50

[Script]

[w:TMP0] = $W; //Stores the written value to the temporary area.
if([w:TMP0] >= 0) { //If the written value is 0 or greater,
$W = [w:TMP0] * 10; //the written value is multiplied by 10.
}else{ //If the written value is less than 0,
$W = 5000; //the written value is set to 5000.
}

3. Drawing fundamentals
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(2) To start blinking after set time
A displayed value (monitored device value) blinks when it does not change for set time.
This operation is useful when urging the use of caution is necessary after set time.

Screen image Operation of each object

[Numerical display]: If the displayed value (monitored 
device value) does not change for 
5 seconds, the characters blink in 
red.

Item Description

[Data Type] [Signed BIN16]

[Trigger Type] [Sampling] (1 second)

[Device] D50

[Script]

if([w:TMP0002] != $$){ //If the displayed value changes,
[w:TMP0001] = 5; //starts counting.

(sets time (seconds) when the blinking starts)
[w:TMP0002] = $$; //saves the displayed value.
my.blink = 0; //sets so that blinking is not performed.
my.text_color = 0xFF; //changes the text color to white.
}else{ //If the displayed value does not change,
if([w:TMP0001] > 0){ //If the count is not 0,
[w:TMP0001] = [w:TMP0001] - 1; //starts counting down.
if([w:TMP0001] == 0){ //If counting down to 0,
my.text_color = 0xE0; //changes the text color to red.
my.blink = 3; //starts high-speed blinking.
}
}else{
[w:TMP0001] = 5;
}
}
redraw_object(); //Lets the object reflect this property.
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3.28.6 Setting the screen for training

Select [Screen] - [New] - [Base Screen...] from the menu to create screen No. 24.

(1) Lamp display settings (To display line control status)

Set the items as shown below by following the steps  to  above.

1. Select [Object] - [Lamp] - [Word Lamp] from the 
menu.

Set the items in the [Device/Style] tab as shown 
below.

2. Set the device and the shape.

[Device]: "D40"
[Shape]: "Rectangle: Rect_17"

3. Click the  button to add a state.

4. Click the  button to display the [Edit Range] 
dialog.

5. Select the state "==", and click "B".

6. Input 1 for the value of B.

7. Click the  button.

State No. [Range]

0

1 $V == 1

2 $V == 2

3 $V == 3

4 $V == 4

5 $V == 5

6 $V == 6

7 $V == 7

(Next page)

1.

2.

3.

4.

5.

6.

7.

3. 6.
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(From previous page)

8. Click the [Text] tab and set the items as shown 
below.
State : "State 0"
[Text] : "All lines stopped"
[Text Color] : "Yellow"

State No. Text Text color

0 All lines stopped [Yellow]

1 Line1 running [Green]

2 Line2 running [Green]

3 Line3 running [Green]

4 Line1 and 2 running [Cyan]

5 Line1 and 3 running [Cyan]

6 Line2 and 3 running [Cyan]

7 Line1, 2, and 3 running [Magenta]

9. Click the  button.

8.

9.
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(2) Switch settings (To control lines and stop all lines)

Set other switches by following the steps above.

1. Select [Object] - [Switch] - [Bit Switch] from the 
menu.

2. Click the [Device], [Style], and [Text] tab and set 
the items as shown below.

[Device] : "M101"
[Action] : "Alternate"
[Lamp] : Select "Bit-ON/OFF".

"M101"
[Shape] : "Square: Square_18"
[Text] : "Line control 1"
[Text Size] : "16"

3. Click the  button.

1 2 3

[Device] M102 M103 M100

[Action] [Alternate] [Alternate] [Set]

[Lamp] [Bit-ON/OFF]: "M102" [Bit-ON/OFF]: "M103" [Bit-ON/OFF]: "M100"

[Shape] [Square: Square_18]

[Text] Line control 2 Line control 3 Stop all lines

[Text Size] 16

2.

3.
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(3) Numerical input settings (For the object script check 1)

1. Select [Object] - [Numerical Display/Input] - 
[Numerical Input] from the menu.

2. Set the items in the [Device] tab as shown below.

[Type] : "Numerical Input"
[Device] : "D50"
[Number Size] : "32"

3. Set the items in the [Style] tab as shown below.
[Shape]: "Frame: Frame_1"

4. Click the [Operation/Script] tab.

(Next page)

2.

3.

4.
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(From previous page)

5. [Operation Type]: Select "Script".

6. Select "Use Object Script".

Set the items as shown below.
[Script User ID] : "1"
[Data Type] : "Signed BIN 16"
[Trigger Type] : "Input Fixation"

7. Click the  button to display the [Edit 
Script(Numerical Input)] dialog.

8. 3.28.5 Example for application of the object 
script function
Describe the program for (1) Data operation by a 
numerical input script.

9. Click the  button.

5.
6.

7.

9.
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(4) Numerical display settings (For the object script check 2)

1. Select [Object] - [Numerical Display/Input] - 
[Numerical Display] from the menu.

2. Set the items in the [Device] tab as shown below.

[Type] : "Numerical Display"
[Device] : "D50"
[Number Size] : "32"

3. Set the items in the [Style] tab as shown below.
 [Shape]: "Frame: Frame_23"

4. Click the [Operation/Script] tab.

(Next page)

2.

3.

4.
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(From previous page)

5. [Operation Type]: Select "Script".
Set the items as shown below.

[Script User ID] : "1"
[Data Type] : "Signed BIN 16"
[Trigger Type] : "Sampling"

6. Click the  button to display the [Edit 
Script(Numerical Display)] dialog.

7. 3.28.5 Example for application of the object 
script function
Describe the program for (2) To start blinking 
after set time.

8. Click the  button.

5.

6.

8.
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(5) Script setting

1. Select [Common] - [Script] - [Script] from the 
menu.

The [Script] dialog appears.

2. Add scripts.
Click the  button.

The [Script Edit] dialog appears.

3. Click the  button, and import 
"Lamps which change according to multiple 
conditions.txt".

Note) The script data can be imported only when 
the storage destination is set to "Project 
Data".

[Script No.] : "1"
[Data Type] : "Signed BIN 16"
[Trigger Type] : "Ordinary"

4. Click the  button.

5. The script is added.

(Next page)

2.

3.

4.
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(From previous page)

6. Click the [Screen] tab, and click the  
button.

The [Script Edit] dialog appears.

7. Click the  button, and import "Detail 
window automatic display.txt".

[Script No.] : "2"
[Data Type] : "Signed BIN 16"
[Trigger Type] : "Ordinary"

8. Click the  button.

9. The script is added.

Click the  button.

6.

7.

8.

9.
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3.28.7 Creating window screens for detail display

Create window screen No. 2 to 5 for detail display.

1. Select [Screen] - [New] - [Window Screen] from 
the menu.

2. The [Screen Property] dialog appears.
Change [Screen No.] to "2".

3. Click the  button.

4. Window screen No. 2 appears on the screen.

5. Place the text figure as shown in the left figure on 
the window screen.

6. Select [Screen] - [Close] from the menu.

(Next page)

2.

3.
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(From previous page)

Window screen No. 3

Window screen No. 4

Window screen No. 5

7. Repeat the steps  to  described in the 
previous page to create window screens No. 3 to 
5 as shown on the left.

8. The settings of the switches for the alarm history 
display function are complete.

1. 6.
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3.29 Operation check 11
Perform the test of the script and object script function on screen No. 24.

( )•••The switch is automatically changed to OFF.

*1 Numerical input range: 3276 or less

Line control 
1

Line control 
2

Line control 
3

Stop all lines Lamp display (D40)

1) ON OFF OFF OFF Line1 running

2) OFF ON OFF OFF Line2 running

3) OFF OFF ON OFF Line3 running

4) ON ON OFF OFF Line1 and 2 running

5) ON OFF ON OFF Line1 and 3 running

6) OFF ON ON OFF Line2 and 3 running

7) ON ON ON OFF Line1, 2, and 3 running

8) (OFF) (OFF) (OFF) ON All lines stopped

PLC test switch Operation result

9) X2: ON Detail display window screen 2 is displayed.

10) X3: ON Detail display window screen 3 is displayed.

11) X4: ON Detail display window screen 4 is displayed.

12) X5: ON Detail display window screen 5 is displayed.

Numerical input Numerical display Operation result

13) Input the value [10]*1. - [100] which is 10 times the input value is 
displayed.

14) The operation starts at 
execution of 13).

[100] is lit for 5 seconds.
After 5 seconds, the text blinks in red.
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3.30 Precautions for drawing
When creating screen data, check the following items.

3.30.1 Maximum number of objects on one screen

For the maximum number of objects that can be set on one screen and the available data capacity, refer to GT 
Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design Manual.

3.30.2 Color settings

65536 colors are prepared.
The following shows the procedure to display the color setting dialog.

1. Click the color set in each setting dialog or the 
button on the right of the color to display the 
color palette.

(Next page)

Color palette

Click here to display the color palette.
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(From previous page)

2. Display the setting dialog to set color.
• Selecting color from 65536 colors

Click [More Colors] in the color palette to 
display the setting dialog.

• Selecting color from 256 colors
Click the [256 Colors] button in the [65536 
Color] dialog to display the setting dialog.

3. Click the  button after the setting to 
complete the color setting.

3.

3.
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3.30.3 How to check the memory capacity of the drawing screen

Before transferring the created project data to the GOT, you can check the data size of each screen or the whole project.

1. Select [Tools] - [Data Size] - [Screen] from the 
menu.

2. The [Data Size (Screen)] dialog appears.
3. Drawing fundamentals
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3.31 Training device list and sequence program
(1)  Training device list

(Next page)

Device Signal name Device Signal name

X0000 Set base screen No. M101 Control line1

X0001 Set overlap window 1 No. M102 Control line2

X0002 Error 1 M103 Control line3

X0003 Error 2 M210 Alarm full notification

X0004 Error 3 M1000 Graph operation

X0005 Error 4 M1010 Cooling water temperature operation

X0006 Set overlap window 2 No. M1200 Parts movement switching device

X0007 Set superimpose 1 No. M1210 Start/Stop parts movement, Display operating/stopped

X0008 Set superimpose 2 No. M1301 Line 1 operating conditions

X0009 Set dialog window No. M1302 Line1 run ready

X000A Alarm error M2000 Stamping error

X000B Alarm error M2001 Welding error

X000C Alarm error M2002 Inspection line trouble

X000D Alarm error M2003 Production line trouble

X000E Alarm error D27.b0 Record write trigger (External control device)

X000F Alarm error, Switch bit comment

X20 to X27 Base screen D0 Switch base screen

X28 to X2F Overlap window 1 D1 Switch overlap window 1

X30 to X33 Overlap window 2 D2 Trend graph 1

X34 to X37 Superimpose 1 D3 Trend graph 2

X38 to X3B Superimpose 2 D4 Trend graph 3

X3C to X3F Dialog window D5 Bar graph 1

D6 Bar graph 2

Y40 to Y4F Display 32-bit data Lower data D7 Bar graph 3

Y50 to Y5F Not used D9 Level device

Y60 to Y6F Not used D10 Surface level setting amount

Y70 to Y7F Not used D12 Write 32-bit data Lower data

D15 Timer 1 limit

M10 GOT timer 1 D17 Comment display (Error data)

M11 GOT timer 1 OFF D25 Record No. storage (Recipe No. 1)

M12 Timer 1 ON D26 Switch superimpose 1

M23 Write recipe D27 Recipe function external control device

M24 Read recipe D28 Recipe No. storage (external control device)

M31 Run/Stop D29 Record No. storage (external control device)

M32 Dummy for ladder monitor D30 1 second unit

M33 Dummy for ladder monitor D31 1 minute unit

M34 Operating D32 1 hour unit

M35 8 hours operation D40 Control lamp display

M100 Stop all lines D51 Switch overlap window 2
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(From previous page)

POINTPOINTPOINT

To check on the devices used in the current project, use the device list on GT Designer3.
For the details, refer to section 3.32.

Device Signal name Device Signal name

D52 Switch superimpose 2 D1510 Line production volume

D53 Switch dialog window D1511 Line1 production volume

D120 Alarm_number of histories D1512 Line2 production volume

D121 Alarm_number of occurrences D1513 Line3 production volume

D122 Alarm observation_change levels

D300 Surface level change amount TN10 Timer current value

D1000 Cooling water temperature

D1100 Language switching device T10 Timer 1

D1110 Line A status T1001 Timer 2

D1120 Operating status T1002 Timer 3

D1200 Position device T1120 Timer 4

D1210 Number of wagons T1200 Timer 5

D1300 Production volume T1511 Timer 6

D1310 Text input 1 T1512 Timer 7

D1320 Text input 2 T1513 Timer 8

D1500 Line
3. Drawing fundamentals
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(1) Training sequence program

(Next page)

Setting the timer ON/OFF and timer limit D15 with the GOT

0 
SM401

Always 
OFF

M10

GOT 
timer 1

M11

GOT 
timer 1 

< K0 D15
Timer 1 
limit

D15
T10

Timer 1

M12

Timer 1 
ON

M12
Timer 1 
ON

Writing 32-bit data

44 
SM401

Always 
OFF

DBCD D12
Write 
32-bit data
Lower 
data

K8Y40

Switching the base/window screen

59 
SM401

Always 
OFF

X0

Set base
screen 
No.

BINP K2X20
Base 
screen 
0 to 99

D0
Switch 
base 
screen

X1

Set overlap 
window 1
No.

BINP K2X28
Overlap 
window 1

D1
Switch 
overlap 
window 1

X6

Set overlap 
window 2 
No.

BINP K1X30
Overlap 
window 2

D51
Switch 
overlap 
window 2

X7

Set 
superimpose 
1 No.

BINP K1X34
Superimpose 
1

D26
Switch 
superimpose 
1

X8

Set 
superimpose 
2 No.

BINP K1X38
Superimp
ose 2

D52
Switch 
superimpose 
2

X9

Set dialog 
window 
No.

BINP K1X3C
Dialog 
window

D53
Switch 
dialog 
window

OFF

Error comment/alarm history

108 
SM401

Always 
OFF

X2

Error 1
MOVP K1 D17

Error 
data
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X3

Error 2
MOVP K2 D17

Error 
data

X4

Error 3
MOVP K3 D17

Error 
data

X5

Error 4
MOVP K4 D17

Error 
data

141 
X2

Error 1
M2000

Stamping
 error

X3

Error 2

144 
X4

Error 3
M2001

Welding 
error

146 
X5

Error 4
M2002

Inspection 
line 
trouble

148 
M2000

Stamping
error

M2003
Production 
line 
trouble

M2001

Welding 
error

151 
M2002

Inspection 
line 
trouble

Y70
Error
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Operating the line 1 to 3 and graph display ladder

154 
SM401

Always 
OFF

M1000

Line 
operation

M5

Stop 
line

K10
T0

T0
MOV K0 Z0

PLS M6
Input 
graph

RST T0

197 FOR K3

<Inputting values to D2 to D4 (trend graph 1 to 3)>

199
M6

Input 
graph

MOV D200
Numerical 
input

D2Z0
Trend 
graph 1

<Inputting values to D5 to D7 (bar graph 1 to 3)>

+ D2Z0
Trend 
graph 1

D5Z0
Bar 
graph 1

INC Z0

+ K9 D200
Numerical 
input

<= K20 D200
Numerical 
input

- K17 D200
Numerical 
input

251 NEXT

252 <= K100 D5
Bar 
graph 1

SET M5
Stop 
line

M2003

Production 
line 
trouble
3 - 262 3. Drawing fundamentals
3.31 Training device list and sequence program



1

O
VE

R
VI

EW
 O

F 
TH

E 
G

O
T

2

BA
TC

H
 E

D
IT

 O
F 

O
BJ

EC
T 

SE
TT

IN
G

S

3

D
R

AW
IN

G
FU

N
D

A
M

EN
TA

LS
(From previous page)

(Next page)

262 
M1000

Line 
operation

M5

Stop 
line

RST M5
Stop 
line

<Initializing D2 to D3 (trend graph 1 to 3)>

FMOV K0 D2
Trend 
graph 1

K3

<Initializing D5 to D7 (bar graph 1 to 3)>

FMOV K0 D5
Bar 
graph 1

K3

MOV K0 D200
Numerical 
input

State

313 = D1000
Cooling 
water 
temperature

K0 MOVP K80 D1000
Cooling 
water
temperature

323 
M1010

Cooling 
water 
temperature 
operation

< D1000
Cooling 
water 
temperature

K100
K5

T1001
Timer 2

331 
T1001

Timer 2
+P K1 D1000

Cooling 
water 
temperature

RST T1001
Timer 2

<= K100 D6
Bar 
graph 2

<= K100 D7
Bar 
graph 3
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380 > D1300
Line1 
production
volume

K1000 RST D1300
Line1 
production
volume

Offset

385 = D1511
Line1 
production
volume

K1000 = D1512
Line2 
production
volume

K1000 = D1513
Line3 
production
volume

K1000 K0

K0 FMOV K0 D1511
Line1 
production
volume

K3

403 = D1511
Line1 
production
volume

K0 MOVP K100 D1511
Line1 
production
volume

MOVP K500 D1512
Line2 
production
volume

MOVP K300 D1513
Line3 
production
volume

339 
M1010

Cooling 
water 
temperature 
operation

> D1000
Cooling 
water 
temperature

K20
K10

T1002
Timer 3

347 
T1002

Timer 3
-P K1 D1000

Cooling 
water 
temperature

RST T1002
Timer 3

Display condition, operating condition

355 
M1301

Line 1 
operating
condition

SM412

1 second
clock

INCP D1300
Line1 
production
volume
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448 > D1513
Line3 
production
volume

K0 < D1513
Line3 
production
volume

K1000
K7

T1513
Timer 8

458 
T1513

Timer 8
+P K1 D1513

Line3 
production
volume

RST T1513
Timer 8

Parts movement

466 
SM400

Always 
ON

K10
T1200

Timer 5

412 > D1511
Line1 
production
volume

K0 < D1511
Line1 
production
volume

K1000
K5

T1511
Timer 6

422 
T1511

Timer 6
+P K1 D1511

Line1 
production
volume

RST T1511
Timer 6

430 > D1512
Line2 
production
volume

K0 < D1512
Line2 
production
volume

K1000
K11

T1512
Timer 7

440 
T1512

Timer 7
+P K1 D1512

Line2 
production
volume

RST T1512
Timer 7
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 524 
T1120

Timer 4
>= D1120

Operating 
status

K1 < D1120
Operating 
status

K6 +P K1 D1120
Operating 
status

= D1120
Operating 
status

K6 MOVP K1 D1120
Operating 
status

480 
M1210

Start/Stop 
parts 
movement

T1200

Timer 5
+P K1 D1200

Parts 
movement 
switching
device

> D1200
Parts 
movement 
switching
device

K5 MOVP K0 D1200
Parts 
movement 
switching
device

+P K1 D1210
Number of 
wagons

RST T1200
Timer 5

Language switching

499 = D1100
Language
switching 
device

K0 MOVP K1 D1100
Language
switching 
device

MOVP K1 D1110
Line A 
production 
status

MOVP K1 D1120
Operating 
status

519 
SM400

Always 
ON

K30
T1120

Timer 4
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RST T1120
Timer 4

Displaying the operating time

 546 
M31

Run/Stop

X2

Error 1
M32

Dummy 
for ladder
monitor

 566 
M32

Dummy 
for ladder
monitor

M33
Dummy 
for ladder
monitor

 568 
M33

Dummy 
for ladder
monitor

M34
Operating

 570 
M34

Operating

SM412

1 second
clock

INCP D30
1 second
unit

 574 >= D30
1 second
unit

K60 INCP D31
1 minute
unit

RST D30
1 second
unit

 581 >= D31
1 minute
unit

K60 INCP D32
1 hour 
unit

RST D31
1 minute
unit

 588 >= D32
1 hour 
unit

K24 RST D32
1 hour 
unit
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593 >= D32
1 hour 
unit

K8 M35
8 hours 
operation

For level display

597 
SM410

0.5 
second 
clock

M300
INC D300

Surface 
level 
change 
amount

< D10
Surface 
level 
setting 
amount

D300
Surface 
level 
change 
amount

SET M300

M300
DEC D300

Surface 
level 
change 
amount

> K0 D300
Surface 
level 
change 
amount

RST M300

627 END
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3.32 How to check on the devices used on the 
created screens

To check on the devices used on the created screens, use the device list on GT Designer3.
Display the list of the devices used on the screens that have been created in this training.

POINTPOINTPOINT

To search for a device which is not displayed in the list, click the [Search] button to specify the device.
For the setting details, refer to GT Designer3 (GOT2000) Help or the GT Designer3 (GOT2000) Screen Design 
Manual.

Display the list of the devices by the following two 
methods.
• Display the list of the devices for each project.
• Display the list of the devices for each screen.

In this training, select the method for each project to 
display the devices used on all the created screens.

Select [Search/Replace] - [Device List] - [Project] from 
the menu.

The [Device List] dialog appears.
Check the bit device list which is displayed by default.

To display the word device list or label list, click the 
[Word] tab or [Label/Tag] tab.

The word device list or label list is displayed 
accordingly.
3. Drawing fundamentals
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3.33 Debugging (GT Simulator3)

3.33.1 GT Simulator3

GT Simulator3 is available to debug project data without GOT by simulating GOT operations on personal computer.
With GT Simulator3, simulation can be performed as follows.

(1) Interaction with GX Developer or GX Works2
Debugging screens is available using GT Simulator3 together with GX Developer or GX Works2.
By installing GX Developer or GX Works2 and GT Designer3 on a personal computer, creating screens and 
debugging the created screens are available on one personal computer.
Any creation or correction made to a screen on GT Designer3 is available to debug on GT Simulator3 
immediately. Therefore, design efficiency is improve greatly.

(2) Available to project data debug without GOT
GT Simulator3 is available to debug project data without GOT by simulating GOT operations on a personal 
computer.

POINTPOINTPOINT

Monitoring speed when GT Simulator3 is directly connected to CPU
When GT Simulator3 is connected to a PLC CPU by the direct CPU connection, the monitor speed is slower than 
one when the software is linked to GX Simulator or GX Simulator2.

Install

(GT Designer3, GT Simulator3)
GT Works3 Version□

GX Developer

GX Developer or GX Works2

GX Developer

Virtual CPU (GX Simulator or GX Simulator2)

Virtual GOT (GT Simulator3)

Install

GT Works3 Version□

Direct CPU 
connection

(GT Designer3, GT Simulator3)

GX Developer

Virtual GOT (GT Simulator3)

GX Developer
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3.33.2 Startup procedure

This section explains the procedure for performing simulation on the personal computer alone by installing GX 
Simulator2 and GT Simulator3.
Start GX Simulator2 in advance.

1. Select [Tools] - [Simulator] - [Set] from the menu 
in GT Designer3.

2. Set the item in the [Communication setup] tab as 
shown below.
[Connection]: "GX Simulator2"

3. Click the  button.

4. Select [Tools] - [Simulator] - [Activate] from the 
menu in GT Designer3.

5. The simulation of the read project data starts.

2.

3.
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3.33.3 Operation procedure for simulation

1. On GT Simulator3, the touch operation is 
performed by clicking.
In this example, click [State].

2. The screen is switched to base screen No. 13.

(Next page)
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3. Click the [Start] button.

4. The temperature of the cooling water increases.

5. Click  to exit the simulation.

3.

4.

5.
3. Drawing fundamentals
3.33 Debugging (GT Simulator3)

3 - 273



3 - 274 3. Drawing fundamentals
3.33 Debugging (GT Simulator3)



Specifications subject to change without notice.

When exported from Japan, this manual does not require application to the
Ministry of Economy, Trade and Industry for service transaction permission.

HEAD OFFICE : TOKYO BUILDING, 2-7-3 MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN
NAGOYA WORKS : 1-14 , YADA-MINAMI 5-CHOME , HIGASHI-KU, NAGOYA , JAPAN

MODEL

MODEL
CODE

SH(NA)-081927ENG-B(2203) MEE

1D7MT7

SCHOOL-GOT2000-ADV-E

Graphic Operation Terminal (GOT2000 Series) 
Advanced Training Textbook (for GT Works3)


	SAFETY PRECAUTIONS
	REVISIONS
	Contents
	Introduction
	Relevant manuals
	Copyright notice
	System configuration used in this textbook
	1. Overview of the GOT
	1.1 GOT
	1.2 Procedure for monitoring the PLC CPU by GOT
	1.3 GOT2000 series features
	1.4 GOT function list
	1.5 Equipment required for using GOT
	1.6 Applicable connection type between the GOT and a PLC CPU
	1.7 Connection to equipment other than PLCs
	1.8 Multi-channel function

	2. Batch edit of object settings
	2.1 Loading screen data
	2.2 Copying a screen in the work tree
	2.3 Selecting objects in a batch on the data view
	2.4 Setting objects in a batch on the property sheet
	2.5 Searching for and editing a specific setting in the data browser

	3. Drawing fundamentals
	3.1 Before creating screens
	3.1.1 Operations before creating screens
	3.1.2 Drawing figures

	3.2 Setting text figures
	3.2.1 Setting a text figure (Outline font and text with a shadow)
	3.2.2 Setting a Go To Screen switch

	3.3 Setting numerical inputs and the numeric keypad window
	3.3.1 Setting for numerical inputs
	3.3.2 Numerical input: Setting a 4-digit number (for surface level setting)
	3.3.3 Numerical input: Setting a 4-digit number with 1 digit after the decimal point (for timer 1 limit setting)
	3.3.4 Numerical input: Setting an 8-digit number with 2 digits after the decimal point (for 32-bit data write)
	3.3.5 Setting the key window display
	3.3.6 Setting Go To Screen switches

	3.4 Setting numeric displays and a level display
	3.4.1 Setting Go To Screen switches
	3.4.2 Setting the momentary function to a switch to keep a bit device on (for turning on timer 1)
	3.4.3 Setting the momentary function to a switch to keep a bit device off (for turning off timer 1)
	3.4.4 Numerical display (D10): Setting a 4-digit number (for surface level display)
	3.4.5 Numerical display (T10): Setting a 5-digit number with 1 digit after the decimal point (for timer current value display)
	3.4.6 Numerical display (D15): Setting a 5-digit number with 1 digit after the decimal point (for timer limit display)
	3.4.7 Setting a level display

	3.5 Creating an original library
	3.5.1 Registering an object
	3.5.2 Editing a registered object or figure
	3.5.3 Pasting an object or a figure from the library

	3.6 Operation check 1
	3.7 Using conditions to control the display and operation of objects
	3.7.1 Setting a state for an object
	3.7.2 Setting a display condition and an operating condition to an object

	3.8 Operation check 2
	3.9 Using layers to superimpose graphs
	3.9.1 Superimposition
	3.9.2 Setting a trend graph
	3.9.3 Setting a bar graph
	3.9.4 Switching a displayed layer
	3.9.5 Setting a bit alternate toggle switch (for graph operations)
	3.9.6 Setting a Go To Screen switch

	3.10 Operation check 3
	3.11 Setting a window screen
	3.12 Operation check 4
	3.13 Offset function
	3.14 Operation check 5
	3.15 Parts display and movement functions
	3.15.1 Parts
	3.15.2 Registering a part
	3.15.3 Setting a parts display
	3.15.4 Setting a parts movement

	3.16 Operation check 6
	3.17 Recipe setting
	3.17.1 Recipe
	3.17.2 Hardware required for the recipe function
	3.17.3 Recipe function
	3.17.4 Screen example for the recipe setting
	3.17.5 Numerical input setting for recipe operation tests
	3.17.6 Recipe setting
	3.17.7 Setting a switch for the record write trigger
	3.17.8 Setting a write trigger switch
	3.17.9 Setting a read trigger switch

	3.18 Operation check 7
	3.19 Document display function
	3.19.1 Procedure for displaying documents
	3.19.2 How to convert a document with Document Converter
	3.19.3 Placing and setting a document
	3.19.4 Touch switch for the document display
	3.19.5 Operating objects by the gesture (object gesture function)

	3.20 Comment display
	3.20.1 Comment display
	3.20.2 Registering a comment
	3.20.3 Setting a comment display using a bit device
	3.20.4 Setting a comment display using a word device

	3.21 Setting the language switching function
	3.21.1 Setting the language switching device
	3.21.2 Registering a comment group
	3.21.3 Setting a comment display
	3.21.4 Setting a touch switch (for language switching)

	3.22 Operation check 8
	3.23 Alarm functions
	3.23.1 Alarm functions
	3.23.2 Alarm observation
	3.23.3 Alarm display
	3.23.4 Setting and arranging a user alarm
	3.23.5 Alarm popup display

	3.24 Operation check 9
	3.25 Sequence program monitor (ladder)
	3.25.1 Features
	3.25.2 System configuration
	3.25.3 Operations for display
	3.25.4 How to operate ladder editor screen
	3.25.5 Key functions

	3.26 Security function
	3.26.1 Security function
	3.26.2 Operation log function
	3.26.3 Screen setting example
	3.26.4 Operator authentication setting
	3.26.5 Object settings of base screen No. 10 (Security setting)
	3.26.6 Object settings of base screen No. 11 (Security setting)
	3.26.7 Adding operators
	3.26.8 Setting the operation log function

	3.27 Operation check 10
	3.28 Script function
	3.28.1 Script function
	3.28.2 Screen setting example of scripts and object scripts
	3.28.3 Example for an efficient application of the script function
	3.28.4 Object script function
	3.28.5 Example for application of the object script function
	3.28.6 Setting the screen for training
	3.28.7 Creating window screens for detail display

	3.29 Operation check 11
	3.30 Precautions for drawing
	3.30.1 Maximum number of objects on one screen
	3.30.2 Color settings
	3.30.3 How to check the memory capacity of the drawing screen

	3.31 Training device list and sequence program
	3.32 How to check on the devices used on the created screens
	3.33 Debugging (GT Simulator3)
	3.33.1 GT Simulator3
	3.33.2 Startup procedure
	3.33.3 Operation procedure for simulation



